Agile Product Lifecycle Management
Product Governance and Compliance User Guide
Release 9.3.6
E71139-01

February 2017
# Contents

## Preface

- Audience .......................................................................................................................... xiii
- Documentation Accessibility ............................................................................................ xiii
- Related Documents ......................................................................................................... xiii
- Conventions ..................................................................................................................... xiii

## 1 Introduction to Product Governance & Compliance

- Compliance Regulations .................................................................................................. 1-1
- Cycle of Compliance Data-Gathering and Corrective Action ........................................ 1-1
- How PG&C Helps You Gather and Manage Compliance Data ..................................... 1-2
- Agile PLM Documentation for PG&C ............................................................................ 1-3
  - PG&C User Guide ...................................................................................................... 1-3
    - Solution-specific Documentation for the PLM Administrator .................................. 1-3
  - PG&C Supplier Guide ................................................................................................ 1-3
  - Getting Started with Agile PLM ................................................................................. 1-3
- PG&C Use Cases ........................................................................................................... 1-4
  - List of Use Cases ....................................................................................................... 1-4
  - Use Cases for the Administrator ............................................................................... 1-5

## 2 PG&C Concepts and Business Objects

- Agile Java Client ............................................................................................................. 2-1
- Agile Web Client ............................................................................................................. 2-1
- Modified Web Client Interface ...................................................................................... 2-1
- Microsoft Excel-based Client ......................................................................................... 2-2
- PG&C Classes of Objects .............................................................................................. 2-2
  - Substances Classes .................................................................................................. 2-2
    - Substance ............................................................................................................... 2-2
    - Substance Group ................................................................................................... 2-2
    - Material .................................................................................................................. 2-2
    - Subpart ................................................................................................................... 2-3
  - Specifications ............................................................................................................. 2-3
  - Parts and Part Groups ............................................................................................... 2-3
  - Declarations .............................................................................................................. 2-4
- Conceptual Entities in PG&C (non-business objects) .................................................... 2-4
  - Bill Of Substances ................................................................................................. 2-4
3 RFI Process in PG&C

Specification Management ................................................................. 3-1
Declarations Gather Compliance Information .................................... 3-1
Full Use of PG&C Business Objects .................................................. 3-1
Summary ............................................................................................. 3-1
RFI Process Overview ........................................................................ 3-2
  Creating Declarations without Supplier Interaction ........................ 3-3
Declaration Workflow and the RFI Process ......................................... 3-3
Routing Declarations ......................................................................... 3-4
  Notifications when Declarations Advance to and from Supplier ........ 3-5
  Acknowledgments for Declarations .................................................. 3-6
  Receiving Notifications .................................................................... 3-6
Information Supplier Fills Out a Declaration ....................................... 3-6
Completing the RFI Process ............................................................... 3-7
Reviewing and Publishing a Declaration ............................................. 3-8

4 Compositions

Contents of a Composition .................................................................. 4-1
Stages of Compositions ...................................................................... 4-2
Compositions in the Context of Parts .................................................. 4-2
  Role of Composition Type Field ....................................................... 4-3
  Validation Type in Conjunction with Composition Type .................. 4-4
  Archiving and Unarchiving Compositions in Items and Mfr. Parts .... 4-4
Compositions in the Context of Declarations ...................................... 4-5
  Declarations Gather and Store Information about Compositions .... 4-5
  Information on Declarations also found on the Parts ....................... 4-6

5 Substances

Tabs and Attributes in Substances ....................................................... 5-1
  General Info Tab ................................................................................. 5-1
  Substances>Alias attribute ................................................................. 5-1
  Where Used Tab .................................................................................. 5-2
  Substance Groups > Substances Tab > Conversion Factor ......... 5-2
  Substance Groups and Conversion Factor .................................... 5-2
  Materials and Subparts > Composition Tab .................................. 5-3
  More About Subparts ......................................................................... 5-3
Creating Substances ........................................................................... 5-4
Working with Substances ................................................................... 5-4
  Substance Aliasing .............................................................................. 5-4
  Mass Disclosure .................................................................................. 5-5
    Full Disclosure, Partial Disclosure, and No Disclosure ............ 5-5
  Mass Tolerance ..................................................................................... 5-6
  Mass Tolerances for External Specifications ............................... 5-7
Example for calculating mass of each substance against external specification:............ 5-7
Intentional and Non-intentional Substances and Related Attributes.......................... 5-8
  Intentionally Added ...................................................................................................... 5-8
  Disallow Intentionally Adding ................................................................................. 5-8
  Specification Intentionally Added........................................................................... 5-9
Unreported Substances in Partially Disclosed Compositions ...................................... 5-9
  Conditions When the System Adds the Unreported Substance ............................. 5-9
  In Declarations (Internal Specifications Only)....................................................... 5-9
  For Substance Composition (Internal Specifications Only)...................................... 5-9
  Homogeneous Material Composition (Internal Specifications Only)............... 5-10
Unreported Substance When Importing Substances to Items and Manufacturer Parts (Internal Specifications Only) 5-10

6 Bill of Substances

BOM Lists Parts that become Products .................................................................... 6-1
BOS Lists Substances contained in Parts that require Compliance ............................. 6-1
Rationale for the BOS ............................................................................................. 6-2
Summary of BOS Structures .................................................................................. 6-3

7 Specifications

Contents of Specifications ......................................................................................... 7-1
Internal vs. External Specifications ........................................................................ 7-1
Tabs and Attributes in Specifications .................................................................... 7-2
  General Info Tab .................................................................................................... 7-2
  Substances Tab ..................................................................................................... 7-3
Creating Specifications .......................................................................................... 7-4
Specification Management ...................................................................................... 7-5
  Adding Specifications .......................................................................................... 7-6
  Replacing Specifications ...................................................................................... 7-7
"All Spec" Use Case ............................................................................................... 7-7
Rules for Selecting Compositions for Rollup on Part/Part Group (Internal Specifications)... 7-8
Rules for Selecting Compositions for Rollup on Part/Part Group (External Specifications)... 7-9

8 Parts and Part Groups

Parts: Items and Manufacturer Parts .................................................................... 8-1
Part Groups: Part Family ....................................................................................... 8-1
  More about Parts and Part Groups ..................................................................... 8-2
Tabs and Attributes in Parts and Part Groups .......................................................... 8-2
  Title Block and General Info Tabs ..................................................................... 8-2
    PageOne Attributes (Items>Title Block or Mfr. Parts/Part Groups>General Info) .... 8-3
    Items>Title Block Attributes .......................................................................... 8-4
    Part Groups>Make Available As Attribute .................................................... 8-4
    Make Available As Attribute and the "Force/Identical" SmartRule ................. 8-4
    PageTwo Tab .................................................................................................... 8-4
  Specification Mapping: Result Compliance from Parts’ Specification Table Mapped to PageTwo Attribute 8-5
## 9 Declarations

### More About the Declarations Classes

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier Declarations of Conformance</td>
<td>9-2</td>
</tr>
<tr>
<td>Japanese Green Procurement Declarations</td>
<td>9-2</td>
</tr>
<tr>
<td>Part Declarations</td>
<td>9-2</td>
</tr>
<tr>
<td>Substance Declarations</td>
<td>9-3</td>
</tr>
<tr>
<td>Homogeneous Material Declarations</td>
<td>9-3</td>
</tr>
<tr>
<td>IPC 1752x Declarations</td>
<td>9-3</td>
</tr>
<tr>
<td>BOS Data Delivered by Scriba Tool</td>
<td>9-3</td>
</tr>
<tr>
<td>Privileges</td>
<td>9-3</td>
</tr>
<tr>
<td>Classes and Subclasses</td>
<td>9-4</td>
</tr>
<tr>
<td>PDF forms for pre-version 2.0</td>
<td>9-4</td>
</tr>
<tr>
<td>XML Data Delivery</td>
<td>9-4</td>
</tr>
<tr>
<td>Mapping Between Agile and IPC 2.0</td>
<td>9-4</td>
</tr>
<tr>
<td>Guidelines for Parts and Specifications on IPC Declarations</td>
<td>9-5</td>
</tr>
<tr>
<td>IPC-BOS Import for Multiple Products and Use Cases</td>
<td>9-5</td>
</tr>
<tr>
<td>Multiple Products Use Cases</td>
<td>9-5</td>
</tr>
<tr>
<td>Case 1: Same Mass and Same Material Content</td>
<td>9-5</td>
</tr>
<tr>
<td>Case 2: Different Mass and Same Material Content</td>
<td>9-5</td>
</tr>
<tr>
<td>Case 3: Same Mass and Different Material Content</td>
<td>9-6</td>
</tr>
<tr>
<td>Case 4: Different Mass &amp; Different Material Content</td>
<td>9-6</td>
</tr>
<tr>
<td>IPC 2.0 New Map Attributes</td>
<td>9-6</td>
</tr>
</tbody>
</table>

### Tabs and Attributes in Declarations

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover Page</td>
<td>9-7</td>
</tr>
<tr>
<td>Affected Parts Tabs</td>
<td>9-7</td>
</tr>
<tr>
<td>Parts Tabs Attributes</td>
<td>9-8</td>
</tr>
<tr>
<td>Excluding Compositions from Rollups</td>
<td>9-8</td>
</tr>
<tr>
<td>Substances for Parts Table</td>
<td>9-8</td>
</tr>
<tr>
<td>Specifications Tab</td>
<td>9-9</td>
</tr>
<tr>
<td>Rules for Synchronizing Declaration Parts Tables and Specifications Table</td>
<td>9-9</td>
</tr>
<tr>
<td>From the Object in Web Client</td>
<td>9-9</td>
</tr>
</tbody>
</table>
10 Importing and Exporting Data in PG&C

- Change-based Revisions on the Item ................................................................. 10-2
- Importing Compositions to Items ................................................................. 10-2
  - Change Number in an Item ........................................................................ 10-2
  - Rules when Importing Compositions into Items ........................................ 10-3
  - Rules when Importing a Composition into Items or Manufacturer Parts ...... 10-3
- Notes and Special Cases of Importing Compositions .................................. 10-4
- Sources of Compositions ........................................................................... 10-5
- Importing Specifications to Specific Revisions of Items .............................. 10-5
  - Summary of Importing a Specification to an Item .................................. 10-6
  - A Difference with Part Groups ................................................................. 10-6
- Importing and Exporting Declaration Data ............................................... 10-6
  - Declarations Actions (Process Extensions) .............................................. 10-7
  - Importing Substances to a Declaration with MS-Excel ......................... 10-7
    - Downloading the MS-Excel Template .................................................. 10-8
    - Adding Substances to the Spreadsheet.............................................. 10-8
    - Importing Substances to the Declaration ........................................ 10-9
    - Notes on Excel-based Declaration Submissions ............................... 10-9
  - Importing and Exporting IPC 2.0 MDOs .................................................. 10-10
  - Importing and Exporting IPC Declarations ......................................... 10-11
    - Transformation Files for Importing Compositions ............................ 10-12
    - Item Number when Importing into Declaration ................................ 10-12
    - Correcting Invalid Substances ......................................................... 10-13

11 Rolling Up Compliance Data Using Internal Rollup

- Defining Approach to Compliance Management ....................................... 11-1
- Use Cases .................................................................................................... 11-2
- Declaration Classes in Rollups ................................................................. 11-2

From the Import Utility ....................................................................................... 9-10
Workflow Tab ...................................................................................................... 9-10

Creating Declarations ...................................................................................... 9-10
Selecting Specifications to add to Declarations ............................................ 9-10
Creating a Declaration ..................................................................................... 9-11

Working with Declarations .............................................................................. 9-13
Invalid Substances in the Declaration .......................................................... 9-13
Restriction about invalid Substances in Declarations .................................... 9-13
Action > Verify Substances ........................................................................... 9-13
Correcting Substances in Declarations .......................................................... 9-14
Working with the Part Tables ......................................................................... 9-14
Working with the Part Substances Tables ...................................................... 9-14
  - Substance Editing .................................................................................... 9-15
  - Substance-Type Declarations: Substance, JGPSSI, and IPC 1752-1 Declarations 9-15
  - Homogeneous Material-Type Declarations: Homogeneous Material and IPC 1752-2 Declarations 9-15
  - Add/Update with Import .......................................................................... 9-16
When and Why Rollups are Run ................................................................. 11-3
Parts Qualifying for Scheduled Compliance Rollups ................................. 11-4
  Stage 1 - Perform Compliance Rollup on Shippable Items: ...................... 11-4
  Stage 2 - Perform Compliance Rollup on Parts/PGs that are Flagged .......... 11-4
Expected Time Required to Complete Systemwide Rollup ....................... 11-5
When Rollup was Last Run ........................................................................ 11-5
Tracking Compliance Changes through History ........................................ 11-5
Compliance States .................................................................................... 11-6
  Worst-Case Priority of Compliance States ............................................. 11-6
  How Compliance States are Ranked ..................................................... 11-6
    Treat Exempt as Compliant in BOM Rollup Rule ................................. 11-7
Composition Rollup on Bill Of Substances ............................................... 11-7
  Kinds of Composition ........................................................................... 11-7
  BOS Hierarchy .................................................................................... 11-7
  Compliance Validation for BOS Tree .................................................... 11-8
When Composition Rollups Occur ......................................................... 11-8
  Two-Step Sequence in Rollups ............................................................. 11-8
  How Disclosure Logic affects Rollups ................................................. 11-8
  Disclosure Logic Use Case ................................................................. 11-9
  Substance Declarations and Need Rollup Flag ..................................... 11-10
Compliance Rollup on BOM/Items, Mfr.Parts, and Part Groups ................ 11-10
  Some Rollup Fields ............................................................................ 11-10
  BOM Rollup Evaluating Compliance States ......................................... 11-11
  Part-Level Validation - Rollup from Compositions to Part/Part Group .... 11-12
    Find Qualified Compositions for Use or Re-use ................................ 11-12
    Rules for Selecting Compositions for Rollup on Part/Part Group (Internal Specifications).... 11-12
    Composition Selection Logic ............................................................ 11-12
    Perform the Rollup for Each Qualified Composition ......................... 11-13
    Re-using Exemptions in Rollups ....................................................... 11-13
    Combine Rollup States of Qualified Compositions ......................... 11-13
  AML Validation - Rollup from AML to Item ........................................ 11-14
  Validation Rollup from Item to Assembly ............................................ 11-14
  Rules for Calculating Compliance for Specifications on Parts ............... 11-15

12 Rolling Up Compliance Data Using External Rollup

External Compliance Rollups ..................................................................... 12-2
  Actions Triggering External Rollup ..................................................... 12-2
  Archived External Compositions ....................................................... 12-2
Manual External Rollup using Excel Add-In ............................................ 12-3
  Excel Add-In Use Case ................................................................. 12-3

13 Managing Suppliers

Attributes in Suppliers ............................................................................ 13-1
  Buttons on the General Info tab ....................................................... 13-2
Creating Compliance Suppliers ............................................................ 13-3
  Supplier Types ................................................................................. 13-3
### 14 PG&C Searches

- Accessing PG&C Saved Searches ................................................................. 14-1
- Using the Search Options in Add Operations .............................................. 14-1
- Searchable Attributes for PG&C ................................................................. 14-2

### 15 PG&C Reports

- Accessing PG&C Reports ............................................................................ 15-1
- Report Privilege ......................................................................................... 15-2
- View and Modify a Compliance Report ....................................................... 15-2
- Specifics to Compliance Report Layouts ..................................................... 15-3
  - Part Compliance Report ........................................................................... 15-3
  - Part Groups Compliance Report .............................................................. 15-4
  - Parts with Compliance Issues Report ...................................................... 15-5
  - Parts with Substances Report ................................................................. 15-5
  - Parts with Substance over PPM Report .................................................. 15-6
  - Supplier Compliance Report .................................................................. 15-6
  - Missing Substances Report ..................................................................... 15-7
    - Refinements to Missing Substances Report ........................................... 15-8
  - Declaration Workflow Metrics Report .................................................... 15-8
  - BOM Compliance Report ....................................................................... 15-9
  - External Rollups Report ......................................................................... 15-10
  - Exemptions Report ................................................................................ 15-11
- Configuring the External Rollup Task ......................................................... A-2
- Checklists for Configuring the PG&C Solution ........................................... A-3
  - PG&C-supporting Configurations ........................................................... A-3
    - Modify Default Admin User Roles for Specification Management Task ... A-3
  - PG&C-specific Nodes ........................................................................... A-4
  - PG&C-specific Classes ......................................................................... A-4
  - PG&C Users and Workflow .................................................................. A-5
  - Suppliers ............................................................................................... A-5
- Declarations Classes in Brief .................................................................. A-6
- Integrated Components for PG&C ............................................................ A-7
  - ComplianceRollup.log in Log.xml File .................................................... A-7
  - Configure Process Extensions (non-Events-based) for PG&C ................ A-8
  - IPC 1752x Declarations ........................................................................ A-9
    - BOS Data Delivered by Scriba Tool ..................................................... A-10
  - Privileges ............................................................................................. A-10
  - Classes and Subclasses ....................................................................... A-10
  - IPC Formats Supported in this Release ................................................ A-10
  - PDF forms for pre-version 2.0 ............................................................... A-10
  - Guidelines for Parts and Specifications on IPC Declarations ................. A-11
- Administrator Nodes for PG&C-specific Settings ....................................... A-11
Using the Declarations Workflow in RFI

Defining PG&C Users - Roles and Privileges in PG&C

Configuring the PG&C Classes

Deploying Custom Workflows in PG&C
Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product value chain.

Audience

This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Documents

Oracle’s Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html contains the latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available on your network from which you can access the Agile PLM documentation (PDF) files.

Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>Convention</td>
<td>Meaning</td>
</tr>
<tr>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
Introduction to Product Governance & Compliance

Agile Product Governance & Compliance (PG&C) is designed to help manufacturers manage all kinds of product compliance, including the ability to audit the presence and amount of regulated substances used in their products, and to demonstrate that they responsibly dispose of, recycle, or re-use parts containing those substances.

Compliance Regulations

Original Equipment Manufacturers (OEM) are required to take global responsibility to dispose of, recycle, or re-use electronics that contain hazardous substances. In addition to satisfying FDA regulations and ISO standards, any company that sells electronics equipment in an international market is subject to the OEM regulations of their target markets. These may include one or more of the following:

- **United States**: Good Manufacturing Practices; ISO Standards; U.S. Food & Drug Administration regulations
- **Europe**: Good Manufacturing Practices; Registration, Evaluation, Authorization and Restriction of Chemical Substances (REACH); Restriction of Hazardous Substances (RoHS); Waste of Electrical and Electronic Equipment (WEEE)
- **China**: Restriction of Hazardous Substances (China RoHS); Waste of Electrical and Electronic Equipment (China WEEE)
- **Japan**: Japanese Green Procurement Survey Standardization Initiative (JGPSSI)
- **International**: Joint Industry Guide (standards adopted by international companies, including IBM, Dell, Hewlett-Packard, others)

Cycle of Compliance Data-Gathering and Corrective Action

This figure depicts a process of due diligence concerning the compliance of existing products and new product designs. This is a “closed-loop” compliance corrective action process. Other Agile solutions - Product Collaboration, Product Quality Management, Product Cost Management, Product Portfolio Management - manage areas around the lower half of the circle. Product Governance & Compliance manages the compliance data-gathering area.
How PG&C Helps You Gather and Manage Compliance Data

People who manage the compliance process at the "buyer" site - compliance managers - must ensure that their company’s products adhere to government regulations and company policy. Agile PG&C helps you gather and analyze compliance data and to take appropriate corrective action.

PG&C is not only a communication vehicle between the compliance manager and information suppliers: it also manages the compliance of parts across multiple suppliers and multiple manufacturer parts. Ultimately, PG&C rolls all this information up to provide a product-level view of compliance.

More specifically, compliance managers use PG&C to:

- collect data about materials used to manufacture a product
- review compliance across the Approved Manufacturers List (AML) of a part, across multiple suppliers (the Approved Suppliers List, or ASL), across BOMs, subassemblies, and of final products
- generate reports to show the level of compliance
- manage supporting documentation, such as descriptions of current regulations, recovery manifests, disposal certificates of destruction, supplier compliance surveys, and other customer-specific specifications

Compliance managers often get compliance information for manufacturer parts from an information provider or collect the information via IPC standard/Excel spreadsheet and then load the collected compliance data into a PG&C declaration. Often this process gets automated via Customizations/Process Extensions.

In another scenario, at the supplier site, information suppliers use PG&C to complete and sign off material declarations:

- declare compliance with specifications concerning hazardous materials that may originate from its customers and from government agencies
- disclose which hazardous substances are contained in the components and subassemblies it provides

Figure 1–1 Depicts compliance process of existing and new product designs.
Agile PLM Documentation for PG&C

The Preface of this manual provides the URL to Agile documentation for current releases of Agile PLM. This manual assumes that Agile PLM has been installed and an Agile administrator has created Agile users with assigned roles that facilitate their work.

PG&C User Guide

This manual, PG&C User Guide, is a complete manual for working in the Agile PG&C solution. It describes how to work with the PG&C-specific business classes in Agile PLM and the Request For Information (RFI) compliance process.

Solution-specific Documentation for the PLM Administrator

Agile PLM end-users do not generally need to consult the Agile PLM Administrator Guide. The PLM administrator and the compliance manager can refer Appendix A, "Configuring Product Governance & Compliance," which describes the PG&C-specific nodes in the Administrator module in Java Client.

PG&C Supplier Guide

A small manual, PG&C Supplier Guide, provides information for your supplier users to learn to work in the Web Client (and, if installed, the Microsoft Excel-based Client) to complete their end of your compliance process. The compliance manager should be familiar with the contents of this guide.

Supplier users can access the Agile Documentation web site to download the Supplier Guide; or, the compliance manager can send the PDF to supplier users as an email attachment.

Getting Started with Agile PLM

Every PLM user must be familiar with the contents of Getting Started with Agile PLM. Each chapter is a comprehensive introduction to Agile client interfaces (Web Client and Java Client), concepts and terms used in Agile PLM, and important cross-solution features.

Chapters 2, 4 and 5 of Getting Started with Agile PLM contain information that is prerequisite to the information in this manual. Even experienced Agile PLM users may find it useful to review Chapter 2, "Navigating Web Client".

This table lists Getting Started chapters (and one other Agile manual) that will help you master your tasks in Agile PG&C.

<table>
<thead>
<tr>
<th>Feature or Concept</th>
<th>Documented in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agile PLM Web Client user interface and navigation - the primary client for PG&amp;C end users. You might read this chapter to gain understanding of the Agile PLM user interface.</td>
<td>Getting Started with Agile PLM, Chap. 2, &quot;Navigating in Agile Web Client&quot;</td>
</tr>
<tr>
<td>Introduction to Agile PLM concepts and terminology - essential if you have never used PLM.</td>
<td>Getting Started with Agile PLM, Chap. 4, “Concepts and Terms in Agile Solutions”</td>
</tr>
<tr>
<td>Feature or Concept</td>
<td>Documented in</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Introduction to Agile business objects, including creating &amp; deleting objects,</td>
<td><em>Getting Started with Agile PLM</em>, Chap. 5, “Working with Objects”</td>
</tr>
<tr>
<td>Actions, tabs, sharing, subscriptions, relationships, and references between</td>
<td></td>
</tr>
<tr>
<td>objects.</td>
<td></td>
</tr>
<tr>
<td>*These chapters may be studied as you need to work with reports, searches,</td>
<td></td>
</tr>
<tr>
<td>workflows and attachments:*</td>
<td></td>
</tr>
<tr>
<td>Using reports to gather data</td>
<td><em>Getting Started with Agile PLM</em>, Chap. 7, “Working with Reports”</td>
</tr>
<tr>
<td>Searches</td>
<td><em>Getting Started with Agile PLM</em>, Chap. 8, “Finding Agile Data with Searches”</td>
</tr>
<tr>
<td>Workflows</td>
<td><em>Getting Started with Agile PLM</em>, Chap. 9, “Routing Objects with Workflows”</td>
</tr>
</tbody>
</table>

| Importing and exporting files and data                                           | *Agile PLM Import & Export Guide* |

**PG&C Use Cases**

Below are general PG&C “use cases” and some use cases for the PLM administrator in PG&C. Each use case is cross-referenced to the corresponding section in the manual.

**List of Use Cases**

1. **"RFI Process Overview"** on page 3-2 - Levels of Due Diligence Using PG&C, Declaration Workflow and the RFI Process, Routing Declarations, and Completing the RFI Process;
2. **"Substances"** on page 5-1 - Creating Substances, Bill of Substances, and Mass Disclosures, Substance Aliasing, Mass Tolerance: Working with Substances;
3. **"Substance Groups > Substances Tab > Conversion Factor"** on page 5-2 - Substance Groups and Conversion Factor;
4. **"Specifications"** on page 7-1 - Creating Specifications Adding and Replacing Specifications, and setting Exemptions, Thresholds, and Validation Type: Tabs and Attributes in Specifications;
5. **"Parts and Part Groups"** on page 8-1 - Creating Part Groups, Mapping Feature, Tabs and Attributes in Parts and Part Groups, and Conversion Factor in part groups: Part Groups > Parts Tab;
6. **"Declarations"** on page 9-1 - Types of Declarations, Creating Declarations, Tabs and Attributes in Declarations, Working with the Part Substances Tables;
7. **"PG&C Searches"** on page 14-1;
8. **"PG&C Reports"** on page 15-1, including BOM Compliance Report;
9. **"Importing and Exporting Declaration Data"** on page 10-6;
10. **"Rolling Up Compliance Data Using Internal Rollup"** on page 11-1 - Rolling Up Compliance Data Using Internal Rollup, Rolling Up Compliance Data Using External Rollup, Compliance States, Composition Rollup on Bill of Substances, Compliance Rollup on BOM/Parts.
Use Cases for the Administrator

Here are a few use cases for PG&C configuration by the administrator. Appendix A, "Configuring Product Governance & Compliance" contains a series of “checklists” that cover numerous areas of interest for the administrator, including the nodes in the Admin tree’s PG&C node folder, as well as PG&C-specific Classes, Workflows, Users, and Suppliers.

1. **Setting up Rollup Rules** - Compliance Rollup Rule-Setting
2. **Mapping Specifications** to Parts > PageTwo (Items or Manufacturer Parts) - Specification Mapping
3. **Managing Events in PG&C** - Use Cases for Event Management in PG&C.
There are various client platforms used by Oracle Agile PLM. The list below is specific to the PG&C solution.

**Agile Java Client**

When Agile PLM was installed at your company, PG&C may have been fully or partially configured. Your Agile PLM administrator, working in the Administrator module in Agile Java Client, may have further configured the following:

- Created end-users in the PLM system with assigned roles and privileges;
- Set up PLM business classes to be able to create PG&C-specific objects, such as Substances, Specifications, and Declarations;
- Configured Manufacturer companies that furnish your company with manufacturer parts and subassemblies, and Supplier companies that furnish your company with compliance-specific information.

---

**Note:** Agile PLM administrator may have renamed classes or subclasses and created additional subclasses, per the company’s requirement.

End-users do not work in Java Client for PG&C.

*Appendix A, “Configuring Product Governance & Compliance”* refers to the PLM administrator and Java Client configurations.

**Agile Web Client**

Compliance managers and other users at the Buyer company work in Agile Web Client. This manual is concerned with PG&C-specific functions and objectives.

*Getting Started with Agile PLM* is the primary guide to Web Client use, as well as cross-solution features like Workflows, Searches, and Reports.

**Modified Web Client Interface**

Your information suppliers also log in to Web Client, but their assigned role dictates that the user interface that they use - the **Basic Supplier UI** - is greatly simplified from the version that you use. A chapter in this manual covers how you work with suppliers, and the Basic Supplier UI is documented in *PG&C Supplier Guide*. 
Microsoft Excel-based Client

A template is available for an information supplier to complete JGPSSl declarations. It is also possible to create custom templates in Microsoft Excel; you can create Excel templates for any of the declaration classes in Agile PG&C. For more information, see your PLM administrator, or contact your Oracle Consulting - Agile Practice representative.

The Microsoft Excel-based Client requires:

- Windows desktop,
- Internet Explorer 7.0 or higher, to log in to Web Client, and

---

Note: Some companies do not permit their employees to download ActiveX controls to their desktop computers. Therefore, the Microsoft Excel-based Client may have to be implemented by the IT department of your company via a "push approach": this automatically pushes the ActiveX control out to users’ desktops. Otherwise, your company can get the ActiveX or Plugin installer from the Agile Support website and install it on users’ desktops.

---

PG&C Classes of Objects

This section gives brief summaries of the Agile PLM business objects used in the PG&C solution. In this context, “business object” simply refers to those entities that you can see in the product record.

Substances Classes

Four kinds of substances are represented in PG&C:

Substance
Defined as a “chemical element and its compounds in the natural state or obtained by any manufacturing process.” Substances are part of materials, components, or products. There can be a distinction between intentional substances, which are present in the product to fulfill a certain function, and unintentional substances, such as impurities.

Example: Aluminum - Al or Al2O3

Substance Group
A grouping of substances that have a Base Substance in common. Every substance within the substance group has a Conversion Factor used to convert the weight of the substance to the weight of the base substance of the group.

Example: Aluminum and Aluminum Compounds - This group has a base substance of Aluminum and includes other Aluminum-based compounds.

Material
A mixture or solution composed of two or more substances that is used to create standard or custom parts.

Example: A roll of sheet metal made out of a certain Aluminum alloy
Subpart
A part within the BOM of a component. Standard components to electronic products such as chips, resistors, motors, or electrical cables all consist of subparts.

Consumers of components think of components as indivisible objects. When they need to think about the BOM of a component, they use the term subpart (a part without a part number). The manufacturer of the component cares about the BOM of a component and will represent the subparts as parts in his systems.

- Homogeneous Materials: A subpart can be homogeneously made of one material (for example, the plastic jacket of a cable), or a subpart can be made of multiple homogeneous materials (for example, the lead frame of a chip, which is a subpart, consists of the frame itself made out of one metal and the lead frame plating).

Specifications
Specifications track the different legislations, customer specifications, or internal specifications with which an assembly or part must comply. The Specifications object is used to create representations of specification documents, regulations, published compliance criteria. You will very likely hold the actual (electronic) document as an attachment to a specification object.

An example of a regulation issued by a government body is the European RoHS directive. Environmental specifications are substance-based, and contain a list of banned substances or substances of concern and their threshold values.

In Agile, specifications are used to validate declarations and assess the compliance of parts by evaluating whether a given restricted substance in the composition of a part surpasses its specified threshold value.

Parts and Part Groups
Object types - base classes, classes, and subclasses - describe the structure of business objects found in Agile PLM. All objects created in PLM are an instance of a single subclass. (Remember, your PLM administrator may have added subclasses that are not named in this manual, or renamed classes or subclasses from what they are called in this manual.)

Items is the base class that is parent to the Parts and Documents classes, which are parents to the Part and Document subclasses, respectively. Parts, documents, and other subclasses can represent the components of products made by your company.

Manufacturer Parts can represent products made by other companies that your company purchases to assemble its products.

- As a shorthand, this manual uses the word "part" to refer to all objects from the Parts, Documents, or Manufacturer Parts classes.

The Part Groups class is used to group similar parts. Subclasses are Part Family, Commodity, and Item Group. However, the subclass used most often in PG&C is the Part Family.

---

Note: This manual uses "part group" for any object in the Part Groups class.

Therefore, the phrase "parts and part groups" (or the notation <Part/PG>) comprises "any kind of part used in the company's manufacturing process.”
Declarations

A declaration is the main object of record in the PG&C solution. Declarations are used to gather compliance information about items, manufacturer parts, and part groups.

A declaration is a record of questions posed by a compliance manager to an information supplier about the supplier itself, its products, or how its products comply with given specifications. Upon completion, it contains the supplier’s responses to the questions.

Declarations also keep track of all the substances, substance groups, homogeneous materials, and subparts that are contained in parts and part groups. This record of substance-specific information is the basis of the Bill of Substances.

Conceptual Entities in PG&C (non-business objects)

This section gives brief summaries of certain concepts (entities) which are of importance.

Bill Of Substances

A Bill of Substances (BOS) is a tree structure, like the BOM. It consists of:

- Subparts - zero or more levels, and then...
- Materials - zero or 1 level, and then...
- Substance Groups - zero or 1 level, and then...
- Substances - zero or 1 level.

See "Bill of Substances" on page 6-1.

Compositions

Declarations can contain multiple parts. When an information supplier responds to a declaration, all information related to a single part within the declaration is called a Composition.

More specifically, a composition is the aggregate of a supplier for a given specification and for a given part (that is, an Item and its Revision or a Manufacturer Part) or part group.

This means that a declaration is a container of not only “parts/part groups” but also their collections of compositions.

For details see "Compositions" on page 4-1.

Level of Disclosure in Compositions

Compositions can be Fully Disclosed, Partially Disclosed, and Undisclosed. These are states stored on the composition:

- Full Disclosure: when 100% (or close to 100%) of the weight of each level in the BOS up to the part's weight is declared within a composition in terms of chemicals;
- Partial Disclosure: when there is enough weight information available within the BOS and the part for the system to calculate the unreported weight portion of the substances;
- Undisclosed: When weight information is missing PG&C cannot perform its validations.

Agile PG&C validates the level of disclosure in the declaration.

For more information about the levels of disclosure, see "Mass Disclosure" on page 5-5.
Requests For Information - the main subject of this chapter - can take many forms, based on the regulations a company may adhere to and the declarations used to gather compliance-specific data. But the capabilities of the PG&C solution are not wholly defined by such PG&C objects as Specifications and Declarations.

Setting up the RFI process, helps you to analyze the levels of due diligence that you require. The following sections cover a few examples of due diligence from a simple level to a more complex level:

**Specification Management**

In terms of substance-based environmental compliance, the simplest level of due diligence involves specifications.

- Let the system assign specifications to all parts within this BOM, and set declared compliance on the specification for a part.
- Define a specification, list exemptions, attach specifications to the product level.
- Let the system roll up the compliance information and review for compliance at the product level.

This use case illustrates the usage of PG&C for general product compliance such as compliance with an FCC specification or with a “MilSpec.”

**Declarations Gather Compliance Information**

A higher level of due diligence is achieved by using a declaration process including a supplier sign-off to gather compliance information. Use declarations to collect information about the compliance of a part or a supplier with a certain specification.

**Full Use of PG&C Business Objects**

The highest level of due diligence for substances-based environmental compliance is achieved by the full use of PG&C object types. - substances, specifications, declarations, part groups - as well as solution-oriented features of “non-PG&C” object types - items, manufacturer parts, suppliers - to produce comprehensive disclosure statements about compositions.

**Summary**

This simplified hierarchy demonstrates that you can tailor the use of the PG&C solution depending on the required type of compliance and the desired level of due
diligence. Substances and even Declarations are not absolutely required to gather benefits from PG&C. The Specification is the most crucial object type; and the Composition - the collection of compliance data - is unique to Agile PG&C.

RFI Process Overview

A Request For Information (RFI) consists of a material declaration, which lists the parts in a product assembly and shows the substances and materials contained in those parts. It is linked to specifications, which may restrict how much of a particular substance the product assembly may contain. A declaration request to a supplier can contain multiple combinations of parts and part groups and specifications (or compositions).

The table below lists the general sequence of the RFI process:

<table>
<thead>
<tr>
<th>Process step</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performed on Buyer side by Compliance Manager.</strong></td>
</tr>
<tr>
<td>Identify parts and part groups for which compliance data is required. See &quot;Parts and Part Groups&quot; on page 8-1.</td>
</tr>
<tr>
<td>Identify people within your company (for parts) and suppliers (for manufacturer parts) who can provide compliance data. This may be an informal process - collecting names and verifying that internal and external (supplier) users with appropriate roles and privileges are available in the database - or involve more research and creation of an Approved Suppliers List, or ASL. See &quot;Managing Suppliers&quot; on page 13-1.</td>
</tr>
<tr>
<td>Create declarations - one supplier per declaration - for parts, manufacturer parts, and part groups. See &quot;Creating Declarations&quot; on page 9-10.</td>
</tr>
<tr>
<td>Route a declaration to an information supplier using the Declarations workflow. See &quot;Routing Declarations&quot; on page 3-4.</td>
</tr>
</tbody>
</table>
Creating Declarations without Supplier Interaction

In another commonly used scenario, the Compliance Manager creates a Declaration on behalf of a supplier and imports the compliance data without supplier interaction. This process is often automated using process extensions for mass imports.

Declaration Workflow and the RFI Process

There are seven default classes of Declarations in PG&C, and they all use the Default Declarations Workflow. The Declarations workflow is the vehicle to send RFIs to your suppliers.

As such, every declaration is a routable object used to keep track of the compliance information about all the substances and materials that are contained in parts or part groups associated in the declaration. As a routable object, the user's actions (on either the buyer or supplier side) result in the declaration moving into another status where the next user will act on it.

The user assigned as the “change analyst” of the compliance workflow is called the compliance manager. The compliance manager creates and sends a declaration request to an information supplier. The supplier completes the declaration by providing data statement for each combination of specification and part - the composition.

In the sequence that results in an RFI, the main task is to identify those parts (Items and Manufacturer Parts) and part groups for which you must seek compliance information.

The other task is to identify the people who will gather and provide that information. This includes people within your company (other compliance managers and assistants) and people who work for your suppliers.
Routing Declarations

The Default Declarations workflow follows a straightforward process flow, as detailed in the following table.

---

**Important:** PG&C permits customized workflows to be sent to suppliers. See your Agile administrator.

---

<table>
<thead>
<tr>
<th>Status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Compliance manager (an Agile user who has been assigned the Compliance Manager role) creates a new declaration, or modifies an existing declaration by adding new items, manufacturer parts, or part groups. Specifications are added to the declaration, and also an information supplier; there is always only one supplier per declaration.</td>
</tr>
<tr>
<td>Open to Supplier</td>
<td>The declaration requests the supplier - an Agile user who has been assigned the (Restricted) Material Provider role - to confirm whether parts comply with specifications. For more information about creating and managing suppliers, see &quot;Managing Suppliers&quot; on page 13-1.</td>
</tr>
<tr>
<td>Submit to Manager</td>
<td>Supplier confirms or denies that the parts that they supply comply with regulations. The supplier electronically &quot;signs&quot; and submits the declaration back to the compliance manager.</td>
</tr>
<tr>
<td>Review</td>
<td>The compliance manager and other reviewers verify and approve the contents of the declaration. A reviewer (system user or supplier user) can acknowledge a declaration when the user is added as an acknowledger.</td>
</tr>
</tbody>
</table>
For more information about workflows and customizing workflows (including how to add and remove approvers, acknowledgers, and observers), see the Routing Objects section of the Getting Started with Agile PLM.

Once a declaration is opened to a supplier, only the supplier’s declaration recipients can edit it. For other users, including the compliance manager, the declaration becomes “read-only” until it is returned by the supplier (unless, as always, the behavior of the workflow has been modified by the administrator).

Note: A released declaration is not set back to Pending status if one of the approvers rejected it and the workflow has a rule that says “If rejected, set to Pending.”

Notifications when Declarations Advance to and from Supplier

This set of default behaviors regards automatic notifications, not user-designated Approvers and Observers.

- Declaration Buyer to Supplier - The notification is sent to the “Default Declaration Recipient” specified on the General Info tab. Although this notification is sent only to the default recipient, other users in the supplier company with Material Provider role can respond to the declarations as well.

- Declaration Supplier to Buyer - The compliance manager is automatically added to the notification list. If no compliance manager was selected, the system adds everyone on the Compliance Managers notification list.

- Declaration Supplier to Buyer - If there are no compliance managers in the system, the originator is added to the notification list.
Acknowledgments for Declarations

A user or user group added as an acknowledger can acknowledge a declaration. Following are examples for acknowledgments for declarations.

Add Acknowledger from the Change Status dialog or the Add Reviewers dialog;

When the Acknowledger opens the declaration, the Acknowledge button is enabled;

The Acknowledger clicks the Acknowledge button and acknowledges the declaration.

Receiving Notifications

Following are the notifications tied to the Acknowledge function:

- Substance Declarations - Declaration Acknowledge Change, Add Acknowledger
- Substance Declarations - Declaration Status Promotion, Acknowledgers
- Substance Declarations - Acknowledge Material Declaration, Notifiers
- Substance Declarations - Acknowledge Declaration, Remove Acknowledger
- Substance Declarations - Acknowledge Declaration, Escalation
- Substance Declarations - Acknowledge Declaration, Reminder

For more about declaration notifications, refer to "Declaration Workflow and the RFI Process" on page 3-3.

Information Supplier Fills Out a Declaration

This manual has more information about suppliers in "Managing Suppliers" on page 13-1. The PG&C Supplier Guide documents the supplier experience in the PG&C solution.
When a declaration request is opened to an information supplier, the supplier is responsible for completing the declaration and disclosing if any restricted substances are contained in the components and subassemblies it provides and whether those substances comply with specifications.

To complete and sign off on declarations, one or more declaration recipients for the information supplier must be assigned the (Restricted) Material Provider role. If you have questions about who in your supply chain has been assigned this role, see your administrator.

The declaration recipient should do the following to complete a declaration.

- For each part, manufacturer part, and part group, fill in the Mass, Mass PPM, and Compliance fields, particularly for substances that are restricted by specifications;
- Add or remove substances from the Substances tables (under the Items, Manufacturer Parts, and Part Groups tabs) on the declaration as necessary; to do this, they must use process extensions (Export AXML and Import AXML) or the Microsoft Excel-based Client, as long as they are in the Basic mode ("supplier interface") of Web Client. Available process extensions in the Actions menu vary, depending on the Declaration subclasses. IPC-1752 declarations have different Import/Export options available than substance declarations or homogeneous materials declarations;
- Complete other flex fields on the <parts/PG> tables as well as the <parts/PG> Substances tables.

For detailed tasks about adding, removing, and editing data on declarations, "Tabs and Attributes in Declarations" on page 9-6.

When the material provider changes the status of the declaration from Open to Supplier to Submit to Manager, he must “sign-off” the declaration.

**Completing the RFI Process**

Once the compliance manager has received, reviewed, and approved the content of the declaration, he advances the workflow to the Released status, and the new data about substances and materials are automatically published to Agile PLM. Once published, the materials are visible on the Compliance tab of the part or part group, as appropriate.

The “buyer” company can now examine the quantities of all materials in a given top-level assembly and find out if the assembly is compliant with a set of specifications by running compliance rollups. See "Rolling Up Compliance Data Using Internal Rollup" on page 11-1.
Reviewing and Publishing a Declaration

Once a declaration is released, it is automatically published. When a new declaration is published, it overwrites substances from previously published declarations.

**Note:** If the substance data on an item’s or manufacturer part’s Compliance tab is from a declaration, you cannot modify it except through another declaration.

When a declaration is released for a part or part group:
- The composition appears in the Active Declarations table in the part’s Compliance tab.
- If a matching active composition exists (same supplier + same spec), then the previous composition is moved to Historical Compositions table and the new one becomes active.
A crucial idea in PG&C is the composition; a composition is not a configurable “business object” in Agile PLM. A composition represents the total collection of information contained in a completed declaration.

This chapter presents information about objects and processes that are documented later in this manual. As you become familiar with the rest of the objects and processes in the PG&C solution, you may return to this chapter.

Contents of a Composition

The information gathered and collected in a declaration is:

1. provided by a single information supplier
2. in reference to a given specification (often called "spec") and

   **Note:** An exception is the "All Spec" use case, where no specification is added to the declaration in order to collect raw compliance data.

3. for a given part, manufacturer part, or part group.
   
   In the case of a part (but not a manufacturer part), the revision-"rev"-is always significant; this fact is suggested by the phrase "part+rev".
   
   So, a composition is a "part+rev in reference to a spec and provided by a supplier" or a "manufacturer part in reference to a spec and provided by a supplier" - in shorthand, a "part with a spec, from a supplier."

4. A fourth factor that contributes to the uniqueness of a particular composition is the attribute Exclude from Compliance Check. This attribute is fully explained in "Excluding Compositions from Rollups" on page 9-8. Suffice to say here that whether this attribute is set to No (the default) or Yes, the system interprets the "Exclude" attribute as a distinguishing factor for that composition.

5. Compositions affected by External Rollup are now marked as "External Compositions". Because the external rollup engine rolls up the substances from all suppliers, it does not distinguish the substance from each supplier. Therefore the supplier of External Composition is listed as blank.

When a declaration is completed and released, the data it has collected is published or electronically distributed across the product record to the parts themselves and, therefore, to their associated Bills of Material.
To summarize, through the idea of composition and its carrying agent, the declaration, compliance data is integrated into the product record in visible form as the Bill Of Substances (BOS), just as part data is integrated into the Bill Of Material (BOM).

---

**Note:** When compositions are directly imported into items or manufacturer parts, naming a supplier is optional. Even in the context of declaration compositions (compositions that you publish from a released declaration), naming a supplier on the declaration is optional.

---

## Stages of Compositions

The Agile system distinguishes between compositions that are published, are not yet published, or have been overwritten by new published data:

- **Pending composition** - a composition on an unreleased declaration
- **Active composition** - a composition that is currently active for the part; it can be from the latest released declaration; it can be a directly imported composition (on the part’s Compliance tab > Declarations and Compositions table) for that part + spec + supplier combination (+ “Exclude” attribute setting); or it can be from external rollup.
- **Inactive or historical composition** - the old composition when replaced by either a new declaration or by importing a new composition for the same supplier + spec combination.

---

**Note:** Inactive compositions are never used to assess compliance

---

You can archive compositions in items and manufacturer parts. See "Archiving and Unarchiving Compositions in Items and Mfr. Parts" on page 4-4.

---

## Compositions in the Context of Parts

To add compositions to the part/PG Compliance tab > Declarations and Compositions table, you can follow the original RFI process, that is, (1) create and send a declaration to a supplier, (2) receive and verify the completed declaration, and (3) publish (release) it. You can also manually import composition and substance data into items and manufacturer parts (but not part groups) - see "Importing Compositions to Items" on page 10-2.

Regarding modifying or removing compositions, when a composition with same supplier + same spec (+ “Exclude” attribute) is released or imported, the previous composition is inactivated, but not deleted. Also, if you make some changes to the same Import file and import again, the system treats it as a new composition and archives the previous one. There is more flexibility in the current release that allows the user to re-activate previously inactivated compositions.

You can publish a composition from a declaration that does not have a specification, which results in the "All Spec" composition (see "All Spec" Use Case" on page 7-7); it is now possible to publish a declaration with no supplier named at all.

When importing compositions and substances into an item or manufacturer part, both specification and supplier are optional. However, Composition Type is required; see "Role of Composition Type Field" on page 4-3.
**Note:** When the specifications of a part group are modified or new declarations are made against this part group - for example, a supplier submits a declaration that includes information about the part group - then upon release of that declaration, the composition relating to that part group will not only be copied to the Compliance tab > Declarations and Compositions table of that part group, but also to all parts belonging to that part group, while applying the Conversion Factor to convert part and substance weights, if applicable. When you perform a “Save As” operation of a part or part group, compositions are not copied to the new object. The system copies the specifications and suppliers over to the new object, but not Active compositions.

---

**Role of Composition Type Field**

For a composition to be imported in a part or part group, the only required field is Composition Type. The available values for Composition Type are:

- Substance Composition
- Homogeneous Material Composition
- Part Composition
- External Composition - this type is not supported for importing a composition.

It is not necessary for a composition to have a supplier or a name - remember that a composition is an important concept in PG&C but there is no business object itself.

As there are more kinds of declarations than composition types, it is helpful to group the Declarations classes as shown in the table. Supplier Declarations of Conformance do not have compositions.

<table>
<thead>
<tr>
<th>This declaration class...</th>
<th>...releases to this value in Composition Type</th>
<th>Validation Type of Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substance Declaration, JGPSSI Declaration, IPC 1752-1 (Substance) Declaration</td>
<td>Substance Composition</td>
<td>Part Level</td>
</tr>
<tr>
<td>Homogeneous Material Declaration, IPC 1752-2 (Homogeneous Material) Declaration</td>
<td>Homogeneous Material Composition</td>
<td>Homogeneous Material Level</td>
</tr>
<tr>
<td>Part Declaration</td>
<td>Part Composition</td>
<td>Homogeneous Material Level or Part Level</td>
</tr>
<tr>
<td>N/A</td>
<td>External Composition</td>
<td>Homogeneous Material Level or Part Level</td>
</tr>
</tbody>
</table>

When a composition is imported to an item or manufacturer part, it appears in the Part’s Compliance tab > Declarations and Compositions table. Before it begins the import, the system looks for an existing active composition with the same parameters (supplier and specification name and "Exclude" attribute); if it finds an active, matching composition, the active one is inactivated, the importing of the new composition begins and this one is made active.

If the import does not succeed, the original active composition remains active.
The subject of importing compositions, as well as entire declarations, is covered in "Importing and Exporting Declaration Data" on page 10-6.

Validation Type in Conjunction with Composition Type

A relationship exists between a specification’s Validation Type - Part Level or Homogeneous Material Level - and a manufacturer part’s or item’s Composition Type - Part Composition, Substance Composition, or Homogeneous Material Composition. This section describes the interaction of these two attributes.

Validation Type is discussed in detail in “General Info Tab” on page 5-1.

The Composition Type attribute of an item or manufacturer part provides a way to track what type of composition is imported to the part. (Note that Supplier Declarations of Conformance do not have the Composition Type attribute.)

- For compositions published from declarations, the system selects the correct Composition Type based on the Declaration class.
- When the system assesses compliance for a specification, it looks for all matching specification compositions that correspond to the validation type of the specification.

So, for a Part Level validation specification, the system looks at all Substance compositions and Part Compositions, therefore, it looks for compositions with same spec that are published from Substance Declarations, JGPSSI Declarations, IPC 1752-1 Declarations or Part Declarations.

For a Homogeneous Material Level validation specification, the system looks at all Homogeneous Material compositions and Part Compositions; therefore, it looks for compositions with same spec that are published from Homogeneous Material Declarations, IPC 1752-2 Declarations, or Part Declarations.

For a given specification, if there is a composition published that has the same specification, the system uses that composition only. If multiple suppliers have provided compositions for that spec, then the system uses compositions from all the suppliers and applies the Composition Rollup Rule (which is an Administrator setting) to determine the compliance of that specification.

For a given specification, when there is no composition with the same spec, the system looks for (latest released or imported) Full Disclosure composition (for each supplier) that corresponds to the same validation level of the specification. If it is not able to find any Full Disclosure compositions, the system looks for Partial- or Un-disclosed compositions that have no specification, which is called "All Spec."

For example, with a part level specification, when there is no composition found with that spec, the system uses all active "All Spec" compositions published from Substance, JGPSSI, or IPC1752-1 declarations or directly imported substance compositions without any spec.

**Note:** A part composition without a spec is not considered to be an "All Spec" composition, since it contains no substance-level information and hence is not useful.

Archiving and Unarchiving Compositions in Items and Mfr. Parts

The Archive and Unarchive buttons on the Declarations and Compositions table of items and manufacturer parts is enabled only if the user has the proper Modify
特权允许在合规表单 > 声明和组成表中为声明属性表单，对于该部分。

在相同的表中，用户可以将视图字段选中为活动、存档和待审部分和声明。

为使术语不混淆的术语如下：
- 档案 = 使组成失效
- 激活 = 激活失效组成
- 存档 = 使失效组成失效
- 激活 = 激活失效组成

对于存档考虑的用例是，未合规声明在发布时，可能会将整个顶层装配件置于非合规状态。

拥有决定不购买非合规零件的权限的用户应被允许使用存档按钮，从产品记录中删除违规的组成。

当组成失效时，即从活动状态中移除，包含该部分的装配件现在有更好的机会处于合规状态。

您可以重新使存档的组成（选择行）和选择组成（选择行），并单击解存档按钮。重新激活组成也仅适用于项目和制造商组成部分。

当系统被告知解存档一个组成时，系统会自动存档任何“匹配”的活动组成（具有相同供应商和规格的组成）。如果存在具有相同规格和相同供应商的组成部分，当视图过滤为活动时看到一个，当视图过滤为存档时看到另一个，当您选择存档的组成并单击解存档时，系统会自动存档活动组成。这与系统在导入组成时的行为一致。

请注意，当您更改组成的状态时，合规检查字段将被重新设置为是，除非是外部组成。在制造商部件中可以看到该变化，但在项目中看不到。此外，存档和解存档操作可能会更改组成中的所有规格的合规状态。最佳实践是，每当您更改组成的状态时，进行合规汇总。

**Compositions in the Context of Declarations**

一个组成描述了在发布的声明中收集的聚合数据。一个组成代表了（1）一个供应商，（2）一个给定的规格和（3）一个给定的部件（以及修订）或部件组。

**Declarations Gather and Store Information about Compositions**

声明是一种结构化的方式，用于将有关部件的环保合规性信息带入Agile PLM。每个声明都是为一个单独的部件的声明。
supplier. Every declaration contains associations to parts or part groups, which, combined with one or more specifications, is the composition. You can store information in a declaration at these levels:

1. At the General Info ("cover page"), Page Two (fields from the class), and Page Three (fields from the subclass) levels of the declaration - these represent entered data about the declaration and describes what information is being sought;

2. At the part level within the declaration - that is, in reference to associated parts or part groups in the context of a specification - and at each of the Bill of Substances (BOS) levels if the declaration <type> requires the supplier to create a BOS for each affected part;

3. At the subpart level - in reference to associated Subparts;

4. At the material level - in reference to associated Materials;

5. At the substance group level - in reference to associated Substance Groups;

6. At the substance level - in reference to associated Substances.

*Parts can be specified by Manufacturer’s Part Number (MPN) or Internal Part Number (IPN)*

Information on Declarations also found on the Parts

There are several similarities between routable objects in the Product Collaboration solution - change orders - and the PG&C routable object, declarations.

A core idea in Agile PLM is the inter-linked quality of data found in "products" - parts, manufacturer parts, part groups (all of which are non-routable) - and the routable "change objects" that modify those products - Changes in PC and Declarations in PG&C. You can view data and information about parts and assemblies in the change objects or in the parts themselves. Many attributes about the parts are duplicated in the linked objects.
Compositions in the Context of Declarations

So, in the PG&C solution, specific composition information is found in two places, on the part/part group and on declarations that list the part. For example, for Part/PG P033, composition data is found as follows:

<table>
<thead>
<tr>
<th>Part/Part Group P033</th>
<th>Declaration MD211</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliance tab</td>
<td>Items tab &gt; Items table &gt; click P033 item number link</td>
</tr>
<tr>
<td></td>
<td>Manufacturer Parts tab &gt; Manufacturer Parts table &gt; click link</td>
</tr>
<tr>
<td></td>
<td>Part Groups tab &gt; Part Groups table &gt; click link</td>
</tr>
<tr>
<td>Compliance tab &gt; Declarations and Compositions table &gt; click View Substances link, you see the associated substances-per-supplier Items tab &gt; Substances for Items table shows associated substances-per-supplier for P033</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Manufacturer Parts tab &gt; Substances for Manufacturer Parts table shows associated substances-per-supplier for linked mfr.parts</td>
</tr>
<tr>
<td></td>
<td>Part Groups tab &gt; Substances for Part Groups table shows associated substances-per-supplier for listed (linked) part groups</td>
</tr>
</tbody>
</table>

A compliance manager adds parts/part groups to a declaration. Parts in a BOM that are listed in a change order as affected items indicates that the change affects the item by modifying it in some way, thus altering the product record. Parts in a BOS that are listed in a declaration can be called affected parts, indicating that the declaration seeks to affect the part or part group by collecting its compliance data, thus altering the product record. Taking the specification(s) into account, the system merges the affected parts and specifications to create a unique "Affected Part/Part Group-Specification" line item for that one supplier - each line is a composition.

So, compositions are found under the various "affected parts" tabs contained in published declarations and under the Compliance tab of associated parts and part groups. Although each declaration goes to only one information supplier, declarations can contain multiple parts, manufacturer parts, and part groups simultaneously. In this way, a declaration can contain the data for multiple compositions.

**Note:** A field called Composition on the Compliance tab of parts and part groups displays links to declarations: this heading simply indicates "the declarations below provide information about compositions."

Types of compositions in a declaration:

- "Yes / No / Exempt" declaration at the part or part group level
- "Yes / No / Exempt" declaration at subpart, material, substance group, and substances level of part or part group
- "PPM / Mass" declaration at the material and substances level of a part or part group
- Combination of the previous types.
Substances are basic building blocks in PG&C. A substance is any chemical element or compound that is tracked within Agile PLM. Because of complexities in how parts (that may contain substances) are used in products, the Substances base class has four predefined classes, each with a child subclass, to cover a variety of circumstances: Substances, Substance Groups, Materials, and Subparts.

- **Substances class** - a substance is a single chemical element; for example, lead, chromium, or cadmium. Generally, these are the potentially hazardous substances that legislations are interested in, as described in specifications. The Alias attribute was developed to handle inconsistencies in how substances are named and recognized by the PLM system.

- **Substance Groups class** - a group of multiple substances. A substance group must have a Base Substance, which is the substance that the legislation is interested in. A substance group called "Lead and Lead Compounds" would cite Lead as its base substance, and it could comprise chemicals like Lead-oxide, Lead-nitrate, and Lead-sulfate. See "Substance Groups > Substances Tab > Conversion Factor" on page 5-2.

- **Materials class** - a material is a compound chemical, that is, a substance consisting of multiple substances. A good example of a material is a glue or a resin that can be bought in bulk. See "Materials and Subparts > Composition Tab" on page 5-3.

- **Subparts class** - a subpart is a subunit of a component. Subparts are not numbered and do not expand the BOM. See "More About Subparts" on page 5-3.

### Tabs and Attributes in Substances

Many attributes in PG&C appear in several or all of the PG&C business objects, as well as items and manufacturer parts.

#### General Info Tab

The General Info tab provides general information about the substance, material, subpart, or substance group.

- **Lifecycle Phase** - When you create a substance, the default lifecycle phase is Active. To make the substance obsolete, change its lifecycle phase to Obsolete.

- **CAS Number** - Chemical Abstracts Service registry number, which identifies a chemical substance or molecular structure. (Agile does not enforce a unique CAS number, they are a reference tool.) This is especially helpful when there are multiple generic or proprietary names for a substance.
Substances > Alias attribute

- **Alias** - This attribute is provided to inform the PG&C system of "substitute names" of substances. Your company has decided how to name your "global substances" (substances of concern to your company and, by extension, substance groups), but there are bound to be discrepancies when substances-in-parts are reported by your information suppliers or part information is imported or downloaded from other sources of data.

For example, an alias for Lead could be the chemical notation "Pb". The system can then resolve any confusion if a supplier submits information for a substance that they call Pb.

You can add and remove one or more alias from this attribute for any substance or substance group.

The maximum number of characters for the Alias field is 4000.

For more information, see "Substance Aliasing" on page 5-5.

Where Used Tab

The Where Used tab lists all Latest Released revs of the top-level assemblies (TLA, the products) that contain, somewhere within their BOM, a composition using the particular substance, substance group, material, or subpart. Where Used tab information is filled in automatically.

Substance Groups > Substances Tab > Conversion Factor

Since a substance group is an object that collects similarly-based substances, it is natural to have a Substances tab that lists them, just like a user group has a Users tab that lists its member users.

- **Conversion Factor** - Default conversion factor is 1. The value can be any non-negative number.

**Note**: Conversion Factor in substance groups is a different idea than Conversion Factor in part groups. See "Part Groups > Parts Tab" on page 8-11.

Substance Groups and Conversion Factor

A substance group relates to a base substance. The base substance must be defined as a substance in Agile. The base substance is stored in the Base Substance field (a list field) that contains a list of all substances in your system.

Substance groups also contain a list of substances that relate to the base substance through a Conversion Factor. Substance groups can only contain substances, not other substance groups. Note that the base substance of a substance group cannot be changed once the substance group is used, or the Substances table of the substance group has substances.
The substances that belong to a substance group have a conversion factor that calculates (by weight) the amount of the base substance that is within one of the members of the substance group. For example, 1 gram of lead-oxide contains 0.78 grams of lead. The resulting conversion factor is "0.78".

Here is another example: let there be a substance group called "Lead-based Compounds," with a base substance Lead, and with lead-based compounds such as Lead Oxide, Lead Phosphate, and Lead Sulfate (among others). You enter conversion factors for these compounds of 0.866, 0.766, and 0.683, respectively. Now consider that you have a part that contains 1 gram of Lead Oxide, 2 grams of Lead Phosphate, and 3 grams of Lead Sulfate. The system takes these amounts against the conversion factors, and so calculates this equation: (1 x 0.866) + (2 x 0.766) + (3 x 0.683) which yields a total of 4.447 grams of lead embedded in "Lead-based Compounds" in the part.

Therefore, substance groups calculate the total amount of their base substance, then behave as if they are their base substance.

---

**Note:** When you import a substance under a substance group to a declaration without a specification, or import a composition directly into a mfr. part (Substances table), if you do not specify the conversion factor for the substance, the conversion factor is copied from the global substance group, assuming the same substance exists there (previously it would leave the conversion factor unpopulated). The system does leave Conversion Factor blank if it is not entered and the substance does not exist in the global substance group.

---

**Materials and Subparts > Composition Tab**

The Composition tab exists in the Materials and Subparts classes, not in the Substances and Substance Groups classes. However, this tab is disabled (not visible) out-of-the-box, so you may not see it.

The Composition tab on a material or subpart object is used to manage the substances that belong to that material or subpart. In the context of materials and subparts, a "composition" is a simple term. The Composition tab of materials and subparts is used for "recipe management," which is keeping track of the intended composition. This data has no impact on the compliance validation process.

---

**Note:** Simple compositions that are listed in the Composition tab of materials and subparts are not the same thing as the aggregate compositions that combine compliance information of part-spec-supplier.

---

**More About Subparts**

A subpart is a subunit of a component manufacturer part. Subparts are not numbered and do not expand the BOM. For example, when your company uses a power supply made by a supplier, a BOM may just list "power supply," which is sufficient for manufacturing purposes. For compliance purposes, however, you need information about substances in all the parts of the power supply - the switch, plate, coil, cord, plug, and so forth: for these you or your supplier would create subparts for the supplier to furnish information. There is no limit to the number of subparts in any assembly.
Creating Substances

When you create most substances, the only required attribute you must specify is Name. The name must be unique. The name is case-insensitive, which means "ARSENIC" is treated the same as "Arsenic". Both the Name and Base Substance attributes are required when you create a substance group.

To create a substance:

1. Click the Create New dropdown button to activate the menu.
2. Point to the Substances link, which sends the flyout menu of Substances classes. It is possible your administrator has renamed these or created additional Substances classes. Select and click a link from the list of Substances, Substance Groups, Materials, or Subparts.
3. When you create a substance, the only required attribute you must specify in the Create New dialog is Name. The name must be unique. The name is case-insensitive, which means "ARSENIC" is treated the same as "Arsenic". Enter the desired information in the Name: field.
   - Remember that substance groups also requires you to specify a Base Substance. Use the Launch the Palette button to type or select an existing base substance.
   - If your PG&C solution has been configured for the JGPSSI class of Declarations, your administrator has set up a PageTwo field called Classification Number (Classification No) in substances and substance groups, and also a field called Level in substance groups: they are required when you create JGPSSI-specific substances.
4. Click Save. The new substance object appears with the General Info tab selected.
5. After you create the substance object, you can modify it at any time. Open the object, click Edit: add information and populate enabled fields under the various tabs.
   - Enter values for the Alias attribute that are alternate names for the substance that may be used by suppliers.
   - If you want to add attachments to this substance, choose from the Add menu (Files, URLs, or By Search), and navigate to the desired file or URL; or use Create button to create a new base substance; or "Type-ahead" to add existing substances.
   - When you have finished adding attachments, click Add.
6. To save your modifications, click Save.

Working with Substances

This section introduces features that have to do with substances, however, these features are part of removing potential blocks to declarations and compliance rollups, which are covered later in this manual. The PG&C solution is robust and multi-tiered,
and this discussion proceeds as if you were already very familiar with the other PG&C objects. You may want to glance through the remainder of this chapter, and then return to it after becoming more familiar with other PG&C business objects.

Topics covered include Substance Aliasing, Mass Disclosure, Mass Tolerance, Intentional and Non-intentional Substances (and related properties), and Unreported Substances feature.

Tasks that describe how to add or edit substances on declarations are provided in "Working with the Part Substances Tables" on page 9-14 and "Substance Editing" on page 9-15.

Substance Aliasing

The Alias attribute (introduced in Substances > Alias attribute) provides the solution: whenever a supplier provides information about substances for a part, there is no guarantee that a substance with the exact same name exists in the buyer’s system.

When you correct or map an invalid substance to a substance in the system, it adds the invalid substance as an alias to the substance. Whenever the same invalid substance is imported, it automatically maps to the objects. The system captures those invalid substances mapped to specific existing substances.

---

**Note:** You can remove an "alias" value any time from any substance; you cannot prevent an alias being added if you are correcting a declaration. So, if you have performed a substance correction in a declaration that, for any reason, you consider a "one-time" correction, once you advance the declaration, you can open that substance object and remove the newly added alias value; the declaration you corrected would not need to be corrected again.

---

To create a new substance:

- Create a new substance and map the invalid substance to the new substance;
- OR
- Create a substance with the same name as the invalid substance; in this case, the "invalid substance" does not exist anymore, as it has become a "global substance".

Mass Disclosure

The Mass Disclosure attribute is found on the Composition tab of Parts and Part groups, and on the Part/PG tabs of declarations. It has three values: Fully Disclosed, Partially Disclosed, and Undisclosed. The correct value is generated by the system during composition rollups. The definitions below apply to composition rollup run against internal specifications. Exceptions for compositions run against external specifications are noted below.

Full Disclosure, Partial Disclosure, and No Disclosure

These are the three types of disclosure, and how they are qualified by substance compositions and homogeneous material compositions.

- Fully Disclosed composition (Full Disclosure):
  - A Substance composition is considered to be Fully Disclosed if the difference between the part's mass and the sum of the masses of all the substances is less
than or equal to the Mass Tolerance Percentage setting. This applies to internal and external specifications.

- A Homogeneous Material composition is Fully Disclosed if this two-step process is satisfied: (1) The difference between a material’s mass (that is, the immediate parent of the substances) and the sum of mass of the substances under that material is less than or equal to the Mass Tolerance Percentage setting; and, (2) The difference between the part’s mass and the sum of mass of the parents of the substances should be within the Mass Tolerance Percentage. This applies to internal specifications only. For external specifications, calculating Fully Disclosed for a homogeneous material compositions is the same as Substance composition.

- Partially Disclosed composition (Partial Disclosure):
  - A Substance composition is Partially Disclosed if the difference is more than the Mass Tolerance Percentage, in which case an "Unreported" substance is added by the system to fill in the missing mass. This applies to internal and external specifications. No 'Unreported' substance is added by the system if you try to create a composition against external specification through declaration release and import.
  - A Homogeneous Material composition is Partially Disclosed if one of the following is true:
    1. The difference between a material’s mass (that is, the immediate parent of the substances) and the sum of mass of all the substances under that material is greater than the Mass Tolerance Percentage setting; and, (2) the difference between the part’s mass and the sum of mass of the parents of the substances is greater than the Mass Tolerance Percentage setting; or
    2. The part’s weight is missing, but none of the information is missing in the BOS tree. That is, the Mass and PPM should not be "null" anywhere in the entire BOS tree, including subparts, materials, or substances. This applies to internal specifications only. Calculating Partially Disclosed for compositions against external specifications will apply the same logic as substance composition (if the difference is more than the Mass Tolerance Percentage).

- Undisclosed composition (Non-disclosure):
  - If the Mass is missing for the part, substance, or the immediate parent of the substances, it is considered an Undisclosed composition. This applies to internal specifications only.
  - Furthermore, a Homogeneous Material composition is Undisclosed if any of these cases are true:
    - One of the substances lacks a Declared Mass and lacks a Declared PPM; or
    - One of the materials lacks a Declared Mass; or,
    - One of the materials does not have any substance; or,
    - One of the subparts does not have any child. This applies to internal specifications only. Compositions run against external specifications have no "Undisclosed" value.

Mass Tolerance

A part/part group or assembly has mass (weight) and all its substances/materials have individual masses: if the sum of their masses does not match exactly, the system checks whether the sum of the material masses falls within the tolerance (%) of the
part’s mass. This tolerance - between 0-5% - has been set by the administrator as a systemwide setting, so it applies across all objects analyzed by PG&C (the end-user does not see this value in the user interface).

To describe the effect with an example: let Mass Tolerance Percentage be 1% and part P1’s mass is 90 g. The composition will be identified as Fully Disclosed as long as the sum of its materials (the Bill Of Substances mass) is at least 89.1 (because 1% of 90 is 0.9). With the tolerance factored in, the mere fact of "missing substances" are not enough to throw off compliance, and the rollup can effectively interpret the composition as Compliant.

Mass Tolerance Percentage facilitates error correction, so it is likely that the value will be even smaller than the 1% in this example, perhaps closer to 0.1%.

Now, if the sum of BoS mass is any smaller than 89.1, let’s say (89.099) our system will add Unreported substance for 0.901 grams that is "missing"

The system stores both mass and normalized mass; when it compares masses, only the normalized masses are compared.

**Note:** If the default unit of weight is "grams" (setup in Java Client) and if the user provides an item’s weight as 1Kg, it converts (normalizes) that value into 1000gms and stores it in the "normalized mass" attr. When we do weight rollups, we get the normalized value and roll it up.

Higher tolerance can have negative impact on partially disclosed compositions.

**Mass Tolerances for External Specifications**

External specifications calculate weight for each substance in the BOS and take the sum of calculated mass of each substance to compare the composition weight. Remember that internal specifications take the sum of its materials (the bill of substance mass).

**Example for calculating mass of each substance against external specification:**

Assume the composition mass is 1g:

<table>
<thead>
<tr>
<th>Substance</th>
<th>Mass</th>
<th>Declared PPM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead</td>
<td>0.25g</td>
<td>500</td>
</tr>
<tr>
<td>Al</td>
<td>0.75g</td>
<td>1000</td>
</tr>
</tbody>
</table>

Internal Specification case:

Mass of Lead + Mass of Al = 0.25 + 0.75 = 1g equal to composition mass, then it is Fully Disclosed.

External Specification case:

Calculated mass of Lead=1*500/1000000 = 0.0005g
Calculated mass of Al=1*1000/1000000 = 0.001g
Sum of calculated mass = 0.0005 + 0.001 = 0.0015g less composition mass, then it is Partially Disclosed.

**Intentional and Non-intentional Substances and Related Attributes**

Homogeneous materials can contain two types of substances, **intentional substances** and **non-intentional substances** (contaminations).

Intentional substances are intentionally part of a material. For example, stainless steel contains 9% Nickel. Nickel is an intentional substance in stainless steel that makes it corrosion-free. However, during production of steel, certain contaminations can be introduced as the result of impurities in the base steel or because of the manufacturing process. These contaminations are non-intentional - but they are still part of the final product.

Certain legislations do not allow for "intentional adding" of certain substances - such as lead - but allow a certain percentage of lead in the product through contaminations, that is, "unintentional adding" of substances. Other legislations add the total amount of a substance - both intentional and non-intentional - and prescribe a maximum threshold value.

**Intentionally Added**

The “Intentionally Added” property acts as the constraint defined in the Joint Industry Guide and the IPC 1752 forms. The Intentionally Added attribute is a "Yes/No" attribute in all the Parts/Part Groups > Compliance tab > Substances tables and Declarations > Parts/Part Groups tabs > Substances tables.

If, for a substance in the specification, Disallow Intentionally Adding is Yes, when a supplier or other user enters Yes in Intentionally Added, the substance’s Calculated Compliance value is Non-compliant. If that substance was not intentionally added (= No), the system can go ahead and check the Threshold PPM of the substance-for-the-spec. This applies only for internal specifications; external specifications do not include the property in rollups.

The compliance manager can modify Intentionally Added in the Pending status of the Default Declarations Workflow. The supplier can modify it in the Open to Supplier status of the same workflow. It cannot be modified in any other status (without administrator impact). If there is no value in Intentionally Added field, the system assumes No when performing rollup calculations.

For internal specifications, this is a special use case for Intentionally Added: If the Result PPM for the substance is 0, and both Intentionally Added flags in specification and composition are Yes, the Calculated Compliance for this substance will be Non-compliant: because the user indicated that the substance in the composition was added intentionally, it’s composition should be Non-compliant even though the PPM is 0.

---

**Note:** The Intentionally Added flag on Substances table applies to the Substances and Weights Rollup and External Rollup features.

---

**Disallow Intentionally Adding**

Found on Specifications > Substances table, the default value of Disallow Intentionally Adding is No, so that it allows the Intentionally Added property to be in effect. If this were set to Yes, Intentionally Added does not take effect. No "blank" value is allowed for this property.
Specification Intentionally Added

In parts/part groups and declarations, the Substance tables also have an attribute called Spec Intentionally Added. This property points to, on the substance's Specifications > Substances tab, the value of attribute Disallow Intentionally Adding. This read-through attribute is readable and searchable but cannot be modified. For existing customers who do not have an Intentionally Added flag in the Specifications > Substances tab, the system assumes that it is set to No.

Unreported Substances in Partially Disclosed Compositions

There is a system-generated entity or object that “fills in” the unaccounted difference between the total mass of the part or assembly and the sum of all its constituent substances. The name in the application is “Unreported (System)” and it can simply be referred to as “unreported substance.” The unreported substance is searchable in the application; the user can edit any field in the PageOne or PageTwo of an unreported substance, excluding the name. You cannot, however delete the unreported substance. Its presence in a composition is inferred when compliance rollups mark a composition as Compliant but the weights of the part and its substances do not match.

**Note:** An unreported substance cannot be added manually by a user; that is, the purpose of the unreported substance is circumvented if an object called "Unreported Substance" or the like is created and used as a "filler" - the system should be allowed to work its calculations and create the entity as needed. Note that it is possible for an unreported substance to be added by a compliance rollup.

**Caution:** The Mass Tolerance Pct. setting and the Unreported (System) substance is used expressly to account for small discrepancies between part mass and substance mass. It is *not* to be used to “hide” a portion of substances in a declaration that could be thought of as a proprietary formula (or “recipe”) in a manufacturer’s product.

Conditions When the System Adds the Unreported Substance

The following lists conditions that must be satisfied for the system to add an unreported substance to a composition.

**In Declarations (Internal Specifications Only)**

The "Unreported (System)" substance is added when the declaration is moved to the next status, except when moving from Pending to any non-Released status; also, when the user chooses Actions > Calculate Compliance.

**For Substance Composition (Internal Specifications Only)**

If the mass of each substance/substance group in the part and the mass of the part are available, the system adds up the masses of the substances and compares the total sum with the mass of the part.

- If the Part's mass is greater than the sum of substances masses, the system adds the Unreported (System) substance to the part and sets the weight difference in that substance's Calculated Mass attribute.
If Mass Tolerance Percentage is set (in Administrator) and the mismatch of "total masses" falls within the tolerance range, the system does not add the unreported substance.

If the Part's mass is less than the sum of the masses of the substances, the system does not add the unreported substance and does not set the negative weight.

If the mass of the Part is missing, or the mass (or Declared PPM) of any one of the substances is missing, the system does not add the unreported substance.

Homogeneous Material Composition (Internal Specifications Only)
If the mass of each homogeneous material is available, the mass (declared or calculated) of each substance in that material is available, and the mass of the part is available, the system compares the material-mass with the sum of the substances mass and it compares the part-mass with the sum of the materials mass.

The unreported substance is added to a homogeneous material declaration only if it is Partially Disclosed.

If the composition is Partially Disclosed and the material-mass is greater than the sum of substances-mass, the unreported substance is added under the material.

If one of the substances in the material does not have a mass and declared PPM, or if the material does not have a mass, the system does not add the unreported substance.

If there are two materials, one Undisclosed and the other Partially Disclosed, the system does not add the unreported substance to the Partially Disclosed material, since the entire composition becomes Undisclosed.

Unreported Substance When Importing Substances to Items and Manufacturer Parts (Internal Specifications Only)
The unreported substance is added after the import process is complete.

If the composition's mass is blank, the system uses the value in Mass attribute (found on General Info of items and Title Block of Mfr. Parts) in doing a composition rollup, and it copies the mass to the Composition table of the part.

After the rollup is done, if the value of Mass in PageOne of the part is changed, the system does not recalculate the composition.
The Bill Of Substances (BOS) is a way to manage compliance information-gathering with regard to the parts and materials used in the manufacturing process.

To understand the BOS and how it is “derived” from the BOM in Agile PLM, let us first look at what constitutes a Bill Of Material.

**BOM Lists Parts that become Products**

The Bill Of Material (BOM) is the list of all parts and subassemblies that are assembled into the manufactured product. The BOM is central in Agile PLM’s Product Collaboration solution, and is fully documented in *Product Collaboration User Guide*.

This is a simple list of BOM levels from the top-level assembly down.

Levels of the BOM:
- First or top level: Top-Level Assembly (TLA), the ultimate product being manufactured
- Second level: Assemblies and sub-assemblies
- Third level: Items (parts and documents; these are manufactured at your company)
- Fourth level: Manufacturer Parts (these are parts from companies on the Approved Manufacturer List, or AML)

Although we are introducing the Bill of Substances by reviewing the Bill of Materials, it is important to understand that the BOM and the BOS list different kinds of entities. Therefore, the "levels" in the BOM and the "levels" in the BOS do *not* correspond with each other: both lists are, however, organized as a hierarchy.

There is a relationship between the BOM and the BOS: anything on the first four levels of a BOM - any kind of part or assembly - can be the origin of a Bill Of Substances.

**BOS Lists Substances contained in Parts that require Compliance**

The Bill Of Substances is a hierarchical list of substances that are contained in the parts and assemblies that make up a BOM. This is a list of BOS hierarchical levels from any composition of a part or part group or subassembly or TLA:

Levels of the BOS
- First or top level: the Composition of a part or assembly
- Second level: Subpart
Rationale for the BOS

Depending on the type of specification with which you need to be compliant, you will need more or less information from your suppliers. For example, the RoHS legislation wants parts to be compliant at the homogeneous material level. This means that you might require your component manufacturer to specify how much lead it contains per homogeneous material within the component.

Unfortunately the sub-units (subparts) of a component (say, the packaging around a chip) are not always homogeneous, but they may consist of a coated material. For the RoHS legislation, this means that such a subpart consists of two homogeneous materials, each of which must be compliant.

This creates a tree structure called the Bill of Substances. Suppliers need to provide information at each of the levels of the BOS.

Depending on the type of specification involved, levels in the above list may be omitted.

Figure 6–1 Schematics of Bill of Substances
Summary of BOS Structures

The rules relating to the type of substances that can be added to the Composition tab are:

1. A subpart can contain a material and a subpart at the same level. A subpart cannot contain all four types of substances at the same time.

2. A material can contain only substances and substance groups. A material cannot contain a subpart or a material.

Here are the valid structures of the Substances classes:

For Subparts:
Subpart > Substances AND/OR
Subpart > Substance Groups AND/OR
Subpart > Substance Groups > Substances
OR
Subpart > Homogeneous Materials AND/OR
Subpart > Subpart AND/OR
Subpart > Subpart > Homogeneous Material

For Homogeneous Materials:
Homogeneous Material > Substances AND/OR
Homogeneous Material > Substance Groups AND/OR
Homogeneous Material > Substance Groups > Substances.
Specifications track the different legislations, customer specifications, or internal specifications with which an assembly or part must comply. The Specifications object is used to create representations of specification documents, regulations, published compliance criteria. You will very likely hold the actual (electronic) document as an attachment to a specification object.

An example of a regulation issued by a government body is the European RoHS directive. Environmental specifications are substance-based, and contain a list of banned substances or substances of concern and their threshold values.

In Agile, specifications are used to validate declarations and assess the compliance of parts by evaluating whether a given restricted substance in the composition of a part surpasses its specified threshold value.

**Contents of Specifications**

Objects created from the Specifications class may consist of:

- Specification-level attributes, for example, Threshold value (PPM) for each of the substances of concern, and Disallow Intentionally Adding flag (on specification Substances table)
- Exemptions
- Attachments carrying or clarifying the specification
- A list of substances of concern (or, simply, Substances list)
- Indication whether a supplier is required to report on a substance or not.

A specification either represents a customer-created specification or legislation adopted by a government.

**Internal vs. External Specifications**

As part of the REACH initiative, Agile PLM now provides an external rollup engine, as well as the internal rollup engine, as described in "Defining Approach to Compliance Management" on page 11-1. Specifications are now marked Internal or External upon creation, and this distinction determines which engine is used for rollup.

Specifications must be marked External for REACH rollup.

A user can run Calculate Compliance on both specification types by clicking the Calculate Compliance button or routing the declaration to "Submit to Manager".
The Internal/External attribute is shown as a read-through attribute on the Specification table on objects that can link to specifications - Declarations, Items, Manufacturer Parts, and Part Groups.

---

**Note:** All specifications upgrading to 9.3.4 are automatically set to Internal. So if you want to include a legacy specification, you must create a new external specification and then use the Add/Replace Spec feature to point all of the declarations and parts to the new external specification. See "Adding Specifications" on page 7-6 and "Replacing Specifications" on page 7-7.

---

Refer to Appendix B, "System Logic of Internal Compliance Rollups," and Appendix C, "Reference Documentation for External Compliance Rollups" for more information on logic used to perform internal and external rollups.

**Tabs and Attributes in Specifications**

Many attributes in PG&C appear in several or all of the PG&C business objects, as well as items and manufacturer parts.

**General Info Tab**

The General Info tab provides general information about this object. Name, Description, Jurisdiction, Lifecycle Phase, Specification Type, and Rollup Engine are data specified when you create the specification. You can edit some of this information by clicking the Edit button in the General Info tab.

- **Validation Type** - drop-down field, choose Part Level or Homogeneous Material Level. This field is required, but the field is populated with the default Part Level in the <create> wizard.

  **Note:** Once you create a specification, its validation type cannot be changed.

- Part Level - enforces simple BOS, e.g., weight of part to validate PPM; compliance with this type of specification has to be validated at the part level; or,

- Homogeneous Material Level - enforces BOS that is more complex; compliance with this type of specification has to be validated at the homogeneous material level

When a specification is added to a part or declaration, this field is useful in tracking whether the part (or all the parts contained in the declaration) should be compliant at the part level or at the homogeneous material level.

Also, when importing compositions or substances into items or manufacturer parts, the part’s Composition Type and the specification’s Validation Type must match.

For more information about this attribute, see "Validation Type in Conjunction with Composition Type" on page 4-4, and "Importing and Exporting Data in PG&C" on page 10-1.

- **Exemptions** - a multi-list field derived from the Exemptions list (set up by the administrator). When you create a specification, you populate the Exemptions
attribute by selecting relevant exemptions that should be present in the drop-down list.

When a specification is associated with a declaration, exemptions named in the spec "read through" to the declaration's Exemptions fields. Exemptions in declarations are discussed in Affected Parts Tabs.

For more information about exemptions and the Exempt compliance state, refer to "Compliance States" on page 11-6.

---

**Note:** The system currently allows you to remove exemptions from a specification if the exemption has been assigned to a declaration, part, manufacturer part, or part group.

---

- **Rollup Engine** - a list field with choices of Internal or External. This field is required, but the field is populated with the choice selected in the Create wizard. Note that you cannot change the Rollup Engine, once the specification is created.

---

### Substances Tab

You can edit, remove, or add substances and substance groups to the Substances tab of a specification; you cannot do the same with materials or subparts. When you are using the specification, the Substances table cannot be changed.

You cannot add both a substance group and its base substance to the specification's Substances tab.

---

**Note:** When the specification is being used (in a part or part group or in a declaration), the Substances tab in the specification cannot be edited (including add / remove). If the spec is removed from part Specifications table or from declaration Specifications table, the Substances tab on the specification reverts to being editable.

---

- **Reporting**

  **Mandatory:** If the specification is set to Mandatory on a declaration, it implies that the supplier must report compliance information for that substance.

  **Optional:** If it is set to Optional, the supplier does not need to provide data for that substance, and the system will not check that substance for compliance.

  The rollup logic considers only “mandatory” substances, and the compliance states of only “mandatory” substances are rolled up to the part.

  Even though a supplier is expected to provide information for substances marked Mandatory, currently the system does not “enforce” this setting (via, for example, a flag or notification).

---

**Note:** The Reporting flag on Specifications > Substances table applies to the Compliance Rollup feature, and does not apply to the Substances and Weights Rollup feature (that uses the Microsoft Excel-based Client).

---

- **Threshold Mass PPM** - When adding a substance group, the Threshold PPM value is given at the substance group level. The “threshold mass PPM” describes the
maximum quantity in parts-per-million of a substance allowed in order to be within compliance.

The Substances table of a specification identifies which substances are restricted and their threshold mass PPM.

---

**Note:** During compliance rollups, the system marks a substance as Compliant if the Declared or Calculated PPM is less than or equal to the Threshold Mass PPM.

---

- Disallow Intentional Adding is discussed in "Intentional and Non-intentional Substances and Related Attributes" on page 5-8.

### Creating Specifications

There are two required attributes that you must specify when you create a specification. The first is Name. The name must be unique. The name is case-insensitive, which means "ROHS" is treated the same as "Rohs".

The second required attribute is Rollup Engine. Your selection determines whether the specification is included in internal rollup (Internal) or excluded (External).

An optional attribute is General Info > Lifecycle Phase. When you create a specification, the default lifecycle phase is Active. To make the specification obsolete, change the value of its lifecycle phase attribute to Inactive.

To create a specification:

1. Click the Create New drop-down button to activate the menu.
2. Click the Specifications link.
3. In the Create New Specifications dialog, click the drop-down arrow next to the Type: field.
   
   The administrator may have created additional subclasses of specification. Select and click the Specification list item.
4. Enter the desired information in the Name: field.
5. Click the drop-down arrow next to the Rollup Engine: field.
   
   Select either the Internal or External list item.
6. Click Save. The new specification object appears with the General Info tab selected.
7. After the specification is created, it can be modified at any time. This task continues with steps to add appropriate objects.

   Open the specification, click Edit: to add information and populate enabled fields under the various tabs.
   
   - In the Description field, enter a description of the specification.
   - In the Jurisdictions field, use the Launch the Palette button to select appropriate locations where this specification is valid.
   - In the Exemptions field, use the Launch the Palette button to select appropriate exemptions.
Note: As mentioned above, when a specification is associated with a declaration, exemptions named in the spec “read through” to the declaration’s Exemptions fields. It is a best practice to be familiar with the use of exemptions in specifications and how they work in declarations. Exemptions in declarations are discussed in “Affected Parts Tabs” on page 9-7.

- In the Validation Type field, use the drop-down list to select Part Level or Homogeneous Material Level.
- In the Lifecycle Phase field, use the drop-down list to select Active.

8. Click Save.

9. To add substances to the specification, click the Substances tab, then click the Add button.
   - Click the Search to add icon to add existing substances in the Substances Search dialog.
   - Or click the Create to add icon to create a new substance object that will be added to the specification.
   - Or use “Type-ahead” to add existing substances automatically.
   - Or, if what you want is visible in the Navigation pane, by Copy & Paste or by Drag & Drop capability.

   Click to select substances that you want to add, and hit Enter; or you can double-click a substance to add it. You may run additional searches after this, too.

10. If you want to add attachments, click the Attachments tab. Now choose from the Add menu Files, URLs, or By Search, and navigate to the desired file or URL to add attachments.

Note: Best practices dictate that a copy of the legislation that covers the substances (in a format such as an Adobe PDF) must be added to the Attachments tab.

 Specification Management

PG&C also supports specification management.

Evolving regulations require that some specifications need to be changed. You can now replace an old specification with a new specification on declarations, items, manufacture parts and part groups using Add and Replace on the Actions menu of a specification. Wizards guide you through the add and replace processes.

You can run add/replace of specifications on:

- The Where Used tab of an existing specification (first page of wizard).
- A selected list of objects (second page of wizard); available for the add process only.

Declarations and items receiving the new specification are tagged for rollup.
The Where Used option is used for Manufacturer Parts and Part Groups. So for select items (Latest Released Rev & Pending Rev) on add or replace of specifications 'Manufacturer Parts' and 'Part Groups' is automatically applied.

Administrators use the Specification Management Task found in Admin > Server Settings > Task Configuration to enable the add and replace functions.

For the Specification Management Task to work, the default admin account must be modified by the Agile administrator. For details, see "Modify Default Admin User Roles for Specification Management Task" on page A-3.

Discovery, Read, Modify, and Specification Management (Add and Replace menu options) privileges apply when performing add and replace actions on objects. If you think your privileges do not include these, see your Agile Administrator.

Adding Specifications

For the specification being replaced, use the where-used option to identify which objects containing the specification will be searched.

The adding specification feature allows you to 'bulk add' the specification to multiple objects. You have two choices:

■ Add a task to add the current specification to all objects found during a where-used search.

■ Add a task to add the current specification to a set of objects specified on the second page of the dialog.

To add a specification:

1. Click the Add command in the Actions menu.

2. In the Add Specification dialog, for the Specification field, select a specification to which you are adding the current specification. You can use auto-complete, type-ahead, or the Search button for this field.

3. In the Where-used Search Options field, check Declarations (Pending) and/or Items (Latest Released Rev & Pending Rev) to include those objects in the search.

4. Click Next. The second page of the dialog is displayed. You can use this page to select more objects in addition to objects in where used.

5. Click Add. A search dialog is displayed.

6. Use the drop down menu to select an object to include in the search. Drop down options are:

■ Latest Released Rev
■ Released Rev
■ Pending Rev
■ Declarations
■ Manufacturer Parts
■ Part Groups

7. Type a valid entry in the search field, and then click the Search button.

8. Select objects from the returned search results.
9. Click the Esc link to close the search dialog.

10. Click Add to Queue. The add task for the specification is now added to the server task queue, and the dialog closes.

The following message displays on the specification where the Add action was initiated: *A task has been submitted successfully. A log file will be attached to this specification after the task completes.*

After you complete the task, a copy of the log is added to the Attachments tab of the specification, which indicates the number of processed records.

### Replacing Specifications

For the specification you are replacing, use the where-used option to identify which objects containing the specification will be searched. Note that for replacing specifications, only the specification is removed; not the compositions against it.

To replace a specification:

1. Click the Replace command in the Actions menu.

2. In the Replace Specification dialog, for the Source field, select a specification to be replaced by the current specification. You can use auto-complete, type-ahead, or the Search button for this field. The Target field displays the current specification and cannot be changed.

3. In the Where-used Search Options field, check Declarations (Pending) and/or Items (Latest Released Rev & Pending Rev) to include those objects in the search.

4. Click Add to Queue. The replace task for the specification is now added to the server task queue, and the dialog closes.

The following message displays on the specification where the Replace action was initiated: *A task has been submitted successfully. A log file will be attached to this specification after the task completes.*

After you complete the task, a copy of the log is added to the Attachments tab of the specification, which indicates the number of the processed records.

**Caution:** If you remove a specification from an item, the substance data is removed, unless it is an "All Spec" composition.

### "All Spec" Use Case

There is a special situation regarding declarations with no associated specifications, called the "All Spec" (All Specification) use case. Basically, if you intend to collect raw data (mass or PPM) at a substance level, create a declaration with no specification attached. The supplier must provide information on all materials and substances. You then use the information to calculate compliance in relation to any specification. The same is true when directly importing compositions into items or manufacturer parts.

Note that the All Spec use case is less important with the introduction of Fully Disclosed compositions, but the All Spec case is still useful, as the following case describes.
Let us start with the “normal” use case: when there is a specification in the declaration, the information that the supplier provides is attached to that specification and cannot be used to assess compliance against other specifications using the data that the supplier provided.

For example, a supplier receives a declaration with Part 101 and the RoHS specification. The supplier responds to this declaration at the part level using the Declared Compliance field in the declaration’s `<parts/PG>` tables. Regardless what the supplier declares (compliant or non-compliant), that information is associated to the RoHS specification, and we cannot use this information to assess compliance against other specifications.

On the other hand, if the supplier provides either the Mass or PPM values at the substance level, the system calculates the compliance and determines whether Part 101 is compliant for RoHS or not.

The difference between these two cases is that, in the second case, even though the supplier provided the raw data (Mass, PPM) at the substance level, since the declaration had a specification (RoHS), all the information from the supplier is associated with the RoHS spec. If the user adds a different specification to Part A, let’s say the WEEE specification, the system is not able to re-use the Mass or PPM information to calculate compliance against WEEE because all that information is associated with RoHS specification, unless the composition is Fully Disclosed, in which case it can be reused to calculate the compliance from any specification with matching Validation Type.

Therefore, if the buyer intends to collect raw data (Mass or PPM) information at the substance level, they should attach no specification to the declaration. The supplier then provides information on all materials and substances in Part 101 with either Mass or PPM information. The buyer can use this information to calculate compliance against any specification. This is what is referred to as the All Spec case.

The set of “system rules” listed below refers to the All Spec composition, and is therefore presented here. These rules are repeated in context in “Part-Level Validation - Rollup from Compositions to Part/Part Group” on page 11-12.

Rules for Selecting Compositions for Rollup on Part/Part Group (Internal Specifications)

Below are the internal rules that the system follows to find a composition that can be used or re-used (where possible) in the rollup of a part/part group. This can also be thought of as “qualifying compositions” for use (rule 1) or re-use (rules 2, 3, 4).

---

**Note:** The name of each rule below is not used by the system logic, they are for user understanding. These are “internal rules” that operate within the system logic, but they are not “seen” in the user interface. The system makes its selection "per supplier."

---

When a rollup is done on an item, manufacturer part, or part group, for a given specification, the following sequence is followed for each supplier that provides an active composition:

1. Matching composition - The system first looks for matching spec composition; a composition that has the same spec as the given specification.

   If a matching composition is not found:
Rules for Selecting Compositions for Rollup on Part/Part Group (External Specifications)

Below are the internal rules that the system follows to find a composition that can be used or re-used (where possible) in the rollup of a part/part group for external specifications. This can also be thought of as “qualifying compositions” for use (rule 1) or re-use (rule 2).

Note: The name of each rule below is not used by the system logic, they are for user understanding. These are “internal rules” that operate within the system logic, but they are not “seen” in the user interface.

When a rollup is done on an item, manufacturer part, or part group, for a given specification, the following sequence is followed for each active composition:

1. Matching composition - The system first looks for matching spec composition, that is, a composition that has the same spec as the given specification.
   
   If a matching composition is not found:

2. Fully Disclosed composition (also called "FMD composition " for Full Material Disclosure) - The system next looks for a Fully Disclosed composition - if multiple FMD compositions are found, it uses the latest active composition per supplier, regardless of the spec on the composition.
   
   If a Fully Disclosed composition is not found:

3. “Super Spec” composition - The system looks for a composition that is on a specification containing every substance on the given specification (that is, the spec involved in the present rollup). The found specification can be called a “superset spec” (or “super-spec” for short) because it can contain more substances than the given spec; the requirement is that the found spec must contain all the substances on the given specification.
   
   If a superset specification composition is not found:

4. "All Spec" composition - The system looks for "All Spec" compositions (that is, without any specification attached) whose Composition Type matches the specification’s Validation Level for that part or part group.
   
   For more information, see "Validation Type in Conjunction with Composition Type" on page 4-4 and "General Info Tab" on page 7-2.
This chapter describes how parts (items and manufacturer parts) are used within PG&C.

**Parts: Items and Manufacturer Parts**

Items and Manufacturer Parts are two base classes in Agile PLM that are used to create objects that represent the things that your company and its suppliers assemble into the products your company sells. They are therefore the “business objects” for which compliance data must be sought.

The compliance data in parts is predominantly found under the Compliance tab, as well as some attributes under PageOne and PageTwo tabs.

Non-PG&C tabs and functionality of items and manufacturer parts are not included in this guide. How items and manufacturer parts work “outside” the PG&C solution is fully documented in *Agile PLM Product Collaboration User Guide*.

**Part Groups: Part Family**

A part group is a “container” that tracks the overall chemical composition for all parts of a particular type. If multiple parts share the same properties - for example, the same composition - you can define a part group with those characteristics. The parts (items and manufacturer parts) that are associated with part groups are listed on the Parts tab of every part group.

A part can only belong to one part group at a time. If a part is already associated with a part group, it cannot be associated with a different part group.

Note, however, that suppliers on a part group are not copied over to the associated parts; that is, parts do not inherit suppliers from part groups.

The Part Groups class has three subclasses:

- Part Family subclass is used by PG&C;
- Commodity subclass is used by Product Cost Management (PCM);
- Item Group subclass is used by Product Collaboration (PC).

Depending on settings, the Part Groups class can generate objects that work independently in PG&C and PCM, or concurrently in both solutions. This manual uses the generic term "part group" (and "PG") to refer to objects from the Part Family subclass.
More about Parts and Part Groups

As suggested above, parts (Items and manufacturer parts) that belong to a part group give up their independence in terms of declarations. From the time parts are associated with a part group until the moment they are disassociated from it, it is not possible to add those parts to a declaration separately. Nor is it possible to import compliance data into the parts separately.

Specifications are forwarded from the part group as well but it is still possible to add specifications directly to the item or manufacturer part, regardless of part group associations.

When a part group is added to an item (that is, part but not manufacturer part), the active compositions of the part group are copied to the latest released revision ("rev") of the part, as well as all Pending revs of the item. (Revisions in Agile PLM are thoroughly documented in Agile PLM Product Collaboration User Guide.)

When a new composition is added to a part group - through publishing a declaration - the system looks for other compositions for the same supplier, same specification, and same Composition Type (or, type of declaration). If there exists an older active composition, then the older composition becomes inactive, and the new composition becomes active.

Also, when a new composition is added to a part group through a published (completed and released) declaration, that composition data is published to all manufacturer parts and items (latest Released rev and all Pending revs). The composition replacement logic runs through all manufacturer parts and items (by revs).

A part group can contain a combination of multiple items and manufacturer parts at the same time. The normal use case is that a part grouping either contains items or manufacturer parts.

- For items, belonging to a part group is rev-independent.
- For items, belonging to a part group is site-independent. (PG&C currently does not support Agile sites.)

Tabs and Attributes in Parts and Part Groups

Many attributes in PG&C appear in multiple PG&C business objects, as well as items and manufacturer parts. Because any given attribute may be defined only once in this manual but may not be defined in this chapter, simply search the PDF for the attribute you want to see.

For information about associating substances with an item, manufacturer part, or part group on a declaration, see "Working with the Part Substances Tables" on page 9-14.

Title Block and General Info Tabs

The General Info tab is the "Page One" on part groups or manufacturer parts. Page One is called Title Block on items. Page One provides general information about this part or part group, including Name, Description, Lifecycle Phase, and Mass.

Changes you make to the weight information (Mass) on a part group's General Info tab will affect the mass of parts and manufacturer parts associated with the part group.
Tabs and Attributes in Parts and Part Groups

PageOne Attributes (Items>Title Block or Mfr. Parts/Part Groups>General Info)

The following fields appear on the Page One of items, manufacturer parts, and part groups:

- Overall Compliance - indicates the compliance state of the part using the worst-case scenario and matched across all specifications associated with the part. This attribute is found on these objects:
  - Items > Title Block tab > Overall Compliance
  - Manufacturer Parts and Part Groups > General Info tab > Overall Compliance

On items, Overall Compliance attribute is revision-controlled, that is, specific to the item’s rev. The Overall Compliance attribute also reads through to the objects below, although in these cases it is named “Summary Compliance”:

- Items base class (Parts and Documents) > BOM tab and Manufacturers tab > Summary Compliance
- Changes base class (ECOs, MCOs, etc.) > Affected Items tab > Summary Compliance

On items, Summary Compliance is always from the Latest Released rev of the item; if there is no released rev, it is from the Introductory revision of the item.

- Compliance Calculated Date - date and time stamp when the last rollup (scheduled or manual) was run

- Mass - the weight of a part (item or manufacturer part) or assembly, expressed in systemwide UOM (unit of measure). Mass in Item Title Block is a "rev-controlled" attribute:
  - You can update the mass of an Introductory item through Item Title Block, if there are Pending or Released revs;
  - You can update the mass of a Latest Released Rev through the Title Block, as long as you have the right privilege;
  - You cannot modify the mass through the Title Block of a Previously Released rev, you can only “update” it through importing compositions with mass, or by publishing a declaration for that item with the mass set through the declaration.

**Note:** Please note that you cannot modify the Mass field in ECO > Affected Items tab if you are working in Java Client; you can however, modify it if you address it through Web Client.

- Part Family and Commodity - On an item, the Part Family and Commodity attributes on the Title Block indicate which part group the part is associated with. Either of these attributes can be enabled, and both are editable. Both Commodity and Part Family attributes can be edited from an item’s Title Block.

On a manufacturer part, only the Part Family attribute is available. The Part Family attribute can be edited from a manufacturer part’s General Info page.

When you assign a part group to a part, the part is added to the part group’s Parts table, and the General Info mass, specifications, active compositions, and corresponding substances are copied over to the part. In order to assign a different part group, you must remove the current value on Part Family attribute, save the changes, and then associate it with a new part group.
Tabs and Attributes in Parts and Part Groups

Items> Title Block Attributes
The following fields appear on the Title Block of items only:

- Shippable Item - Yes or No: when an item is ready to go to market (presumably a top-level assembly), setting this field to Yes sets a "flag" that the system looks for in the scheduled rollups. (See "Rolling Up Compliance Data Using Internal Rollup" on page 11-1.)

- Exclude from Rollup - Items only, setting is Yes or No (Default for Parts class is No; Default for Documents class is Yes and the Exclude for Rollup field is set to invisible): setting to No means that the item will always be included in compliance rollups. When the value is Yes, it sets a flag that prevents the system from considering the compliance of the item (which it determines anyway) when determining the compliance of its parent. There can be items, for example, a document, whose compliance you are not concerned about, set to Yes.

Part Groups> Make Available As Attribute
Another General Info field on part groups, the Make Available As field, plays a part in these settings.

Make Available As Attribute and the "Force/Identical" SmartRule
An attribute on General Info of part groups called Make Available As is not visible out-of-the-box. The Make Available As field exists for this reason: it provides a way for companies with both the PCM and PG&C solutions to keep their PCM commodities separate from PG&C part groups. If your company does not own Agile PCM, the Make Available As setting is not needed and is not enabled.

This setting can be set by the user who creates a PG&C object, but it cannot override the administrator's SmartRule called "Force Commodity and Part Family to be Identical." The Make Available As attribute may be visible if the "Force/Identical" SmartRule is set to No, as there may be reasons to create your object as a "Part Family-only" object.

These are some business rules around the settings of "Force/Identical" SmartRule and Make Available As attribute:

If the SmartRule is set to Yes, a part can belong to only one part group. If the SmartRule is set to No, an item can belong to one "Commodity Only" part group (in PCM) and one "Part Family Only" part group (in PG&C).

If the SmartRule is set to No and Make Available As is set to "Part Family Only" or "Commodity and Part Family," you can add manufacturer parts to a part group, while if Make Available As is set to "Commodity Only," you cannot add manufacturer parts to a part group. If the SmartRule is set to Yes, regardless of Make Available As value, you can add manufacturer parts to a part group.

Also note that when this SmartRule is set to No, when assigning different values for the Part Family and Commodity attributes, the mass, specification, active compositions, and corresponding substances will be copied from the part group object. When this SmartRule is set to Yes and both attributes are enabled, setting the value on one, automatically assign it to the other attribute.

PageTwo Tab
A feature called "specification mapping" lets you view the Result Compliance value that has been mapped (by the administrator) from Item/Mfr.Part Specifications table to a selected attribute Two detailed below.
Specification Mapping: Result Compliance from Parts’ Specification Table Mapped to PageTwo Attribute

The administrator now has the capability of mapping a specification to a selected LIST attribute Two which points to the “Calculated Compliance” selection list. The mapping is done per specification and per class: Parts, Documents, or Manufacturer Parts.

This mapping simply allows you to see the Result Compliance for a specification on the PageTwo of the part, rather than forcing you to go to the Compliance tab > Specifications table.

Another advantage is that, as a PgTwo attribute, the specification-specific Result Compliance is available (for viewing, exporting) on:

- Items > BOM tab,
- Items > Manufacturers tab, and
- Changes > Affected Items tab.

Let us say that the compliance manager creates a Specification called "China RoHS." Then, for Parts class, the administrator maps the China RoHS spec to an attribute also called "China RoHS" (it could be an existing attribute or one that the administrator creates). The mapping means that for any object created from any subclass of the Parts class, the value of the China RoHS attributeTwo is copied from the Result Compliance attribute (on Specifications table) upon rollup.

The Result Compliance (RC) value of the specification is copied to the mapped PageTwo field if any one of the following events occurs:

- a rollup is done on the Latest Released rev (LRR) of a part or document;
- a rollup is done on a manufacturer part;
- a rollup is done on a BOM: if a child is the LRR, its RC value is copied to the child's PageTwo field; or,
- a rollup is done on an item that is associated with a manufacturer part: the RC value of the mfr. part is copied to the mfr. part's PageTwo field.

The copying of Result Compliance to a Part’s Pg2 happens only for the LRR of the part, since Pg2 is always applicable to LRR. So, if the rollup changes the RC of a previously Released rev (or a Pending rev), that value is not copied to the mapped Pg2 field. Similarly, if that Pg2 field is enabled in the item BOM tab, it only displays the value corresponding to the LRR of the item.

The copy of the Result Compliance value to the mapped Pg2 attribute only occurs during rollup. If the part (that is, LRR of item, or mfr. part) has multiple specs, and each spec has a mapped Pg2 attribute, the values of all the mapped attributes are copied from the RC value of the corresponding spec during the rollup.

If the admin changes a mapping to another attribute, the system removes the previous mapped attribute and also “erases” the old values from the Pg2 field. If you remove the specification from the Latest Released rev of the part, or from a mfr. part, the value of the mapped Pg2 attribute is also erased.

If you do a SaveAs from an item/mfr. part that already had a rollup, and already received the copied RC value, the new object will show the associated specification from the original object; however, because the new object has not undergone a rollup yet, it has no RC value and does not show the copied value on PageTwo.

The following lists administrator or end-user actions involving specification mapping, with their consequent effects:
Specifications table - lists the specifications that are associated with the part or part group; full details in "Compliance Tab > Specifications Table" on page 8-6.

Declarations and Compositions table - lists the declarations and compositions on the part or part group; full details in "Compliance Tab > Declarations and Compositions Table" on page 8-9.

The Compliance tab reflects changes to the composition of the part or part group. Changes to this data are generally collected using declarations; you can also manually import composition and substance data into items and manufacturer parts (but not part groups).

### Note:
Previous releases of PG&C used icons on tabs to indicate the presence of business objects; these are replaced by gray and red dots.

- Grey dot = The compliance state of all compositions are Waived, Exempt, Compliant, or Not Applicable;
- Red dot = The compliance state of one or more compositions are Non-compliant or Missing Information.

### Compliance Tab > Specifications Table
The Compliance tab has a Specifications table. You can add or remove specifications from the Specifications table.

- For internal specifications, when you add a specification to a part or part group and a compliance rollup (manual or scheduled) is run on the part, the specification is also added to the other part/PG on the BOM.
- For external specifications, when you add a specification to a part or part group and an external rollup (manual or scheduled) is run on the part, the specification is not added to the other part/PG on the BOM.
This is how the system automatically evaluates compliance of assemblies, even if the specification is not formally added to all the parts in the assembly. Specifications that were so added can then be removed with the “Bulk Specification Removal” on page 8-8 feature.

External rollups do not rollup the compliance status, but do rollup the substance mass value. Therefore external rollups do not add any external specification from the parent down the tree to children.

Views Filter of Specifications
In a part’s Compliance tab > Specifications table, there is a filter called Views that lets the user choose to display All Specifications or only Relevant Specifications, that is, specifications that are concerned with substances contained by the part.

Some Fields on the Specifications Table
- Exemption - This field can be set by the user (roles and privileges permitting) if you determine that the part is exempt for this specification. Remember that Exemptions is a field on a specification’s General Info page. When a specification is created, exemptions can be selected as a subset from an Exemptions drop-down list that represents all Exemptions of concern (this master list is created by the administrator for the Specifications class in Agile PLM). So, for a part, when you set a substance to Exempt, the values you see for Exemption on a part group’s Specifications table are really coming from the associated specification.

For this reason, Declared Compliance is valid only if there is an associated specification in the declaration. Only when there is a specification, and the spec has exemptions associated (found in the spec’s General Info), can you set Declared Compliance to Exempt: when you do, you are then prompted to select an exemption from the list.

- Need Compliance Check - this field is set to No when no new data has come in since the last rollup; it switches to Yes when the system receives new data, indicating that a rollup could produce a new Result Compliance. When a new rollup is run (scheduled or manual), this field reverts to No.

This field is not visible to the user on items. It is visible on manufacturer parts and part groups (Compliance tab > Specifications table). Whether or not the field is visible to you, the system still recognizes it and reacts to it in items.

Note: For internal compositions, both the archiving and unarchiving process cause the Need Compliance Check field on the part to be re-set to Yes. While that change is visible in manufacturer parts, the field is not visible in items. Moreover, the Archive and Unarchive action may change the compliance states for all specifications on the part or assembly. The best practice is, whenever you change a composition’s Inactive or Active state, do a compliance rollup on the part or related assemblies.

Note: While archiving and unarchiving external compositions, the Need Compliance Check field on the part is not re-set to Yes because external compositions will not be involved in internal rollup and external rollup.
Declared Compliance, Calculated Compliance, and Result Compliance are available at all levels - at the substance level, material level, subpart level, composition level, and at specification level. Also, Calculated Compliance at a level will be Result Compliance of the level below.

Note that the Calculated Compliance at any level can be overwritten with Declared Compliance. Also, the Calculated Compliance value can be changed by a Process Extension created through the Agile SDK.

**Bulk Specification Removal**

The "Bulk Spec Removal" feature (BSR) allows removing specs across the BOM in a single operation. Note that BSR applies only to Items and Manufacturer Parts; Part Groups are not capable of Bulk Spec Removal, that is, removing a spec from a part group does not remove the spec from associated parts.

Here is the use case: PG&C’s compliance feature can verify whether a product is compliant with a new (or planned, or upcoming) specification. By adding the spec to the top-level assembly (TLA), or indeed to any part/PG in the assembly, and running a compliance rollup, you learn that your product may or may not have problems with compliance to that spec. When compliance rollup is run on an assembly, the internal specification on that assembly is automatically added to all parts and mfr parts that belong to that assembly. Then, in this use case, and for a variety of other reasons, the user may not want to keep the propagated spec in the BOM.

In the case of removing a specification from an item that is not an assembly or contains no associated mfr.parts, you are prompted whether you want to continue, then the spec is removed with no further actions. Now, when you decide to remove a specification from an assembly or an item with associated manufacturer part, you will see the same prompt, then a Warning that asks you to choose "This Item" or "All," depending whether or not you want the spec removed from all items and mfr.parts on the BOM; this is the Bulk Spec Removal.

When you check All Sublevels, you are prompted with a message for you to choose:

- If you want to remove the specification from this item only, check This Item only, then click OK, the spec is removed;
- If you want to remove the specification from all items and mfr.parts belonging to this BOM, check both This Item and All Sublevels, then click OK, the spec is removed from all levels of this BOM.

More specifically, the spec is always removed from the current level of the BOM, that is, the level from which you start the BSR operation. Removal from the other levels is subject to these business rules:

- Since specifications are Rev-specific on items, BSR on items only applies to the particular revision that is presented in the BOM.
- If there is a value in Declared Compliance of the item or mfr.part, the spec is not removed from that object. Therefore, BSR removes all specs from all associated parts except those items/mfr.parts that have a value in its Declared Compliance field.
- When removing a spec, if the item is Latest Released rev or it is a mfr.part, the system erases the value of the mapped attribute for that spec. If the item is not LRR, the mapped value is not erased.

As a result of bulk spec removal, throughout the BOM, the Summary Compliance value is updated based on the overall compliance state from other associated specifications.
Compliance Tab > Declarations and Compositions Table
The Compliance tab also has a Declarations and Compositions table, which lists specification-supplier combinations that are associated with the part or part group.

Views Filter of Compositions
In a part’s Compliance tab > Declarations and Compositions table, there is a filter called Views that lets the user choose to display Active, Pending, or Archived compositions. This feature is fully explained in “Archiving and Unarchiving Compositions in Items and Mfr. Parts” on page 4-4.

Some Fields on the Declarations & Compositions Table
Fields on this table:
- Mass Disclosure - the field that states whether the composition is Fully Disclosed, Partially Disclosed, or Undisclosed; see “Mass Disclosure” on page 5-5.
- Composition Type - the use of this attribute is detailed in "Role of Composition Type Field" on page 4-3.
- Source - this field indicates the source of the composition; see “Sources of Compositions” on page 10-5.
- Declared Compliance - allows an information supplier to declare the compliance state of the substance. A Declared Compliance value always “trumps” a Calculated Compliance value. That is, the Result Compliance value field always take the state found in the Declared Compliance field. If the Declared Compliance field is blank, the value in Calculated Compliance is copied to the Result Compliance field during rollup.
- Calculated Compliance - This Read-only value is derived from the system’s logic: the Calculated Compliance of one level in a BOS or BOM is most likely the same value as the Result Compliance of the next lower level - unless there is a different value in the Declared Compliance field that is parallel to Calculated Compliance. Also, Calculated Compliance at a level will be Result Compliance of the level below.
  
  Note: The Calculated Compliance at any level can be overwritten with Declared Compliance.

  Note: The Calculated Compliance value can be changed by a Process Extension created through the Agile SDK.

- Result Compliance - this field simply reflects the “winner” for that level of the BOS or BOM. If there is a Declared Compliance value on that level, that becomes the Result Compliance value. If there is no Declared Compliance value, the Calculated Compliance value on that level becomes the Result Compliance. Finally, the Result Compliance of a level of BOS or BOM becomes the Calculated Compliance of the next higher level.

  For information about tracking changes to this field from compliance rollups, see “Tracking Compliance Changes through History” on page 11-5.
**Note:** When importing compositions and composition substances into items or manufacturer parts, at the end of import, the system performs a composition rollup. When the mass on the composition is blank (during import), the system uses the Cover Page Mass to do a composition rollup at the end of the import.

---

**View Substances Button**

On the Declarations and Compositions table, click the View Substances button to bring up the Substances View table. (The View Substances button appears only if the user has Read privilege for the Composition Type attribute.)

For each part and part group, the Substances View table lists associated substance composition (providing, of course, that the part/PG is associated with substances).

- Reporting - A read-only field, the value comes from the Reporting field on the associated specification Substance table for the same substance. The rollup only looks for substances that are marked as Mandatory in the spec.
- Mass (or Declared Mass) - can be used by the supplier to declare the Mass values at each level of the BOS.
- PPM (or Declared PPM) - if enabled, can be used by the supplier to enter the PPM values directly. It supersedes the Calculated PPM in the rest of the rollups.
- Threshold Mass PPM - A read-only field, its value comes from the Threshold Mass PPM field on the associated specification’s Substances table for the same substance. The "threshold mass PPM" describes the maximum quantity in parts-per-million of a substance allowed in order to be within compliance.
- Calculated PPM - the PPM as the result of the division of the mass of two levels.
- Calculated Mass - If Part Mass and Declared PPM of the substance is available, the calculated mass equals to part mass multiplied by declared PPM of the substance.
- Result PPM - if there is a Declared PPM value for the substance, that becomes the Result PPM value. If there is no Declared PPM value, the Calculated PPM value for the substance becomes the Result PPM value.
- Result Mass - if there is a Declared Mass value for the substance, that becomes the Result Mass value. If there is no Declared Mass value, the Calculated Mass value for the substance becomes the Result Mass value.
- Intentionally Added and Spec Intentionally Added are discussed in "Intentional and Non-intentional Substances and Related Attributes" on page 5-8.
- User-entered CAS Number - The information supplier can enter a value on a declaration or a regular user on a part or part group. These are used by the compliance manager to ascertain the precise substance the supplier is referring to.

---

**Note:** Values are calculated for all appropriate fields whether or not those fields are visible to you (enabled by the administrator). In PG&C, the administrator can choose to make some things not-visible, but in rollups the system is “indifferent” to that factor, that is, it always takes non-visible fields into account. If you think there is information that is not visible that you need to see, see your administrator.
Scale Property in Calculated PPM and Result PPM
As an example of these fields in use, let us say the Scale property for Calculated PPM and Result PPM is set to 2 in Administrator, which permits two decimal places. In this case, you could see a value of 333.33 in these fields on declaration <Parts/PGs> BOS tree for a substance, and even if Threshold PPM is equal to 333.33, the system could identify it as Not Compliant because the value (that it perceives in the database) for Calculated PPM and Result PPM could be 333.333333333, which is slightly higher than Threshold PPM at 333.33.

If you run into this situation, you must advise the administrator to set the scale property with a higher value for Calculated PPM and Result PPM on the Substances tables.

Also, if the Threshold PPM is set to 100 and the Calculated PPM and Result PPM are calculated to be 100.0001999, the system still makes the substance Non-Compliant because the calculated PPM is higher than the Threshold PPM, however small the discrepancy. Again, in this case, if the scale on Calculated PPM is set to 2, you would see 100.00 in the field, whereas the value in the database is slightly but inescapably higher.

Modifying the Declarations and Compositions Table
To add compositions to the part/PG Compliance tab > Declarations and Compositions table, you can follow the original RFI process, that is, (1) create and send a declaration to a supplier, (2) receive and verify the completed declaration, and (3) publish (release) it. You can also manually import composition and substance data into items and manufacturer parts (but not part groups).

Suppliers Tab
The Suppliers tab lists the suppliers who carry this part or part group. The Suppliers tab enables you to add, edit, or remove suppliers on a part or part group. Parts can be tracked with regard to their approved suppliers.

Note that you can also map the Supplier attribute under Suppliers tab to P2 attributes.

If there are suppliers associated with a part or part group, when creating a declaration from a part or part group Actions menu, the suppliers from Suppliers tab of the part or part group are displayed in a drop-down list for convenience. You may select any one of these suppliers or search for and select another supplier in the system.

Part Groups > Parts Tab
A part group’s Parts tab lists all parts and manufacturer parts associated with the part group. The association between part groups and parts is important because some properties of the part group are carried over to the associated parts.

Changes on a part group’s composition through the declaration process, impacts all parts and manufacturer parts on the Parts tab of the part group.

You cannot add substances to a part group’s Parts tab, you can add only parts and manufacturer parts. (If your company is set up for “Commodity-only” objects, you can import only items, not manufacturer parts. “Commodity-only” objects can have only parts on the Parts tab. These and other business rules are detailed in Make Available As Attribute and the "Force/Identical" SmartRule.)

- Conversion Factor - The items and manufacturer parts belonging to a part group have a conversion factor that is used to convert data such as Mass and Substances Content from the part group to its member parts.
To describe how the conversion factor works, let a part group describe a series of cable, made of the same materials and available from supplier(s) in a variety of lengths. The part group contains the data that defines the “unit” length of cable to be 2 feet long. The part group object then lists cables of 2 ft, 6 ft, and 10 ft in length. So, the 2-ft cable has a conversion factor of 1 in terms of its mass and hazardous substances content, the 6-ft cable has a conversion factor of 3, while the 10-ft cable has a conversion factor of 5.

---

**Note:** Conversion Factor in part groups is a different idea from Conversion Factor in substance groups. See “Substance Groups > Substances Tab > Conversion Factor” on page 5-2.

---

**Creating Part Groups in PG&C**

Part Groups let users categorize parts for compliance and sourcing processes, and collect information on restricted substances for part groups.

Part Groups can be associated with items - parts and documents - and manufacturer parts. A part group is a way of grouping similar types of parts. By associating each part with a part group, your users can distribute Requests For Information (RFIs) to suppliers based on the part groups they offer.

As with the other PG&C objects, part groups are created and modified in Web Client. You can search for part groups in Java Client, but not create them.

Part Groups can be active or inactive (Lifecycle Phase). Part Groups are not routable, so they do not have workflows (the only routable PG&C object is the Declaration). They are simply used to categorize groups of parts.

To create a part group:

1. Click the Create New drop-down button to activate the menu.
2. Click the Part Groups link.
3. In the Create New Part Groups dialog, click the drop-down arrow next to the Type: field. From the list of subclasses, select Part Family. The administrator may have created additional subclasses of part group.
4. Enter the desired information in the Name: field.
5. The Make Available As field may appear (pre-populated according to administrator choices).
6. Click Save. The new part group object appears with the General Info tab selected.
7. After the part group object is created, it can be modified at any time. This task continues with steps to add appropriate objects.
   - Open the part group, click Edit: to add information and populate enabled fields under the various tabs.
   - To add parts to the part group, click the Parts tab, then click the Add button.
   - Click the Search to add icon to add existing parts in the Parts Search dialog.
   - Or click the Create to add icon to create a new part object that will be added to the part group.
   - Click to select parts to add, and hit Enter; or you can double-click a part to add it. You may run additional searches after this, too.
8. To add specifications to the part group, click the Compliance tab. In the area of Specifications table, click the Add button.
Use the same set of steps (as adding parts) to search for and associate specifications to the part group.

9. On the Suppliers tab, use the same set of steps to search for and associate suppliers to the part group.

10. To add attachments, click the Attachments tab. Choose from the Add menu Files, URLs, or By Search. When you are finished adding attachments, click Finish.

11. When your modifications are complete, click Save.

Mapping Feature in Parts and Part Groups

The mapping feature is available for use in to Page Two (class-level) and Page Three (subclass level) tabs in items, manufacturer parts, and part groups.

Note: Although PG&C supports attribute versioning (attributes on Page Two and Page Three are change-controlled), mapped attributes on Page Two cannot be change-controlled.

Mapping of attributes is useful for some Page Two/Page Three attributes in parts and part groups. Mapping lets you see some values from the Compliance tab > Declarations and Compositions table attributes. It distributes changed values on published declarations that are associated with those parts. The administrator may have mapped fields within parts. For example, the administrator has enabled and mapped Declaration > Items > Part (link) > PageTwo > Date05 to Part > Compliance tab > Declarations and Compositions > Date02, when you edit this attribute, the new value is published back to Part > Page Two > Date05.

Now let us say the supplier alters the Date02 field while completing the declaration. When the declaration is returned, released, and the data is published to the system, this new value automatically carries over to Part > Page Two > Date05.

Note that the mapping works two ways: when adding this item to the declaration, the system pulls the value from the item’s Page Two / Page Three into the declaration’s <Parts/PG> table onto the mapped attribute.

When multiple declarations regarding the same part are sent to different suppliers, the rule in Agile is "Latest Released Wins." This implies that the value of a mapped attribute can change if later declarations dictate it.
A declaration is the main object of record in the PG&C solution: it is a record of questions posed by a compliance manager to an information supplier about the supplier itself, its products, or how its products comply with given specifications. Also, declarations keep track of all the substances and materials that are contained in items, manufacturer parts, or part groups.

The Declarations base class has seven default classes of declarations. The following table defines the kinds of declarations in PG&C.

<table>
<thead>
<tr>
<th>Declaration class</th>
<th>Definition</th>
<th>Validation Type of Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substance Declarations</td>
<td>The supplier is requested to provide compliance information for each substance within the specification.</td>
<td>must be Part Level</td>
</tr>
<tr>
<td>Homogeneous Material Declarations</td>
<td>The supplier is requested to provide a complete BOS breakdown of the part and provide compliance information at the homogeneous material level.</td>
<td>must be Homogeneous Material Level</td>
</tr>
<tr>
<td>Part Declarations</td>
<td>Receive part-level compliance information as well as other composition header level information (manufacturing parameters).</td>
<td>can add any specification</td>
</tr>
<tr>
<td>JGPSSI Declarations</td>
<td>The supplier is requested to provide compliance information (weights) according to the JGP standard.</td>
<td>must be Part Level</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> There is a fully supported Japanese version of the JGPSSI template for creating JGPSSI Declarations; see your administrator.</td>
<td></td>
</tr>
<tr>
<td>Supplier Declarations of Conformance</td>
<td>A questionnaire to assess supplier compliance with specifications from customers and government agencies. The survey addresses compliance at a general company level. Can be used for CSR &lt;type&gt; declarations.</td>
<td>can add any specification</td>
</tr>
<tr>
<td>IPC 1752-1 Declarations</td>
<td>A Joint Industry Guide (JIG) substance declaration for electronic products. The 1752A type supports IPC 2.0 and REACH compliance.  &quot;IPC Formats Supported in this Release&quot; on page A-10.</td>
<td>must be Part Level</td>
</tr>
<tr>
<td>IPC 1752-2 Declarations</td>
<td>A Joint Industry Guide (JIG) homogeneous-material declaration for electronic products.</td>
<td>must be Homogeneous Material Level</td>
</tr>
</tbody>
</table>
More About the Declarations Classes

These are additional facts and rules of business logic for the out-of-box Declarations classes.

Supplier Declarations of Conformance

This class of declarations requests statements from suppliers at a supplier level. It is basically a supplier survey. The company sends out a questionnaire and receives a declaration from the supplier, assessing compliance with specifications from customers and government agencies. Typical questions could be: Do you have a RoHS compliance Initiative going on? When do you anticipate to have 100% compliant Product? Which ISO certifications do you possess?

No fields are pre-populated in this declaration. The SDOC does not require association with any items, manufacturer parts, part groups, or even specifications to be effective. Adding specifications to this type of class is allowed for reference purposes.

Japanese Green Procurement Declarations

This class of declarations is used against the template for the Japanese Green Procurement format. Agile supports only JGPSSI version 2.02. Your company wants suppliers to provide a declaration in the JGPSSI format using the JGPSSI supported entities. No substances from specifications are pre-populated in this declaration.

Part Declarations

This class of declarations is used to ask questions related to parts or part groups. Your company wants to send out a questionnaire to assess part compliance with specifications from customers and government agencies. Typical questions could be:
What is the maximum re-flow temperature of this part? What type of plating is on this part? Is this part in compliance with a certain specification? No fields are pre-populated in this declaration.

**Substance Declarations**

This class of declarations allows a supplier to respond at a substance-group level and at a substance level without being able to add to the BOS. It could be a material compliance declaration in which your company wants suppliers to declare compliance with specifications at the substance level; or, it could be a partial material disclosure declaration in which your company wants suppliers to disclose the weight and/or concentration of selected (or all) substances that are contained within the components and subassemblies it sources from this supplier.

A substance declaration supports pre-population of substances and substance groups from associated specifications.

**Homogeneous Material Declarations**

This class of declarations allows a supplier to build a BOS consisting of four levels: subpart, homogeneous material, substance groups, and substances. It could be a material compliance declaration at the homogeneous material level, or it could be a partial material disclosure declaration to discover the weight and concentration of substances that are contained within the homogeneous materials. This can be effected through an outside application or spreadsheet. No fields are pre-populated in this declaration.

**IPC 1752x Declarations**

The IPC 1752 Declarations classes are material declarations which support the compliance data gathering for the EU RoHS regulations. Only the enhanced IPC-1752A standard includes China RoHS and REACH.

These declaration classes support compliance data gathering via the IPC-1752 standards. The IPC-1752x family of standards establishes a standard reporting format for material declaration data exchange between supply chain participants. IPC-1752A is the latest version of the standard, version 2.0, which supports REACH compliance. IPC-1752A supports reporting multiple parts, reorganization and simplification of the reporting levels. It removes the list of substances out of the standard into informative annexes to improve the ease of updating data exchange.

IPC past standards (IPC 1752-1) and homogeneous materials declarations (IPC 1752-2) supported data entry PDFs for collecting data. IPC-1752A does not support PDF forms; instead the electronic signature resides within the XML data.

**BOS Data Delivered by Scriba Tool**

To use the new IPC 175x Version 2.0, you need to download the Scriba1750a_beta06 from [http://sourceforge.net/projects/ipc175xutils/](http://sourceforge.net/projects/ipc175xutils/). Scriba is a tool that allows you to enter BOS data. The BOS data is then imported using the Import IPC 2.0 XML process extension.

**Privileges**

A user must be assigned the Import and Export privileges to complete IPC declarations. If your privileges do not include these, see your Agile Administrator.
Classes and Subclasses

Your administrator must create a new subclass of IPC 1752-1 declarations in Java Client. See “Configuring the PG&C Classes” on page A-21 for more information.

PDF forms for pre-version 2.0

IPC declarations prior to version 2.0 use PDF forms. Adobe Acrobat version 7.x is the minimal requirement, while Acrobat version 8.x is the recommended release for work with the IPC PDF forms. The website for Adobe Software is www.adobe.com.

The IPC1752-2 PDF form allows entry of unstructured substance data. For instance, the user can enter homogeneous material data in a hierarchical structure or in a flat structure. The system also stores the flat structure within the declaration, which can show the user how the data was retrieved from IPC and how PLM converted the data into a hierarchical structure.

The storing of the flat structure is accomplished through four flex-fields, Text01--Text04, on the part Substances tables. They are renamed as IPC Sub-item, IPC Material, IPC Category, and IPC Substance.

By default, these fields are disabled (not visible), and the flat structure is not stored. To capture the flat structure of the composition, these fields must be enabled by the administrator. Even with the flex-fields enabled, a user must have Modify privilege for those fields; if not, the flat structure is not stored and the user sees an “Insufficient Privilege” error during the import procedure.

XML Data Delivery

With these updates the electronic signature resides within the XML data, and not in the original PDF form.

Figure 9–1 XML Data Delivery

Mapping Between Agile and IPC 2.0

You can now import IPC version 2.0 xml files into Agile PLM and export data from Agile PLM as IPC version 2.0 xml files. You can also map IPC version 2.0 xml to the Homogeneous Material Declaration.

<table>
<thead>
<tr>
<th>Agile Level</th>
<th>IPC 2.0 Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homogeneous Material Declarations</td>
<td>IPC 2.0</td>
</tr>
<tr>
<td>Subpart</td>
<td>Material (Homogeneous Material Name)</td>
</tr>
<tr>
<td>Material</td>
<td>Material Group (Homogeneous Material Group Name)</td>
</tr>
<tr>
<td>Substance Group</td>
<td>Substance Category</td>
</tr>
</tbody>
</table>
Guidelines for Parts and Specifications on IPC Declarations

Export IPC 2.0 XML and Import IPC 2.0 XML can now support multiple objects, so each IPC declaration can now carry more than one specification and part/part groups. There is no restriction to the number of specifications or the number of parts/PGs that can be added to IPC declarations. However, if a declaration carries multiple items, manufacturer parts, or part groups and multiple specifications, Export IPC 2.0 XML supports multiple Parts/PGs. This implies that Export IPC 2.0 XML will export all compositions from the declaration’s <Parts/PGs> tables. Export IPC XML will only export one composition from the declaration’s <Parts/PGs> tables.

Similarly, Import IPC XML updates only one composition, that of the part that was exported. The system identifies this by the part number, rev, and the first specification in the declaration’s Specifications table, which is sorted alphabetically.

Import IPC 2.0 XML will also update all compositions of the parts that were exported. The system identifies these by the part number, rev, and the related specifications in the declaration’s Specifications table, which are sorted alphabetically. As part of Import IPC 2.0 XML support of multiple compositions, for one item with different revisions, the revisions are distinguished by this format: ‘NumberId [Rev]’.

IPC-BOS Import for Multiple Products and Use Cases

IPC 1752A Version 2.0 supports identification of multiple products to which associated declarations apply.

Multiple Products Use Cases

Multiple products support covers these four use-cases:

- Included products have same mass and material content
- Included products have different mass with the same material content
- Included products have same mass with different material content
- Included products have different mass and different material content

Case 1: Same Mass and Same Material Content

A grouping of reported products where all the products are identical in body mass and material content. Most often this scenario is associated with grouping of products (product family). Class A, B, C and D are fully supported in this case.

Case 2: Different Mass and Same Material Content

The products have different mass but are identical in material content. This is usually associated with a grouping of products that are composed of same materials, but vary in body size or number or repeatable products. When different masses are assigned to different products, masses are reported in percent. This case supports single response for class A, and classes B, C or D may be used to report detailed content.

Example: Touch pads in different sizes. Everything is the same in terms of product intervals, except for the size of the case, screen, and so forth. Another example would be wire - single strand, double strand, and so forth.
Case 3: Same Mass and Different Material Content
A grouping of products with same mass value but different material content. This scenario is possible if the products are produced in different manufacturing facilities with different raw or processed material sources. Class A supports single response and class B, C or D supports detailed material content.
Example: A resistor or capacitor with same mass might be manufactured from different materials.

Case 4: Different Mass & Different Material Content
These products have different mass and different material content. This would happen when a set of products that are used to make finished goods with no commonality are grouped together. Class A supports single line response and class B, C and D supports more detailed content.
Example: A list of component used to assemble a power block. Or a list of components supplied by the same supplier - resistors, capacitors, and so forth.

IPC 2.0 New Map Attributes
The following map attributes have been added for Process Information on the Manufacturer parts on existing IPC 1752-1 and IPC 1752-2 classes.
1. Ramp Down Rate
2. Preheat Min Temp
3. Classification Temp
4. Time Above 217
5. Max Time Within 5
6. Preheat Max Temp
7. Component Temp Spike
8. Ramp Rate
9. Preheat Duration
10. Max Total a Wave Time
11. Max Total Solder Time
12. Package Designator
13. Psl Rating Wave
14. Wave Additional Info
15. Psl Rating Reflow
16. Reflow Additional Info

Tabs and Attributes in Declarations
Declarations are the “workhorses” of the PG&C solution, carrying many kinds of data and giving that data dynamic qualities as they are published into the product record. This section reviews the basic tabs in declarations and the kinds of information each tab carries.

Many attributes in PG&C appear in several or all of the PG&C business objects, as well as items and manufacturer parts. Because any given attribute may be defined only
once in this manual but may not be defined in this chapter, simply search the PDF for
the attribute you want to see.

Cover Page

The Cover Page tab provides general information about the object. The declaration’s
name, description, supplier, date sent to supplier, and due date are data you enter
when creating the declaration. The Cover Page carries information about the
compliance manager and the supplier, including contact users. After you create the
declaration, you can edit it by choosing the Edit button in the Cover Page tab.

Note: As soon as a part or part group is added to a declaration, the
associated supplier cannot be changed.

- Has Invalid Substance - “No” indicates the presence of an invalid substance. You
must correct it before you release the declaration.

- Need Rollup - A flag indicates if the declaration has been modified since the last
time of declaration rollup. So, after an invalid substance is corrected, or Mass (on
Parts table) changes, Need Rollup attribute automatically changes to Yes. It is
simply an “advisory” field. When the declaration rollup is run, the field reverts to
No.

Note: The Need Rollup field does not change to Yes if a Substance
Declaration changes directly from Pending to Released statuses.

- Supplier - Unless the administrator has made the Supplier field for the type of
declaration you are creating 'Not Required', an Active supplier must be
named. The supplier can be a Web Supplier (that is, in Supplier object, Web
Supplier field = Yes) or a “non-Web Supplier” (Web Supplier field = No): but a
Web Supplier must have at least one associated Declaration Recipient. You can
name a non-Web Supplier in the declaration with no associated declaration
recipients. It is recommended that declarations name a Web Supplier, as PG&C
carries and publishes the most complete information when a Web Supplier
with declaration recipients is associated.

Note: If the Supplier field is made Not Required (by the
administrator, for a given class or classes of declaration), you can still
add a supplier to the new declaration. However, with Supplier field
Not Required, if you create a declaration from a part/PG’s Actions
menu, you are not allowed to add a supplier, since from the part’s
Actions menu the declaration is created with the part already added
(and, as noted above, once a part is added to a declaration, in effect
the Supplier field cannot be changed).

Affected Parts Tabs

The following table shows the hierarchy of data about parts and part groups that are
contained in most declarations (except, for example, Supplier Declarations of
Conformance). Each “affected parts tab” in a declaration has a table listing the Items,
Manufacturer Parts, or Part Groups, and a table listing the substances associated with
each part (for example, Substances for Item ABC):
Tabs and Attributes in Declarations

<table>
<thead>
<tr>
<th>Items tab contain</th>
<th>Manufacturer tab contain</th>
<th>Part Groups contain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items table – lists parts and documents on the declaration</td>
<td>Mfr Parts table – lists manufacturer parts on the declaration</td>
<td>Part Groups table – lists part groups on the declaration</td>
</tr>
</tbody>
</table>

Parts Tabs Attributes

Many attributes that you see in declarations appear also in parts/part groups. See “Tabs and Attributes in Declarations” on page 9-6 in Parts and Part Groups for definitions of attributes.

- Exemptions - There is an Exemption field on a declaration’s <Parts/PGs> tabs. Exemptions are set in a specification’s General Info page; the values you see for Exemption on a declaration’s Parts tab come from the associated specification.

Excluding Compositions from Rollups

There is a use case where a manufacturer may not want or need a composition to be evaluated for compliance. A field, Exclude from Compliance Check, is now provided to handle this; it is on the <parts/PG> tabs of declarations (that is, Items, Manufacturer Parts, and Part Groups tabs, as well as the Compliance tab of the <part/PG>). You can set it either on the declaration itself, or you can “manually” set in the (import) XML file before importing it to a part.

Here is a representative use case. Remember that, after a composition is attached to a part (either through importing or through the RFI process), it is always included in subsequent compliance calculations. The Exclude from Compliance Check field means that this statement is no longer always true.

When an EMS provider must provide compliance information to their OEM customer, the EMS provider first contacts their component suppliers. Having obtained compliance data about their components, the EMS provider sends consolidated compliance information to the OEM via a declaration.

Now, the OEM wants compliance validation across all parts in the BOM, so the OEM attaches the information as a composition to the top-level assembly.

However, from the EMS provider’s point of view, this composition does not need to be included in their own rollup process, since it is going to be used just for “exporting” to the OEM customer. They can use Exclude from Compliance Check field.

- Exclude from Compliance Check - Set to Yes (default is No), the compliance rollup ignores the composition. Note that the system still performs the calculation within that composition, but this composition is ignored during compliance rollup of the <part/PG>. This field is also seen on the <part/PG’s> Compliance tab > Composition table, but it cannot be modified there.

Substances for Parts Table

Note: Part Declarations do not have a Substances table.
For each part and part group, the Substances tables list their associated substance composition, providing the part or part group is associated with substances. You can filter the Substances table to isolate substances for a particular part or part group.

See "Tabs and Attributes in Parts and Part Groups" on page 8-2, for definitions of attributes, such as Threshold Mass PPM, Calculated Mass, Intentionally Added, and so forth.

For more information about compliance rollups, see Appendix B, "System Logic of Internal Compliance Rollups."

Specifications Tab

When adding specifications to a declaration, for every part in the declaration, the system creates “part+spec” combinations, or compositions.

The compliance manager may inform the supplier that the buyer is going to validate the supplier’s substances based on the specifications on the Specifications tab. If there are one or more specifications associated with this substance declaration (this type only), the system automatically pre-populates the substances from those specifications for all the items, manufacturer parts, or part groups in this declaration. If there is no specification associated with this declaration, no substance is pre-populated, even for the substance declaration.

The Specifications table of a declaration lists specifications related to the items, manufacturer parts, and part groups contained in the declaration. The purpose of a declaration is to ensure that suppliers comply with any restrictions stated in the specifications.

The specifications may concern many substances, including those not used by the parts contained in the declaration. When a substance declaration is opened to the supplier, any substances from the specifications are automatically added to the Substances for <Part/PG> tables. This ensures that you are properly tracking any restricted substances contained in parts listed in the substance declaration.

A new field on the Specifications tab, called Rollup Engine indicates whether the specification will be rolled up internally or externally. For more information on rollup types and how they are tied to specification type, see "Internal vs. External Specifications" on page 7-1, "Rolling Up Compliance Data Using Internal Rollup" on page 11-1 and "Rolling Up Compliance Data Using External Rollup" on page 12-1.

Rules for Synchronizing Declaration Parts Tables and Specifications Table

The notes for the “import” case below are given here in parallel with working in the object, that is, in Web Client’s user interface.

From the Object in Web Client

- When adding a part: the system creates one composition for each spec in the declaration for that part.
- When adding a spec: the system creates one composition for each part in the declaration for that spec.

Example: given two compositions, (Item1+Spec1) and (Item1+Spec2), if you remove the second composition, when you add Spec3, the system will create a third composition, namely (Item1+Spec3), and it does not re-create the second composition; therefore, there is no “sync-up” in this case.
From the Import Utility

- When importing a part: if you name a specification along with part, the system creates a composition only for that part+spec combination, and it does not create one composition for each spec in declaration or each spec in the Import file; therefore, there is no “sync-up” in this case.

Example: given an Import file with (Item1+Spec1) and (Item2 + no specification), if there are two specifications (Spec1 and Spec2) in the Import file or in the declaration, the system creates the following compositions: (Item1+Spec1), (Item2+Spec1), and (Item2+Spec2).

- When importing a specification: the system creates one composition for that spec for each part in the declaration.

Workflow Tab

The default Declarations Workflow is used in the RFI processes. The Workflow tab of a declaration shows all the statuses the declaration has passed through, and which statuses remain to be completed. It also shows all the approvals and rejections made during each approval cycle. See "Routing Declarations" on page 3-4.

For more information about using the Workflow tab, see the chapter on Items in Agile PLM Product Collaboration User Guide. There is also a chapter on workflows in Getting Started with Agile PLM.

Creating Declarations

Compliance managers - an Agile user who has been assigned the Compliance Manager role - can create declarations. (More specifically, a user with a role that has the Create Declaration privilege can create a declaration; Compliance Manager is the out-of-box role with this privilege.) Supplier users with the (Restricted) Material Provider role (and who are not restricted to the Basic supplier interface) can also create declarations: in this case, only the Name attribute is required to create the object (because it is a "Restricted" role); the Supplier attribute is filled in automatically with that user’s supplier organization.

Note: Some values for declaration-recipient fields come from the Supplier business object, while some values come from the “supplier user” business object (the declaration recipients).

You can create a declaration either through the Create function, or by choosing Actions > Create Declaration from within an item, manufacturer part, or part group.

When you create a declaration, you must specify a unique declaration name. By default, the name field uses an Autonumber format with the prefix "MD" (for "Material Declaration"). Although the Autonumber format is not required, it makes sense to use the same prefix for all declarations to make it easier to search for them. In any case, the name must be unique and it must be upper case (unless the administrator has changed the character set for declaration names and allows mixed case).

Selecting Specifications to add to Declarations

Specifications are associated with declarations to provide the basis by which compliance information is specifically requested and, upon completion by the
supplier, evaluated by the compliance manager. The declaration’s Compliance tab lists associated specifications on the Specifications table.

When you add one or more specifications to a declaration, the type of specifications that are appropriate to select depends on the type of declaration. The table in the beginning of the chapter, specifies the type of specification you can add to each type of declaration. A new field on the Specifications tab, called Rollup Engine indicates whether the specification will be rolled up internally or externally. For more information on rollup types and how they are tied to specification type, see “Internal vs. External Specifications” on page 7-1, Appendix B, “System Logic of Internal Compliance Rollups,” and Appendix C, “Reference Documentation for External Compliance Rollups.”

The declaration to which no specification is added still functions, but is then merely a part survey for weight and perhaps PPM information, and is no longer a request for a compliance statement. Selecting a value in a compliance-specific field has no meaning for a declaration with no associated specification.

You cannot change the class of a declaration once a specification is added to it, since there is a limitation between the class of a declaration and the type of specification attached to that declaration.

---

### Creating a Declaration

This task takes us through the Create wizard to configure a declaration.

To create a declaration:

1. Click the Create New drop-down button to activate the menu.

2. Point to the Declarations link, which sends the flyout menu of Declarations classes. It is possible your administrator has renamed these or created additional Declarations classes.

   Select and click a link from the list of classes of declarations - Substance, Homogeneous Material, JGPSSI, Part, Supplier Declaration of Conformance, IPC 1752-1, or IPC 1752-2.

3. In the Create New dialog, click the drop-down arrow next to the Type: field.

   The administrator may have created additional subclasses of the selected class of declarations. Additionally, note that 1752A is now a choice when you select an IPC-1752-1 class. Select and click an appropriate subclass.

4. In the Name: field, an identifying number for the declaration is automatically generated. Accept or modify this identification.

5. If the Supplier field is visible (it does not apply in all declarations), click the Search icon to bring up the Search for Suppliers dialog. Search for and select a supplier. You are allowed to select only one supplier per declaration.

---

**Note:** When creating a declaration from part or part group Actions menu, if there are suppliers in the part or part group Suppliers tab, those suppliers appear in the dialog; you can either select one of them or search for a different supplier to add to the declaration. When a supplier is added to a declaration, details pertaining to the supplier are added to Cover Page and Page Two fields, provided it is a Web supplier with at least one associated declaration recipient.
Note: The requirement that a declaration have a supplier has been removed; but the administrator must make the Supplier field ‘not required’. PLM also allows declarations to name either kind of supplier: a Web Supplier (Supplier object > General Info tab > Web Supplier field set to Yes) must have at least one associated Declaration Recipient; a non-Web Supplier (Supplier object > General Info tab > Web Supplier field set to No) may be named in the declaration with no associated declaration recipients. However, it is still recommended that a declaration name a Web Supplier: PG&C carries and publishes the most useful information if a Web Supplier with associated Contact Users is named; for example, those declaration recipients receive notifications.

6. Click Save. The new declaration object appears with the Cover Page tab selected.

7. You can modify the declaration any time, after you create it. This task continues with steps to add appropriate objects, such as parts, manufacturer parts, part groups, and specifications to the declaration.

Open the declaration, click Edit: to add information and populate enabled fields under the various tabs.

8. Enter the general information (Description, Declaration Type, Compliance Manager, Workflow, and Due Date).

It is recommended to always assign a Compliance Manager. If you do not, when the supplier returns declaration, all Compliance Managers in the system will be notified. Note that when you select a Compliance Manager, the values on these attributes are added immediately: Title, Phone, Email, and Fax.

9. To add specifications to the declaration, click the Specifications tab, then click the Add button.

Click the Search to add icon to add existing specifications in the Specifications Search dialog.

Click to select specifications that you want to add, and hit Enter; or you can double-click a specification to add it.

Note: There is some restriction on what type of specifications can be added to a declaration. The validation level is displayed in the Add Specification search wizard, and you must select an appropriate specification based on the validation level - Part level or Homogeneous Material level.

You can run more searches to add more specifications as appropriate. Depending on how many specs are added, that many records or entries will be created for each part or part group that is added to the declaration.

10. On the Items tab, use the same set of steps to search for and associate items (Agile parts or documents) to the declaration.

11. On the Manufacturer Parts tab, use the same set of steps to search for and associate manufacturer parts to the declaration.

12. On the Part Groups tab, use the same set of steps to search for and associate part groups to the declaration.
13. On the Attachments tab, if you want to add attachments, choose from the Add menu Files, URLs, or By Search, and navigate to the desired file or URL.

14. When you complete your modification, click Save.

If you have added $m$ number of specifications and $n$ number of parts, you will create $(m \times n)$ compositions in the declaration Parts table, and each of these compositions has its own set of substances that are governed by the threshold defined in specification for that composition.

Pre-population of substances occurs only when there is a specification present and only for Substance declarations. If you do not associate any specification to a Substance declaration, no substances are pre-populated to the declaration.

Working with Declarations

The chapter on “Substances” on page 5-1, introduced the elements of substance validation and correction. Listed below are a few points about how substance validation impacts declarations.

Invalid Substances in the Declaration

When suppliers respond with substances for a part, they are not sure about how substances are declared in the customer’s system. Use of the Alias field in substances in the buyer’s system allows any substance to be introduced into the declaration and the compliance manager does the “clean-up”; suppliers can submit their information faster, which encourages completion of declarations.

Restriction about invalid Substances in Declarations

When the declaration contains substances or substance groups that do not exist in the system (invalid substances that are not “aliased”), you cannot perform a rollup from the declaration’s Actions menu, nor does the system automatically perform a rollup on change status of the declaration. You must “clean up” all invalid substances in order to be able to perform a rollup.

If there are invalid substances or substance groups, the system does allow you to manually change status except to the Released status. Even if there is one invalid substance, the system will not allow the declaration to advance to Release; a message on the declaration indicates this.

---

Note: Materials and Subparts that do not exist in the buyer's system can come into a declaration, and can still be released: to distinguish them, we refer to them as “local substances”. But Substances and Substance Groups (that are not aliased or do not exist in the buyer's system) can block the declaration from being Released, so the uncorrected substances/substance groups are particularly called “invalid substances”.

---

Action > Verify Substances

Verify Substances is enabled on a declaration’s Actions menu when there is an invalid substance present, often the result of a naming problem. (Also, it is enabled only when you have (including supplier) the privilege to change the status of the declaration.)

Click Actions > Verify Substances to bring up a popup with these fields:

- User-entered Substance or Substance Group
Working with Declarations

- User-entered CAS number
- A drop-down list of matching substances/substance groups that match the CAS number
- Icons for Creating a substance object and for Searching for an existing substance.

Correcting Substances in Declarations

If you are prompted to “Correct Unknown Substances,” this can often be achieved inline: as you type potential substance name into the Replace With field, a drop-down list offers existing substances (per the letters you have typed).

Figure 9–2  Inline editing to correct substances

Working with the Part Tables

The Items, Mfr Parts, and Part Group tabs in a declaration work similarly when to Add, Edit, or Remove parts.

For information about importing substances or compositions into parts, see "Importing and Exporting Data in PG&C" on page 10-1.

These are two general methods to add substances to parts and part groups:

1. When a declaration is released, the specifications and substances from the declaration are published to its parts.

2. When a part is associated with a part group, then any specifications, compositions, and substances from the part group are copied to the parts (with the conversion factor that was provided).

Remember that when adding <parts/PGs> to a declaration, if the declaration already contains specifications, PG&C will create part+spec combinations - compositions - for each specification in the declaration.

Working with the Part Substances Tables

The Substances for <Part/PG> tables on the <Part/PG> tabs of declarations are no longer Read Only from the user interface. The ways to add substances to the
Substances for <Part/PG> table of a declaration: (1) by Process Extensions, (2) by implementing the Excel integration or, for IPC declarations, (3) by using XML-based integration; see "Importing and Exporting Declaration Data" on page 10-6.

You can also add substances, edit substances, or remove substances from declarations. These modifications, known collectively as Substance Editing, are carried out using Actions within the declaration.

**Substance Editing**

Substance editing lets you add, remove, and edit substances directly in (unpublished) declarations. The substance editing feature is available on all types of declaration except Supplier Declaration of Conformance and Part Declaration.

Linked to Composition Type Field, the declaration classes in which substance editing works are as follows.

- Composition Type = Substance Composition:
  - Substance, JGPSSI, and IPC 1752-1 declarations
- Composition Type = Homogeneous Material Composition:
  - Homogeneous Material and IPC 1752-2 declarations

The behavior of the Actions are described according to the type of declaration.

**Substance-Type Declarations: Substance, JGPSSI, and IPC 1752-1 Declarations**

Add - lets you add a substance group or a substance to the selected part. You can use search, or type in known substance names directly; “Type-in names” is also the method to add a non-existing substance. The system will prompt if you add a duplicate substance to the same part. When you add a substance group, the system does not populate its children. In the Substance type of declarations, you cannot add a material or subpart directly to the part.

---

**Note:** If a substance/substance group added (using typed-in names) does not exist in the system, a question mark (“?”) appears in the substance name indicating this is an invalid substance. You can use Verify Substances to make the correction.

Add Sub-level - lets you add a substance to a selected substance group (SG). If you do not select an SG (or you select a substance instead), the system prompts you to select a valid row. You can type in known substance names to add an existing or non-existing substance to the parent SG.

Edit - lets you edit all editable fields on selected rows. Note that you cannot edit the name of the substance itself.

Remove - lets you remove selected rows from the part. If the selected row is a substance group, the system removes all substances under that substance group.

The system blocks any attempts to add the “Unreported (System)” substance.

**Homogeneous Material-Type Declarations: Homogeneous Material and IPC 1752-2 Declarations**

Add - lets you add a subpart or a material to the selected part. You can use search, or type in known subpart/material names directly; ”type-in names” is also the method to add a non-existing subpart/material. The system will prompt if you add a duplicate
subpart/material to the same part. In the Homogeneous Material type of declarations, you cannot add a substance or substance group directly to the part.

Add Sub-level - lets you add a substance to a selected SG, a substance or SG to a material, or a subpart or material to a subpart.

Edit - lets you edit all editable fields on selected rows. Note that you cannot edit the name of the substance itself.

Remove - lets you remove selected rows from the part. If the selected row is a parent (subpart or material or a substance group), the system removes the entire hierarchy under that parent.

The system blocks any attempts to add the "Unreported (System)" substance.

**Add/Update with Import**

In a declaration Substances table, while using the Add/Update mode, if there is an error in the data being imported, the system only deletes compositions that have issues. Successfully imported Substances are not deleted.
You can import compositions and substances directly into items and manufacturer parts without having to go through the RFI process (that is, data added via released declarations). For items, the import is Change Number-specific - associated with the Change Number of the part or document. Compositions are generally imported via: Item > Compliance tab > Declarations and Compositions table, or Manufacturer Part > Compliance tab > Declarations and Compositions table.

You need to gather compliance information for manufacturer parts; the data maybe in a spreadsheet or, it could be on the website of an information supplier or other third party.

Importing compositions and substances requires the ability to create aXML files. You must create aXML-format files with composition and composition substances, then use Agile Import to import the compositions and composition substances into the system.

---

**Note:** You can choose to attach the IPC XML file during import, for version 2.0 or prior.

---

New compositions created through External Rollup are marked as “External Compositions”. See Appendix C, “Reference Documentation for External Compliance Rollups” for details.

The following Agile documents (available on the Agile Documentation website) will guide you with Import/Export, so you can perform the necessary tasks for importing compositions to items or manufacturer parts:

- Using the Import and Export tools: Agile PLM Import & Export Guide

Substances are also imported into a declaration when it is submitted from a supplier using the Microsoft Excel-based Client, and when you publish the declaration, the substance is published to the item or manufacturer part.

---

**Note:** When importing a composition or multiple substances, if there is a problem with the composition or Bill of Substances, the entire composition is rejected. When importing multiple compositions, if there is a problem with one of the compositions, only that composition and corresponding BOS are rejected; the rest are accepted.

---

A field, Exclude from Compliance Check, is provided to exclude a composition from being rolled up. This can be set either on the declaration itself, or it can be “manually” set in the (import) XML file before it is imported to a part. See "Excluding Compositions from Rollups" on page 9-8. Do not confuse an "excluded composition"
with an "Inactivated composition"; the latter is described in "Archiving and Unarchiving Compositions in Items and Mfr. Parts" on page 4-4.

Change-based Revisions on the Item

These statements refer to two subclasses in the Changes base class: Engineering Change Orders (ECOs) and Manufacturer Change Orders (MCOs). An “ECO-based revision on the item” simply means the revision of the item was created by a change order being approved and released.

PG&C supports only ECO-based and MCO-based revisions on the item. For example:

- You can add specifications only on ECO- or MCO-based revisions of the item;
- You can import of compositions only on ECO- or MCO-based revisions of the item;
- When adding items to a declaration, only the Introductory rev or an ECO-/MCO-based revision of the item can be added;
  - Furthermore, when adding or importing an item without rev information, the latest ECO- or MCO-based change of the Latest Released rev of the item is added to the declaration;
  - Also, if the rev is provided, the Latest Released ECO- or MCO-based change of that rev of the item is added to the declaration.
- When creating a change on an item other than an ECO or MCO, the system does not copy over the specifications and active compositions from Latest Released rev;
- You cannot access Actions > Create Declaration from an item rev that was not created by an ECO or MCO.

Importing Compositions to Items

All necessary attributes in the Item > Composition and Item > Substances tables can be modified through Agile Import, not the user interface:

- Through Tools > Import;
- Only aXML format is supported for importing, not CSV, Excel, Template or PDX formats;
- The same aXML file can have multiple items and each item can have multiple compositions.

Change Number in an Item

Importing compositions to items is quite similar to importing composition to manufacturer parts. The only difference is that the item-import uses the internal Change Number, which is contained in the aXML file with the <Change Number> tag and is how the system recognizes the revision. The Change Number identifies the Pending, Previously Released, or Latest Released revs of the item. The revision number <ItemRev> tag in the Import file is ignored when importing compositions, specifications, and suppliers into items. If the change number is not given, the system uses the latest ECO- or MCO-based change on the Latest Released rev of the item.
**Note:** You must use “Introductory” when attempting to import compositions, suppliers and specifications into the Introductory rev of the item.

Also note that adding items to declaration does not work based on change number. (See "Importing and Exporting Declaration Data" on page 10-6.) Adding items to a declaration is still based on its revision, not on its change number. That implies when adding items into declaration, the Import file (in aXML) needs to have the `<ItemRev>` tag. Based on the revision number, the system determines the Latest Released ECO- or MCO-based change for that rev of the item and adds it to the declaration.

**Rules when Importing Compositions into Items**

The following rules apply to importing internal compositions to items. The Import module does not support import of external compositions.

You must specify the Change Number for the item in the Import source file. The Change Number is only in an MCO or ECO.

- If you do not have a `<ChangeNumber>` tag for the item in the source file, or leave the `<ChangeNumber>` tag blank, it will import to the Change Number of the Latest Released rev (again the Change Number can be an MCO number or an ECO number). If there is no Released change for this item, the composition is imported to the Introductory rev of the item.

- In the Import wizard, you are not allowed to select both BOM/AML/Attachment and Composition/Spec/ASL checkboxes.

- Import Preferences "Business Rule Options" should be set to "Authoring" when importing Composition/Spec/ASL to items.

- Import Preferences "Multi-Row Update Mode" (Add/Update or Complete Replace) is not applicable for importing compositions to items or mfr. parts.

- Change Number selected in Import Preferences does not affect importing Composition/Spec/ASL to items, since Import uses the Change Number specified in the source file.

- Change order selection on the Import wizard’s Mapping step has been removed for importing Composition/Spec/ASL to items, since Import uses the Change Number specified in the source file.

- The Add/Update mode is not valid when importing compositions and substances, but it is valid when importing specifications and ASL.

**Rules when Importing a Composition into Items or Manufacturer Parts**

If you import multiple compositions (with substances) for a single part in a single Import file, any error in one composition (or one of its substance) causes the rejection of that particular composition (and its substances); however, the system continues to import other compositions to that part.

If you import multiple compositions (with substances) for multiple parts in a single Import file, any error in one composition (or one of its substances) causes the rejection of that particular composition (and its substances); however, the system continues to import other compositions to that part (that did not receive the composition with the error) as well as the other parts.
The above-mentioned error could be any error - either an invalid substance or an invalid entry in one of the list fields - all of them are treated in the same manner.

**Notes and Special Cases of Importing Compositions**

A specification name in a composition is optional. If a specification is provided in the Import file, it is added to the manufacturer part’s Compliance tab > Specification table.

After importing a composition into an item or manufacturer part, the system sets the specification's Need Compliance Check field in the Specifications table to Yes. Also, when importing a composition with or without specification, Need Compliance Check on all the specifications on that item or manufacturer part is set to Yes.

If a manufacturer part is associated with a part group, you cannot import compositions into the manufacturer part. You would have to create a declaration for the part group and bring substances to the manufacturer part via a released declaration.

When importing compositions into an item or mfr. part, if you did not provide mass at the composition level, the system copies the mass information from PageOne to the composition, and then uses it for composition rollup.

When importing compositions into an item or mfr. part or when importing the BOS into a declaration, all types of errors are treated the same; previously the system continued to import partial data on certain types of import errors.

When importing compositions directly into a mfr. part, the system does not accept partial data. If there is any Type of error, the system rejects the composition along with the BOS.

When importing the BOS into a declaration for parts and part groups, where there is any Type of error, the system rejects the complete BOS for that part.

When importing compositions directly into an item or mfr. part, the Mass from PageOne is used if the Mass on the composition is blank. Moreover, the Mass from PageOne is copied to the composition if it was blank during import.

When importing compositions directly into an item or mfr. part., you cannot import a BOS with substances and substance groups that do not exist in the system.

Importing a composition directly into an item or mfr. part is considered equivalent to publishing the composition to the product record by releasing a completed declaration. Therefore, the system does not allow importing substances and substance groups that do not exist; first there must be substance correction (of name, or creating a new substance in the system) or substance aliasing. (The concept of invalid substances and substance groups is only supported in declaration.) When directly importing compositions into item or mfr. part and using a substance alias, the system automatically converts that alias to the corresponding substance / substance group name.

Importing substances and substance groups that do not exist in the system is allowed in the declaration; you must map these invalid substances and substance groups with an Alias to an existing substance or substance group or create a new substance or substance group, otherwise, the system will not allow you to release that declaration. In short, compositions with invalid substances cannot be published to the product record.

These ideas are stated somewhat differently in "Invalid Substances in the Declaration" on page 9-13.
Sources of Compositions

Since there are several sources of compositions, the item, manufacturer part, and part group’s Compliance tab > Compositions table has a field called Source, to identify the source. The table below lists sources of compositions and possible values for various fields of the Compositions table.

<table>
<thead>
<tr>
<th>Composition source</th>
<th>Value in Source field of Composition table</th>
<th>Value in Supplier field of Composition table</th>
<th>Value in Composition field of Composition table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publication of a declaration</td>
<td>String &quot;Declaration&quot; (class name in metadata)</td>
<td>Name of the supplier (link to supplier object)</td>
<td>Identifier of the declaration (link to declaration object)</td>
</tr>
<tr>
<td>Publication from a part group</td>
<td>String &quot;Part Group&quot; (class name in metadata) concatenated with identifier of the specific part group, for example, &quot;Part Group XYZ&quot;. This value does not change if name is changed.</td>
<td>Name of the supplier on the part group declaration (link to supplier object)</td>
<td>Identifier of the part group declaration (link to declaration object)</td>
</tr>
<tr>
<td>Revision change</td>
<td>String &quot;Rev&quot; concatenated with the identifier of the previous revision. Once the Source field is set, a change to the rev number does not change this value.</td>
<td>Name of the supplier on the declaration (link to supplier object)</td>
<td>Blank if the composition on the previous rev did not come from a declaration but, for example, from an import procedure.</td>
</tr>
<tr>
<td>Import of a composition</td>
<td>The value is set in the Import file, or is &quot;Import&quot; if the field is blank.</td>
<td>The value is set in the Import file or Blank (link to supplier object)</td>
<td>Blank</td>
</tr>
<tr>
<td>External Rollup</td>
<td>The value is &quot;Import&quot; or blank if no default setting by Admin.</td>
<td>Blank</td>
<td>Blank</td>
</tr>
</tbody>
</table>

Note: When you perform a Save As on a part or part group, the system copies the specifications, but not compositions.

Importing Specifications to Specific Revisions of Items

Agile PG&C supports the integrity of item revisions when importing (associating) a specification to the item.

- When you import a specification, supplier, or composition (with BOS), the import is based on the Change Number and it can be imported to any rev of the item when the Change Number is provided in the Import file.
- When you remove a spec from an item, it is only removed from the specific rev.
When the compliance manager publishes a declaration, the system not only copies the composition from the declaration to all associated items, it also takes the specs in the declaration and adds them to the Specifications table on the items; these specs are added only to the rev of the item that was named in the declaration.

**Summary of Importing a Specification to an Item**

To summarize system rules when importing a specification to a revision of an item:

- When you add a specification to a rev manually (through the object), that specification is specific to that rev. The specification is not be added to other revs (Previously Released or Preliminary or Pending). So, only that rev would be flagged as Need Rollup.

- When you create a new change (ECO or MCO), the system copies over the specifications from the previous rev to the new Pending rev. Note that the system copies over the specifications only when a new change order is created from a previous rev. If the change already exists and if a previously released rev gets a new specification, that spec is not copied to the next rev.

- When a declaration is published, the specification shall be published only to the rev that is associated with the specification in the item.

- When an item is added to a part group with specifications, the specs from the part group are copied only to the Latest Released rev and all Pending revs of the item.

**A Difference with Part Groups**

There is a difference in behavior between part groups and items: when you add an item to a part group, the system adds the specifications and active composition in the PG to all Pending revs and Latest Released rev of the item. In distinction, when you publish a declaration, PG&C publishes only to the rev of the item that was added; so, if you added Rev A of an item to a declaration and then released that rev, the spec and composition will only go to Rev. A. Even if you have created Revisions C, D, and E, the system does not copy composition to these revs.

The reason for this distinction is because the work objectives of Change Managers and Compliance Managers may differ. The Change Manager may continue to create new changes for revisions to parts; whereas, if the Compliance Manager gets Rev. A and sends it to an information supplier in a declaration, when it comes back from the supplier and is released, it makes sense that the composition only applies to Rev. A, because that is what the supplier declared to.

---

**Note:** when a declaration is released, the composition goes to the particular rev of the item that was added, whereas if you add an item to a part group, at that time the system copies the compositions and the spec from the PG into all Pending and Latest Released revs of the item. This behavior applies to part groups but not items or manufacturer parts.

**Importing and Exporting Declaration Data**

Generally, exporting and importing data from declarations is handled by process extensions (non-Events-based), which appear in the Actions drop-down menus.
Declarations Actions (Process Extensions)

Assuming the administrator has assigned out-of-box process extensions (non-Events-based) to PG&C declarations, they contain these class-specific actions:

<table>
<thead>
<tr>
<th>Additional Process Extensions</th>
<th>Found in objects from these classes:</th>
<th>Result of this action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Excel &gt; Download Template</td>
<td>All Declarations except Supplier Declarations of Conformance</td>
<td>Download Template - This action downloads an MS-Excel file with the declaration’s attributes, which can be saved and populated with substances information and data</td>
</tr>
<tr>
<td>Microsoft Excel &gt; Import from Excel</td>
<td>JGPSSI Declarations class</td>
<td>Import from Excel - This action imports substances information contained in the Excel spreadsheet into the declaration</td>
</tr>
<tr>
<td>Export AXML</td>
<td>Homogeneous Materials Declarations class</td>
<td>Export AXML - &quot;AXML&quot; is Agile XML, an XML representation of Agile’s business schema that contains all product content managed in Agile. You or a supplier use it to export the declaration information in aXML format. The declaration can be completed and re-imported into PLM.</td>
</tr>
<tr>
<td>Import AXML</td>
<td>Part Declarations class</td>
<td>Import AXML - A declaration that was exported using the aXML format and then completed can be imported back into PLM using this action.</td>
</tr>
<tr>
<td>Import IPC 2.0 XML</td>
<td>IPC 1751A Declarations class</td>
<td>Import IPC 2.0 XML - Imports XML data that is used to complete IPC Version 2.0 forms</td>
</tr>
<tr>
<td>Export IPC 2.0 XML</td>
<td>IPC 1751-1 Declarations class</td>
<td>Export IPC 2.0 XML - Exports XML data that is used to complete IPC Version 2.0 forms</td>
</tr>
<tr>
<td>Import IPC XML</td>
<td>IPC 1752-2 Declarations class</td>
<td>Import IPC XML - Imports XML data that is used to complete IPC forms for versions prior to 2.0</td>
</tr>
<tr>
<td>Export IPC XML</td>
<td></td>
<td>Export IPC XML - Exports XML data that is used to complete IPC forms for versions prior to 2.0</td>
</tr>
</tbody>
</table>

**Note:** Files older than two days (48 hours) are purged from the directory (the AgileEITemp folder on the server) every time these Actions are executed: Import AXML, Import JGPSSI, Import IPC XML, Import IPC 2.0 XML; this is not configurable.

**Importing Substances to a Declaration with MS-Excel**

When your company seeks compliance information about Parts/Part Groups by sending a declaration to a supplier, it may not be convenient for the supplier firm to compile that information directly into the declaration.

One option that is available to the Supplier is to export and import files in a format called aXML. See "Importing and Exporting Declaration Data" on page 10-6.

A simpler solution is available in which compliance information that is sought by a Declaration can be collected in a Microsoft Excel spreadsheet, then imported into the Declaration. In this procedure, an Excel template is produced by PG&C.
**Downloading the MS-Excel Template**

You create a declaration and add a specification to it. Parts or Manufacturer Parts or Part Groups are added to the declaration, whose objective is for any substances of concern that are contained in these parts to be declared.

For this compliance information, this declaration may be sent to a supplier, or it may be completed internally by a compliance manager.

To download the MS-Excel template:

1. In the declaration, click the Actions drop-down menu, select Microsoft Excel, then select Download Template.
2. PG&C automatically exports the declaration’s attribute information to the Excel spreadsheet. The File Download dialog prompts you to Open or Save the file.
3. To save the file, browse to a location on your hard drive. You can accept a system-generated filename or enter a new filename.
4. Close the Get File dialog, which conducted the export of the spreadsheet file.

For the importing process, see "Importing Substances to the Declaration" on page 10-9.

**Adding Substances to the Spreadsheet**

Assuming you have downloaded and saved the MS-Excel spreadsheet. You now need to add substances to it.

To add substances to the spreadsheet:

1. The Excel spreadsheet must be populated with data about the substances being declared for the parts named on the declaration.
2. These are key fields that must be populated.

---

**Important:** The column headings must appear exactly as below. Two columns, Parts.Rev/Mfr and Parts.Specification, must appear even if they are not populated.

- **CoverPage.Name**
- **CoverPage.Declaration Type**
- **CoverPage.Supplier** - note that the Supplier name must be typed exactly as it appears in PG&C
- **Level** - this number reflects the level in the Bill of Substances for the substance in this row.

**Note:** Use the numerical sequence 0, 1, 2, 3 (not 1, 2, 3, 4). The objects are in plural form, and "Homogeneous Materials" are called "Materials" in the spreadsheet.

- 0 = Subparts
- 1 = Materials
- 2 = Substance Groups
- 3 = Substances
• Parts.Part Type - this and the next several fields could be for a Manufacturer Part or Part Group
• Parts.Number
• Parts.Rev/Mfr - this column must be in the Excel file, even if there is no value in any of this column's rows
• Parts.Specification - this column must be in the Excel file, even if there is no value in any of this column's rows
• Substances.Substance
• Substances.Mass
• Substances.Mass-Measure
• Substances.Substance Type - the Substance Type names must be plural, as shown in "Level", above

3. When you have completed populating the fields, save the spreadsheet file.

**Importing Substances to the Declaration**

Begin on the Cover Page of the declaration.

This part of the process may be completed by the supplier; or, the supplier may have populated the Excel spreadsheet and sent it to the compliance manager, who can complete the process, as follows.

To import substances from the spreadsheet:

1. In the declaration, click the Actions drop-down menu, select Microsoft Excel, then select Import from Excel.
2. Agile Import is opened. In the Import dialog, next to the Import File field, click the Browse button.
3. In the Choose File dialog, select the Excel file that has been prepared with Substances data in the previous topic, and click Open.
4. In the Import dialog, click Import.

**Note:** The Import process takes several minutes to complete. You will know it has completed when the Close button appears.

5. Before closing the dialog, verify that the Import process has imported the Parts/PGs and the Bill of Substances, which are viewed in the ACCEPTED column.
6. In the declaration, click the Items, Manufacturer Parts, or Part Groups tab as appropriate. The Substances table (below the list of the parts) lists the substances that have been declared for each part/PG.

This completes the procedure for importing substances into a declaration with MS-Excel.

**Notes on Excel-based Declaration Submissions**

When the supplier has used the Microsoft Excel-based Client to submit the declaration, it is possible that data may not be successfully imported to the buyer side. There are two stages in which their data is processed. The data is uploaded to the server; upon successful upload, the supplier receives the message that "Your data has
been submitted for processing.” The data is then be processed on the server and imported into the system.

If there was a problem with the upload, the supplier is notified immediately; but if the problem occurs at processing or importing on the server side, the system sends an email with the error log as an attachment to the supplier. This means that the declaration remains in Open to Supplier status, and this does not change until the supplier reviews the log in the email notification, makes appropriate changes, and re-submits.

Even if the import on the server side is successful, depending on the size of the declaration, it will take some time for the declaration to move from Open to Supplier to Submitted to Compliance Manager. So if the user checked the declaration immediately after submitting from Excel, they may not see the changes for awhile.

These "under the hood” behaviors are detailed so that you can instruct your suppliers.

**Import and Export IPC 2.0 MDOs**

This task outlines how you could send an IPC 1752A declaration that you have created in Agile, while the supplier completes the declaration. IPC 1752A declarations support version 2.0 of IPC, which encompasses REACH compliance.

---

**Note:** IPC version 2.0 does not support the use of PDF forms. Rather the electronic signature resides within the XML data. For instructions on using import and export for IPC 1752-1 and IPC 1752-2 declarations, see “Importing and Exporting IPC Declarations” on page 10-11.

---

A user must be assigned the Import and Export privileges to complete IPC declarations. If you think your privileges do not include these, see your Agile Administrator.

A typical RFI sequence with an IPC 1752A declaration:

1. Verify with your administrator that the Import IPC 2.0 XML and Export IPC 2.0 XML Process Extensions are enabled and have a live URL.

2. Create an IPC-class declaration in Agile PLM - IPC 1752-1 Declaration class.

3. Select IPC1752A as the Declaration Type.

4. The default workflow for the declaration is moved to the Open to Supplier status.

5. The declaration recipient for the information supplier opens Web Client (Basic) and sees the declaration. The supplier could simply open the declaration in Agile and select Export IPC 2.0 XML. Your administrator’s setup of PG&C also presents an alternative, via the process extension Export IPC 2.0 XML; this appears as a link in the declaration row that the supplier can click directly; or, if the supplier clicks the declaration name, all the process extensions are displayed as links on the left navigation pane of Web Client (Basic mode). An XML file is saved.

6. The supplier user saves the XML file on the machine, then opens the XML file.

7. The declaration recipient enters or modifies values in the declaration.

8. When completed, the data is exported using Export IPC 2.0 XML. The existing XML file is overwritten.
9. The supplier returns to Web Client and uses the Import IPC 2.0 XML process extension to import the modified XML data. Then he submits the declaration to the buyer firm.

10. At the buyer site, you can open the completed declaration in Agile to review for possible release.

Note: For the out-of-the-box IPC integration (which supports only one part / one spec per declaration): Regardless of the type of part (item, manufacturer part, or part group) used in the declaration, Export IPC 2.0 XML exports the value to the Item Number field in the IPC declaration. If you want to change this behavior, please work with your Agile Solution Delivery representative. If your company is creating declarations for only manufacturer parts, we recommend the Items and Part Groups tabs in the IPC declarations be hidden (that is, the Agile administrator sets the Visible property of those tabs to No). This makes it easier for suppliers to be clear on the fields they need to complete.

Important: This sequence is an outline. Agile PLM Import & Export Guide fully documents the use of the Import/Export tool.

Importing and Exporting IPC Declarations

This task outlines how you could send an IPC 1752-1 or IPC 1752-2 declaration that you have created in Agile, while the supplier completes the declaration working in the IPC PDF format.

Note: IPC version 2.0 does not support the use of PDF forms, so when using the Import IPC 2.0 XML and Export IPC 2.0 XML options, you will not be prompted to attach a PDF. See the previous section for instructions on using these options.

Importing and Exporting IPC Declaration Data
process extensions are displayed as links on the left navigation pane of Web Client (Basic mode). An XML file is saved.

6. The IPC form is found on the machine - the supplier user will have IPC PDF forms downloaded from IPC web site (www.ipc.org/IPC-175x) - in an IPC folder. The supplier user opens the form in Adobe Acrobat and clicks Import Data (or File > Form Data > Import Data to Form), then specifies the location of the XML file. The XML data is imported to the PDF form.

7. The declaration recipient enters or modifies values in the declaration.

8. When completed, the data is exported using Export Data (or File > Form Data > Export Data from Form). The existing XML file is overwritten.

9. The supplier returns to Web Client and uses the Import IPC XML process extension to import the modified XML data. Then he submits the declaration to the buyer firm.

10. At the buyer site, you can open the completed declaration in Agile to review for possible release.

---

**Note:** For the out-of-the-box IPC integration (which supports only one part / one spec per declaration): Regardless of what type of part (item, manufacturer part, or part group) is used in the declaration, Export IPC XML exports the value to the Item Number field in the IPC form (PDF). If you want to change this behavior, please work with your Agile Solution Delivery representative. If your company is creating declarations for only manufacturer parts, we recommend the Items and Part Groups tabs in the IPC declarations be hidden (that is, the Agile administrator sets the Visible property of those tabs to No). This makes it easier for suppliers to be clear on the fields they need to complete.

---

**Note:** This sequence is an outline. Agile PLM Import & Export Guide fully documents the use of the Import/Export tool.

---

**Transformation Files for Importing Compositions**

When compliance information is gathered for parts using the pre version 2.0 IPC forms (in PDF) or JGPSSI forms (in Excel) from a supplier, the same IPC or JGPSSI form may be sent to multiple customers of the supplier. Your company may not have the right names, as defined by your supplier; or, a manufacturer’s name may not match what is defined in PG&C.

Transformation files resolve this problem when importing compositions via IPC declarations or JGPSSI declarations.

A transformation template can be downloaded and modified to match the import. Supported operations are "REPLACE", "PREFIX", OR "SUFFIX". Support is also provided for regular expressions, such as ".", "*", "+", and "?".

---

**Item Number when Importing into Declaration**

PG&C supports users being able to select different revisions of an item into a declaration. The property Item Number is now "change-controlled", that is, it may become a different value by a change order.
When importing an item into a declaration, if the user wants the item at, say, Rev. B where the Item Number is "123", but in Rev. C the Item Number has changed to "987", the user must manually change the value of Item Number in Rev. B to "987". If this is not done, the system cannot find the matched item.

To import Item and Substance Group into IPC declarations, you must ensure that Item Number matches in two places:
  - Item Number on the Items table, and
  - Item Number on the Item Composition table.

**Correcting Invalid Substances**

Click the Verify Substances global action under Declarations to verify the invalid substance, check the pop-up user interface, including columns, and icons.

Or, verify substance by clicking Search icon, Create icon, or the drop-down list of matching substances/groups with exact CAS number.

For more information, see "Invalid Substances in the Declaration" on page 9-13, "Correcting Substances in Declarations" on page 9-14, and "Unreported Substances in Partially disclosed Compositions" on page A-16.
Rolling Up Compliance Data Using Internal Rollup

When compliance data has been gathered for items, manufacturer parts, and part groups, the compliance manager reviews the completed declarations; he needs a way to determine if they are ready for publication into the product record. And, after declarations are published, with their data written through to parts and part groups on BOMs, compliance managers need to examine and test BOMs to ensure that the assemblies and products are compliant. This general process is called compliance validation, and the mechanics of compliance validation are fulfilled through compliance rollups.

Rollups are built into the system, and they are a powerful feature of the PG&C solution. These built in rollups are referred to as “Internal Rollups,” and this chapter details their use.

Rollups are easy to execute and rollup results are seen in the user interface. The business logic of rollups that is programmed “under the hood” is extensive; details of the logic and some use cases are found in “System Logic of BOM/Compliance Rollups” on page B-4.

Current rollup information is always available from the BOM Compliance report. For details about setting up this report, see “BOM Compliance Report” on page 15-9.

---

**Note:** As part of REACH compliance, external rollups now occur via the external rollup engine. The external rollup engine is a PL/SQL script shipped with Agile schema; customer can follow the data schema and modify this with their own rollup logic. Specific logic involved with external rollups can be found in Appendix C, "Reference Documentation for External Compliance Rollups." External compositions will not be involved in internal rollup.

---

**Defining Approach to Compliance Management**

Compliance rollups can be managed by logic built into the Agile PG&C application; we use the shorthand "internal engine" for this approach to compliance management. The internal engine determines compliance at the lowest level within the top level object (part or top level assembly) such that it compares the amount of a substance within each sub-object (part or subpart) against the weight/mass of that sub-object. The rollup is then the worst case scenario of the compliance statuses of the individual sub-objects.
Examples:

- Compliance status of subparts rolls up to set compliance of a part.
- Compliance status of parts rolls up to set compliance of top level assembly.

Alternatively, compliance rollups can be managed by customer-originating systems; we use the shorthand "external engine" for this approach to compliance management. The external engine determines compliance for the top level object (part or top level assembly) such that it rolls up the amount of a substance from all of the sub-objects in the top level object and compares it to the weight/mass of that entire top level object.

Examples:

- Compliance status of a part is the total weight/mass of a substance in all the subparts compared to the weight/mass of the part.
- Compliance status of a top level assembly is the total weight/mass of a substance in all the BOM parts compared to the weight/mass of the top level assembly.

Use Cases

The term "compliance rollup" can be used in a general sense to refer to compliance validation, but Agile PG&C offers several specific rollups named by their use cases: the BOS or Composition rollup, the BOM or Compliance rollup, and the Substances and Weights rollup:

- **BOS or Composition rollup** - Produces the compliance of a composition against a given specification on a declaration. BOS rollups occur automatically when the declaration workflow's status changes, except when moving from Pending to a non-Released status. Also, when a composition is imported into an item or manufacturer part, a rollup is triggered.

- **BOM or Compliance rollup** - Produces the compliance of a part or part group or assembly against a given specification. BOM rollups can be enacted at any time via manual rollups; the information is also refreshed throughout the system via scheduled rollups set by the administrator. (Settings in Administrator also govern the overall strictness of BOM rollups.)

BOM rollups are discussed in "BOM Compliance Report" on page 15-9.

**Declaration Classes in Rollups**

Let us review the Declarations classes from the point of view of compliance rollups. Remember that a rollup is possible only when a specification is associated in a declaration; compliance states are always calculated in the context of a specification; so we say "rollups are by spec."

<table>
<thead>
<tr>
<th>Declaration class</th>
<th>Kind of specification</th>
<th>Kind of substance held</th>
<th>Kind of composition produced by declaration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Declarations</td>
<td>Any</td>
<td>N/A</td>
<td>Part composition</td>
</tr>
<tr>
<td>Substance Declarations</td>
<td>Part-level specifications</td>
<td>Substance groups and substances</td>
<td>Substance composition</td>
</tr>
<tr>
<td>JGPSSI Declarations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPC 1752-1 Declarations*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**When and Why Rollups are Run**

You can start Rollups automatically or manually. Automatic rollups (internal and external) are scheduled by settings by the administrator, apply to all parts and part groups that qualify, and they are triggered to start per the information in the scheduler. Manual rollups are started by a user within a single declaration or part.

<table>
<thead>
<tr>
<th>Use case</th>
<th>How rollup is started</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOM/Compliance rollups</td>
<td>Automatically</td>
<td>Per the schedule set by the administrator.</td>
</tr>
<tr>
<td></td>
<td>Manually</td>
<td>In parts and part groups on the Compliance tab, Calculate Compliance button is enabled when compliance data is present (assuming the corresponding Specifications table is not empty).</td>
</tr>
<tr>
<td>BOS/Composition rollups</td>
<td>Automatically</td>
<td>Within declarations whenever the declaration changes status (except from Pending to non-Released status). Also, at the end of importing compositions into items or manufacturer parts, system starts the rollup.</td>
</tr>
<tr>
<td></td>
<td>Manually</td>
<td>Declaration’s Actions menu includes Calculate Compliance.</td>
</tr>
</tbody>
</table>

Scheduled rollups (internal and external) are important because of the possibility of changes to compliance objects by other actions and events across the product record.

For example, the system does not flag an assembly with the Need Rollup flag every time there is a Product Collaboration-related changes (such as adding a new item or manufacturer part to the BOM, removing an item or manufacturer part from the BOM, and so forth): this is really not feasible as that would force the system - every time the slightest change took place in the product record - to find all TLAs and set Need Rollup to Yes, even if the change was not compliance-related.

It is far more efficient to have the Scheduled Rollups regularly refreshing compliance states on assemblies that are marked (as Shippable Items) to account for pertinent, compliance-specific changes to the products. In summary, regardless of *any* changes to parts and assemblies, the system goes ahead and calculates compliance based on administrator-set Compliance Rollup Scheduling rules.

---

* You can now select 1752A as a type of IPC-1752-1 class when you create a new declaration. 1752A represents IPC version 2.0, delivering REACH compliance.

---

<table>
<thead>
<tr>
<th>Declaration class</th>
<th>Kind of specification</th>
<th>Kind of substance held</th>
<th>Kind of composition produced by declaration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homogeneous Material Declarations</td>
<td>Homogeneous-material-level specifications</td>
<td>Subparts, materials, substance groups, and substances</td>
<td>Homogeneous material composition</td>
</tr>
<tr>
<td>IPC 1752-2 Declarations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplier Declarations of Conformance</td>
<td>Because SDocS do not hold parts or substances, no rollups are necessary.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Parts Qualifying for Scheduled Compliance Rollups

For scheduled rollups, there are several factors that “qualify” parts and part groups to be rolled up, that is, examined by the system for compliance. This can be thought of as occurring in two stages:

Stage 1 - Perform Compliance Rollup on Shippable Items:

All parts with Shippable Item flag set to Yes - this includes top-level assemblies (TLA), subassemblies, and leaf items (the last part of a branch in the BOM). Although we recommend setting the TLA for the assemblies, it is possible to set it at the level of subassemblies or leaf items. The rollup is performed on the Latest Released revision and all Pending revs of the shippable items. If it is a TLA, the system performs the rollup for the entire BOM for the specifications in the TLA; if it is a subassembly, the system performs the rollup for the entire BOM for the specifications in the subassembly.

Note: The specification(s) on any Shippable Item is propagated (added) to all parts that belong to the Shippable Item, if the specs are not already associated with those parts. (This applies to manual rollups: when you click the Calculate Compliance button, a part or assembly, the system propagates the specs on that part or assembly to all parts/mfr.parts that belong to that assembly, if they are not there already.)

All Pending revisions of all Shippable Items. Note that the system does not perform rollups on previously released revisions of Shippable Items.

Stage 2 - Perform Compliance Rollup on Parts/PGs that are Flagged

Regardless of the setting of Shippable Item or the status of a revision, the system looks for all “flagged” parts/part groups, that is, those parts/part groups (with associated specifications) whose Need Compliance Check attribute has changed from No to Yes (on <part/PG> Compliance tab Specifications table). When Need Compliance Check field changes to Yes, the system is indicating that it is advisable to perform a rollup on that part.

Note: On items (Specifications table), the Need Compliance Check attribute is not visible.

Several events cause Need Compliance Check to switch from No (meaning nothing has changed since the part was rolled up, it is still "up-to-date") to Yes (meaning something changed and the part is no longer "up-to-date"):  
- A new specification is added to an item, manufacturer part, or part group  
- A specification’s declared compliance is changed on an item, manufacturer part, or part group  
- A declaration/composition is released for an item or manufacturer part  
- A declaration/composition is released for a part group that is associated with items or manufacturer parts  
- A composition is manually imported to a manufacturer part
- A composition is archived (from an item, manufacturer part, or part group)
- An item or manufacturer part is associated to a part group that has a new specification (that is, not already on the item or manufacturer part).

**Expected Time Required to Complete Systemwide Rollup**

How long the systemwide (automatic) rollup task takes depends on the number PLM objects described by “Stage 1” and “Stage 2” above. If the number of shippable items is relatively stable from day to day (or other chosen period), the time required by the system to perform Stage 1 will be the same. A large volume of parts, say, numbering in the tens-of-thousands, leads to a greater volume of shippable items, causing Stage 1 to consistently run "long."

For a company's first run of the rollup task, Stage 2 might be expected to encounter many flagged parts in the system; for a large number of parts, Stage 2 might take a significant amount of time. On the other hand, from the second run going forward, many of those parts are now "cleaned up" - the factors listed above will not change from day to day for the bulk of parts - and do not require processing time in the system. With fewer changed parts in the system, Stage 2 is likely to run faster each time. This may or may not make a noticeable difference in time, again depending on the overall volume of compliance-specific objects in the system.

There are many events that change the database information about parts and manufacturer parts (through work in other Agile solutions such as Product Collaboration) that may impact the compliance result of the part, even though these events are not PG&C-specific (and do not change the Need Compliance Check flag). A partial list of such events include:

- Adding a part or manufacturer part to OR removing it from an item (manually or through an ECO/MCO)
- Adding an item to OR removing it from an assembly (manually or through an ECO)
- Creating a new revision of an Item
- BOM resolution change-based on pending revisions.

**When Rollup was Last Run**

After any kind of rollup (that includes a part) is run, a "stamp" at the top of the part that says, Compliance Last Calculated Today or Compliance Last Calculated Yesterday. To know the time of the part’s most recent rollup, go to its Cover Page, see the Compliance Calculated Date attribute.

**Tracking Compliance Changes through History**

When Result Compliance of a part is changed by a scheduled rollup, or is changed by Calculate Compliance, a new entry is added to the History of that part (which tracks the Date and Time when the compliance of a part was modified or changed).

For a part or part group, the system tracks the compliance change per each specification that is assigned to the part (not just for the Overall Compliance, which is for all specifications on that part).

The tracked data is found in the Details column on a part’s History tab.
Compliance States

There are six default compliance states on parts and part groups. Compliance rollups use compliance states of compositions stored on parts/part groups to calculate the compliance state of larger assemblies.

---

Note: The administrator can change the names of compliance states to fit the requirements of your company. However, because compliance states do not change their essential meaning, the new names should be readily associated with the default names listed below. Compliance states cannot be added or removed.

Agile PG&C defaults to the reporting of “worst-case” scenarios.

Worst-Case Priority of Compliance States

The priority of the compliance states when the system is set to a "worst-case" bias is:

1. Non-Compliant - this state takes highest priority in the worst-case bias
2. Missing Info - the state of “missing information” takes the second highest priority
3. Waived - the third highest priority state informs that a “waiver is in place”
4. Exempt - this is the lowest of the four non-compliant states; however, Exempt may be set so it is considered compliant: see "Treat Exempt as Compliant in BOM Rollup Rule" on page 11-7.
5. Compliant - this state indicates that the part/PG is in compliance with the specification.
6. Not Applicable - this indicates that the part/PG does not need to be evaluated by the system for compliance, and will not adversely affect the compliance of the assembly. In worst-case scenarios, Not Applicable is the lowest-priority “compliance state”.

---

Note: There is another “set” of compliance states in declarations, which information suppliers use through change orders: they can declare Compliant or Non-compliant, or they can declare Exempt if exemptions are available, that is, if the specification has any listed exemptions.

---

How Compliance States are Ranked

The rule that governs the priorities of compliance states is this:

From any level in a BOS or BOM, the calculated compliance state of any higher level cannot be lower than the calculated compliance state of the current level.

So, if “level 7” of the BOM has a result compliance of Missing Info, none of the higher levels (top level of BOM, or level 1 through level 6) can be any worse than Missing Info; this makes sense, because level 7 has already taken all of the lower levels (level 8 through end of BOM) into account.
This means that if a part or assembly shows a Compliant state (5 in the list), you can conclude none of the part’s subassemblies have any of the non-compliant states (1-4) blocking the part from being in compliance.

That is the strength of the worst-case bias, that although you are always seeing the "bad news" about the compliance state of a BOM or BOS, the more you drill down and resolve problems, and the lower levels achieve the Compliant state, the "good news" begins to move up the BOM/BOS until an entire assembly can demonstrate integrated compliance up and down the bill of materials or bill of substances.

**Treat Exempt as Compliant in BOM Rollup Rule**

The administrator has an optional setting that permits BOM rollups to "overlook" the presence of Exempt states in arriving at the final compliance state of the top-level assembly in the Bill of Materials. Because Exempt is one of the 'non-compliant' compliance states, a part that is declared Exempt can render the entire assembly Exempt. By setting this rule to Yes, once a part is Exempt, the rule prevents "Exempt" from rolling all the way to the top of the assembly.

Of course, other parts in the assembly may have more serious non-compliance problems, so this setting does not bypass those states being rolled up.

Also note that the ability of the administrator to change the names of default compliance states makes it possible to change Compliant to, for example, "Compliant with possible Exemption."

The rest of this chapter examines the three kinds of rollup in PG&C.

**Composition Rollup on Bill Of Substances**

The top level of a Bill of Substances is the composition, or aggregate of part+rev for a given supplier for a named specification. The terms “BOS rollup” and “composition rollup” refer to the same process. Compositions are gathered or collected by declarations, or by direct import into manufacturer parts.

**Kinds of Composition**

- Pending Composition - a composition on an unreleased declaration
- Active Composition - a composition on a released declaration, or which you have manually imported to the part
- Inactive or Historical Composition - the old composition when it has been updated by a new declaration, or by a newly imported composition directly to the part.

**BOS Hierarchy**

Remember that the hierarchy of the Bill of Substances is:

- First or top level: Composition of a part or assembly
- Second level: Subpart (note that a subpart may have child subparts)
- Third level: Material (homogeneous material)
- Fourth level: Substance Group
- Fifth level: Substance
Most Bills Of Substances are subset of these levels, for example, you may simply have a part with a few regulated substances. The hierarchy is important for understanding how the system structures its BOS analyses.

**Compliance Validation for BOS Tree**

We speak of part-level validation and homogeneous material-level validation, based on the setting of Validation Type field on the General Info tab of the associated specification (see "General Info Tab" on page 7-2.). These are the varieties of BOS rollups, from “lowest” to “highest”:

- Substance to substance group
- Substance or substance group to material, subpart, or part
- Material to subpart or part
- Subpart to part
- At Part level

**When Composition Rollups Occur**

Validations within a declaration is the process of calculating compliance of the Bill of Substances within a composition and assigning a compliance state to the composition based on this analysis. This ensures that all contained data is kept up to date during the course of the RFI process.

Composition rollups can occur in the following ways:

1. Within a declaration, a BOS rollup takes place automatically every time the declaration workflow advances one status, except from Pending to a non-Released status; so, change from Pending to Released, and all other advances from non-Pending status to another triggers the composition rollup.
2. In a declaration, when you manually click Actions > Calculate Compliance.
3. When you complete importing a composition to an item or manufacturer part, a BOS rollup is automatically triggered.

**Two-Step Sequence in Rollups**

Rollups have a two-step sequence, depending on the presence of specifications in the declaration.

The first step is: when a declaration changes status, or at the end of direct import of compositions into an item or mfr. part, the system calculates the PPM for all substances regardless of whether any specification is present. Also, the Mass Disclosure type is identified. If the composition is identified as Partially Disclosed, the system adds the “Unreported (System)” substance wherever necessary in the BOS tree.

The second step is if there is a specification in the composition, the system proceeds to the second part of the rollup, where it evaluates and updates the calculated compliance at each level. For more details about the logic that the system follows for different types of substances, see "System Logic of BOS/Composition Rollups" on page B-2.

**How Disclosure Logic affects Rollups**

"Disclosure logic” lets the system make the following distinctions:
On Substance Compositions, if the sum of the substances’ masses add up to the part’s mass (that is, it is Fully Disclosed), even if the substances in the specification are missing in the composition, those system considers those substances Compliant for that composition.

If the composition is Partially Disclosed, the system tries to assess compliance of all the missing substances against the Unreported substance, and the worst case is used for the rollup.

If there is an Unreported substance, the result can be either Compliant or Missing Info.

On Homogeneous Material Compositions, the same logic is used to calculate the compliance of a parent of the substance (material or subpart) for Fully Disclosed compositions only.

As soon as the system identifies the composition as Partially Disclosed, it follows the established rules for rollup.

If there is an Unreported substance in the composition, the system tries to assess compliance of all the missing substances against the Unreported substance, and the worst case is used for the rollup.

Note that when an Unreported substance is present, the Declared Compliance, Calculated Compliance, or Result Compliance fields are not used. You can manually calculate the values and make sure that the system is doing the rollup against Unreported substance appropriately.

**Disclosure Logic Use Case**

When you add an Unreported substance to the specification, if the Unreported substance exists in the spec, the system also calculates its compliance (similarly to regular substances in the spec). The Calculated Compliance of the Unreported substance is the worst case.

This spec lists three substances:

Spec1:
- Sub01 500 PPM
- Sub02 2000 PPM
- Unreported (System) 1000 PPM

If the system adds an Unreported substance to the composition, with Sub01 and Sub02 already present, the system calculates the Unreported substance’s compliance as if it were a regular substance.

However, if the system adds an Unreported substance to the composition, and one of the substances - Sub01 - in the specification is not present in the composition, the system compares the Calculated PPM of the Unreported substance with the Threshold PPM of Sub01, the missing substance, and its own Threshold PPM, and picks the worse case as the result.

In this example, if the Calculated PPM of the Unreported substance is less than or equal to 500 PPM, the Unreported substance is Compliant. If it is 900 PPM, comparing with the Threshold PPM of Sub01, it is Non-compliant; while comparing with its own Threshold PPM, the Unreported substance is Compliant; so, the Calculated Compliance of the Unreported substance is the worst case, Non-compliant.
Substance Declarations and Need Rollup Flag
A known issue has been fixed: a BOS rollup on a Substance Declaration would not occur if changing status directly from Pending to Released. However, there is still an issue where the declaration changes status (which causes a rollup to be run automatically) but the Need Rollup flag seems to remain “Yes.” What is really taking place is that, after the workflow changes status, the system is pre-populating the substances from the specs.

This issue is seen if all of the following are true:
■ The declaration is a Substance Declaration;
■ The declaration has one or more specifications;
■ The status is changed from Pending to Released (or Implemented) directly.

The workaround is simply to roll up the declaration once more, manually.

Compliance Rollup on BOM/Items, Mfr.Parts, and Part Groups
Once the compliance at the composition level is known, the compliance within a part or manufacturer part on a BOM can be calculated. We know that a composition has a declared and a calculated compliance. With these settings, the compliance rollup can calculate the compliance within a part or part group. The terms "BOM rollup" and "compliance rollup" refer to the same process.

The cases to consider are subunits of the BOM rollup:
■ Part-level Compliance validation: Composition level to its parent (part or part group).
This is governed by the setting in Administrator for "Composition Rollup" set to Strict (default) or Relaxed.
■ AML Compliance validation: AML to IPN (manufacturer parts to parts).
This is governed by the setting in Administrator for "AML Rollup" set to Strict (default) or Relaxed.
■ Item to Assembly-level validation
This is governed by the Administrator setting for "Treat Exempt as Compliant in BOM Rollup Rule" on page 11-7.

Some Rollup Fields
Many fields used to interpret compliance rollups are defined in "Tabs and Attributes in Parts and Part Groups” on page 8-2. The fields below are presented here as a reminder.
■ Overall Compliance/Summary Compliance - indicates the compliance state of the part using the worst-case scenario and matched across all specifications associated with the part. This attribute is found on these objects:
   ■ Items > Title Block tab > Overall Compliance
   ■ Manufacturer Parts and Part Groups > General Info tab > Overall Compliance
On Items, Overall Compliance is revision-controlled, that is, specific to the Item’s rev.

Note: The Overall Compliance attribute also reads through to the objects below, although in these cases it is named “Summary Compliance”:
Items base class (Parts and Documents) > BOM tab and Manufacturers tab > Summary Compliance

Changes base class (ECOs, MCOs, etc.) > Affected Items tab > Summary Compliance

On items, Summary Compliance is always derived from the Latest Released Rev of the item; if there is no released rev, it is from the Introductory rev.

On parts and part groups, the Overall Compliance field is the worst-case compliance of all associated specifications. For example, if there are five specifications and four of them are compliant but one of them is not compliant on the part’s Specifications table, then the overall compliance is Not Compliant.

- Shippable Item - On items only, when the Shippable Item field is Yes, a flag is set that the system recognizes that a top-level assembly is ready for market and will be included in any scheduled rollup. During scheduled rollups, the system first looks for Shippable Items, on the second round it looks for all parts/part groups with one or more specifications that the Need Compliance Check field is Yes.

- Exclude From Rollup - On the other hand, when the Exclude From Rollup field is Yes, it sets a flag that prevents the system from considering the compliance of the item (which it determines anyway) when determining the compliance of its parent. The default for the Documents class objects is Yes. The default for the Parts class objects is No, but of course it can be set to Yes for any part of an assembly whose compliance state does not concern you. Again, this attribute applies only to items, that is, parts and documents.

Note: Exclude From Rollup flag on item is supported by Compliance Rollup as well as Substances and Weights Rollup features.

BOM Rollup Evaluating Compliance States

For parts, part groups, or assemblies, the Composition Rollup rule and AML Rollup rule (set in Administrator) are generally set to Strict, which gives your BOM rollup results the ‘worst-case’ orientation. The setting of the rollup rule “Treat Exempt as Compliant” adds its influence to BOM rollup results. The effects of these rules are noted below.

If you detect your compliance rollups yielding unexpected (or undesired) results, see your administrator about the systemwide settings of the compliance rules.

Here is a general case with emphasis on the two ‘strict/relaxed’ rules: let there be an assembly that has multiple subassemblies. One subassembly has a compliance state of Exempt; another subassembly has a compliance state of Missing Info; all the other subassemblies are in the Compliant state. Can you predict the resulting compliance state of the entire assembly?

If you refer to the list of compliance states, you see that the subassemblies that are Compliant will at some point contribute to the overall compliance of the assembly, but right now they are not going to “win” or influence anything. The Exempt subassembly is weighted, but the Missing Info subassembly is more weighted. So, the compliance state of the assembly is Missing Info. Remember that as soon as non-compliance is found in a lower level of a BOM, all levels above it carry the non-compliant state until the problem is removed.

Things could be altered if Treat Exempt as Compliant rule is set to Yes (its default is No); however, note that in this particular use case, the compliance state of the top-level assembly would still be Missing Info.
Part-Level Validation - Rollup from Compositions to Part/Part Group

The steps followed by the system for part-level validation are:

- Find and re-use (where possible) qualified compositions based on the specification, and per supplier
- Perform the rollup for each qualified composition
- Combine rollup states of qualified compositions

Find Qualified Compositions for Use or Re-use

The PG&C business logic for compliance rollups has the "goal" of re-using compositions as much as possible. A composition is re-usable if the substances of the rollup specification (for the part to be rolled up) is a subset of the substances in the composition spec.

So, the first step of a part or part-group rollup (compliance check) is that the system seeks to find and qualify compositions for items, mfr. parts, or part groups (<Part/PG>).

As soon as the system finds a single composition with a specification (or the "All Spec" case, a composition with no specification) that fulfills one of the conditions (listed below), that composition/spec combination is used (rule 1) or re-used (rules 2, 3, 4) in the rollup of the <Part/PG>.

For the set of rules below, recall that Full Material Disclosure is defined in "Mass Disclosure" on page 5-5, Mass Disclosure, and that All Spec is discussed in "All Spec Use Case" on page 7-7.

Rules for Selecting Compositions for Rollup on Part/Part Group (Internal Specifications)

Below are the internal rules that the system follows to find a composition that can be used or re-used (where possible) in the rollup of a part/part group. This can also be thought of as "qualifying compositions" for use (rule 1) or re-use (rules 2, 3, 4).

Note: The name of each rule below is not used by the system logic, they are for user understanding. These are "internal rules" that operate within the system logic, but they are not "seen" in the user interface. The system makes its selection "per supplier."

Composition Selection Logic

When a rollup is done on an item, mfr part or part group, for a given specification, it pursues the following sequence that provides an active composition:

1. Matching composition: The system looks for matching spec composition. It looks for a composition that has the same spec as the given specification. If there are multiple compositions found, it picks the one that fits the 'compliance rule setting'. It picks up both the compositions, in case there are 2 compositions with the same spec - one Full Disclosure (FD) and the other Partial Disclosure (PD).

   If a matching composition is not found:

2. Fully Disclosed Composition: The system look for a latest released composition marked as 'Fully Disclosed' per supplier. The compositions selected may have a different spec or 'no spec'. In case multiple compositions are available, it picks the one that complies with the rule.
If a Fully Disclosed composition is not found:

3. No spec composition: The system shall find Partially Disclosed/Undisclosed compositions that have 'no spec'. It looks for a composition (without any specification attached) that contains all the substances on the given specification. Super spec composition: If Fully Disclosed compositions are not found, the system looks for Partially Disclosed / Un-disclosed compositions that are on a spec that contains all of the Substances for the current specification.

4. Super spec composition: If Fully Disclosed compositions are not found, the system looks for Partially Disclosed / Un-disclosed compositions that are on a spec that contains all of the Substances for the current specification.

If it is not able to find compositions for any of the above rules, the system shall set the value of 'missing info' on the 'calculated compliance' attribute in the spec table.

For more information, see "Validation Type in Conjunction with Composition Type" on page 4-4. and "General Info Tab" on page 5-1.

Perform the Rollup for Each Qualified Composition

The next step in the sequence of part-level validation is the actual rollup of each qualified composition.

Re-using Exemptions in Rollups

Here the goal of the internal logic is this: if the user has declared one or more exemptions for a part/substance in a composition, and another spec contains one of these exemptions, the exemption can be applied to the part/substance for that spec.

Previously the system could only re-use the value of the Declared Compliance field in the case of a matching composition (that is, the spec in the composition was exactly the same as the spec for which the rollup is performed). In other cases, such as Fully Disclosed or All-Spec compositions, the Declared Compliance value was ignored.

Now, for a non-matching composition, the value of the Declared field can and will be re-used if all of the following are true:

- Composition is qualified for rollup specification,
- the value is Exempt;
- there are values in the Exemptions list; and,
- one or more Declared exemptions exist in the rollup specification.

However, if the result of the calculated compliance is already Compliant, then this result is used, and there is no need to re-use the exemption.

Combine Rollup States of Qualified Compositions

The final step of part-level validation takes into account the appropriate Composition Rollup rule in Administrator. For each part or part group, this rollup evaluates all qualified compositions for the part across all suppliers for the particular specification being rolled up at the time.

The resulting compliance state is stored in the Calculated Compliance field and Result Compliance field of the Specifications table of the part or part group for that specification.

The Specifications table also has a Declared Compliance field for each specification. This field allows a user to overrule the Calculated Compliance up to this point. This is
used in the case where a company has put a waiver in place or has an application-based exemption for, say, medical devices.

**AML Validation - Rollup from AML to Item**

This is governed by the AML Rollup rule in Administrator. Strict setting, or worst case, means that as long as one of the manufacturer parts on the AML of the part is different than Compliant, then the part cannot be compliant. Relaxed setting, or best case, means that as soon as one of the manufacturer parts on the AML of the part is compliant, then the part is compliant, effectively reversing the compliance state priority list.

The resulting compliance state of the item across its AML is stored in the Calculated Compliance field (and Result Compliance field) of the Specifications table on the item for that specification.

The Specifications table for that item also has a Declared Compliance field that allows a user to overrule the Calculated Compliance up to this point.

This validation does not happen automatically but depends on scheduled rollups or on the user launching a compliance calculation for the parent of the compositions or one of the parent’s higher-level BOM parents.

Here are a few use cases illustrating how the rollup rules work.

Case 1 - AML Rollup rule is set to Strict and Treat Exempt as Compliant rule is set to Yes or No.

- Item 1 - Not Compliant
  - Mfr.Part 1 - Exempt
  - Mfr.Part 2 - Not Compliant

Case 2 - AML Rollup rule is set to Relaxed and Treat Exempt as Compliant rule is set to No.

- Item 1 - Exempt
  - Mfr.Part 1 - Exempt
  - Mfr.Part 2 - Not Compliant

Case 3 - AML Rollup rule is set to Relaxed and Treat Exempt as Compliant rule is set to Yes.

- Item 1 - Compliant
  - Mfr.Part - Exempt
  - Mfr.Part2 - Not Compliant

So, if the mfr. part has a compliance state of Exempt and the 'Exempt' rule is set to Yes, the item is compliant.

**Validation Rollup from Item to Assembly**

This is governed by the Treat Exempt as Compliant rule in Administrator. The resulting compliance state is stored in the Calculated Compliance field (and Result Compliance field) of the Specifications table on the item for that specification.

The Specifications table for that specification also has a Declared Compliance field that allows a user to overrule the Calculated Compliance up to this point.
This validation does not happen automatically but depends on scheduled rollups or on the user launching a compliance calculation for the parent of the compositions or one of the parent's higher-level BOM parents.

Please see "System Logic of BOM/Compliance Rollups" on page B-4.

**Rules for Calculating Compliance for Specifications on Parts**

For specifications with matching compositions, the Result Compliance from the composition is used. The system does not perform the composition rollup, since the rollup already happened in a declaration or during Import and its result can be re-used.

For all other non-matching compositions, the rollup compares the substance in the spec with the substances in the composition based on their Result PPM. The Declared, Calculated and Result Compliance fields at all levels in the composition will not be used.

Note that the system does not update any fields on the Composition table or composition Substances table, so it can be difficult to verify. When doing a rollup from an assembly, use the BOM Compliance Report to ensure that the system-calculated compliance at the specification level is correct for all the children in the assembly.
The External Rollup solution revolves around the idea of extracting PG&C data from Agile database into an external aggregation engine; rolling it up and updating it back to Agile database.

Prior to this release, Agile PG&C allowed two types of rollups: A rollup that could be done at will with the Calculate Compliance button, and a scheduled rollup that works more like a nightly task; these are the internal rollups described in the previous chapter. The External Rollup feature aims to achieve the same level of functionality using your company’s own rollup or aggregation engine.

The solution works as outlined below:

A customer gathers compositions for Items (manufacturer parts) from suppliers, then adds the items to product BOMs and attaches a REACH specification at the product level. The REACH specification is marked "External" for external rollup and the product BOMs as "Shippable". A scheduled external rollup task when started scans the PG&C database for records of BOMs that need to be rolled up and collects them. The database is further scanned for compositions at the leaf nodes of the BOM.

Another simpler approach is introduced, which extracts any item that has a specification marked external. Data is sent to external rollup tables and a rollup is performed. Here we ignore the "Is Shippable" flag and only check if a specification is attached that is marked as "External". Be it an item or a product BOM, it will get rolled up in the external rollup.

All of this data gets extracted to some tables in the Agile database; but in a new tablespace. Data transformations are performed on this dataset residing in the external rollup tables to help the rollup or aggregation engine do rollups. Once the data is ready, the external rollup or aggregation engine starts the rollup task. The dataset gets locked till the rollup is over or a flag based approach is used to keep data consistency between Agile and external rollup tables. All business logic (REACH regulation related logic) required for the rollup is executed as PL/SQL scripts with the rollup. Customers can modify the scripts or use a custom rollup engine on the external rollup tables to do rollups.

On completion of the rollup, the results are written in to external rollup tables. The results are then pulled in to PG&C-related tables through server or PX code to mark the items or product BOMs compliant or non-compliant against the specification. If custom attributes are involved in rollup, customers can execute custom code independent of the rollup task against external rollup tables to retrieve and update results into Agile.
Note: To avoid bottlenecks around pulling data back in to Agile, customers with huge amounts of substance data and high volume of compositions to be created, can bring the flags (Compliant, Non-Compliant, etc.) back to Agile leaving the real substance level details in external tables and use a URL PX on the Item/Manufacturer Part to show the substance of the active composition.

New SDK APIs are provided for customers to implement a process extension (PX) to extract data for a given product BOM and its compositions. These APIs can invoke the code on the server (the same code that executes the scheduled server task) that extracts the data, push it to the external database, and run a rollup. Once the rollup is completed, the results can be updated back on to the product BOM by SDK API.

Refer to Appendix C, "Reference Documentation for External Compliance Rollups" for the logic used in the external rollups.

External Compliance Rollups

External rollups provide a solution to deliver REACH compliance data.

Unlike the internal rollup engine, which cannot be modified, the external rollup engine is a PL/SQL script shipped with Agile schema; customer can follow the data schema and modify this with their own rollup logic.

Actions Triggering External Rollup

Three types of actions which trigger the external rollup are described:

1. External Rollup Task: Configured in Java Client > Admin tab > Server Settings > Task Configuration > External Rollup Task. When the task is triggered the server calls the external rollup engine to search out all objects which need to do external rollup. [Object with external specification and its Need Compliance Check flag is 'Yes']

2. On Demand: This works the same as internal rollup, with the user clicking the Calculate Compliance button or routing Declaration Status from 'Open to Supplier' to 'Submit to Manager'. If there is an external specification associated to the object or added to declaration, the server triggers the external rollup engine to do rollup for this object.

3. Composition Rollups: Occurs within declarations having an external specification whenever the declaration changes status (except from 'Pending' to 'Non-Released' status). The system starts the rollup at the end of importing compositions into items or manufacturer parts.

Archived External Compositions

Number of Archived External Compositions is a parameter set in Admin > Server Settings > Preferences used to limit the number of archived external compositions.

If users run external rollup (by task or On Demand) while creating new external compositions, the server checks the value of 'Number of Archived External Compositions' for each external specification. If the Archived External Compositions number exceeds the admin setting, the oldest (based on last update time) external composition is deleted.
This setting is described in more detail in Number of Archived External Compositions Preference in Appendix A, "Configuring Product Governance & Compliance".

**Manual External Rollup using Excel Add-In**

An additional manual method of using external rollup, the concept and the logic behind external rollups is described in detail in Appendix C, "Reference Documentation for External Compliance Rollups."

**Excel Add-In Use Case**

Here's a high level view of how a user performs an external rollup using the Excel Add-In:

1. Open the Excel Rollup template and log in to the server.
2. Search for a part (three search options: Latest Released Rev, Released Rev and Pending Rev) or a manufacturer part, and select the external specification, then load the data.
3. Click Rollup the Data in the spreadsheet and get compliance status.
4. Click Submit Data, which updates the Calculated Compliance in the specification in PG&C.
A supplier is a company that provides compliance information about parts that are used in the company’s manufacturing process. The supplier firm may or may not actually make or sell the parts about which they furnish compliance information.

Besides creating objects to represent supplier firms, a compliance manager creates objects to represent employees of the supplier: these have been called "contact users," and are now called "declaration recipients" in the PG&C context.

When you create a declaration, you assign it to a supplier who is requested to provide compliance information. The supplier’s declaration recipient uses the PG&C Supplier Guide to learn to work in Agile Web Client and to complete the declaration. Later the compliance manager evaluates the data received from the supplier and releases the declaration.

The compliance manager may create Supplier Groups that can be leveraged by users with appropriate roles.

---

**Note:** There has been a relaxing of the original constraints to suppliers on declarations. These are detailed in the Note in "Creating a Declaration" on page 9-11.

---

For more information about suppliers, see the PG&C Supplier Guide.

### Attributes in Suppliers

As with other Agile objects, information about the supplier is displayed on a series of tabs. Each tab contains information about, or related to, that supplier.

By default, the General Info tab contains the fields listed in the following table. Agile administrators can add custom class and subclass fields to the General Info tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the supplier</td>
</tr>
<tr>
<td>Supplier Type</td>
<td>Indicates the supplier subclass; configurable by the administrator.</td>
</tr>
<tr>
<td>Lifecycle Phase</td>
<td>Supplier is Active or Inactive</td>
</tr>
<tr>
<td>Number</td>
<td>Supplier number assigned to the supplier when you create it</td>
</tr>
<tr>
<td>DUNs</td>
<td>Industry-standard Data Universal Numbering System (DUNS) number</td>
</tr>
<tr>
<td>Display Name</td>
<td>Display name</td>
</tr>
</tbody>
</table>
Attributes in Suppliers

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Text that describes the supplier; maximum length is set by Agile administrator</td>
</tr>
<tr>
<td>Web Supplier</td>
<td>Indicates if this supplier logs in to Web Client (Yes, which is then called &quot;Web Supplier,&quot; or No, which is then called &quot;non-Web Supplier&quot;). PLM now allows declarations to name either kind of supplier: a Web Supplier must have at least one associated declaration recipient (see next section); a non-Web Supplier may be named in the declaration with no associated declaration recipients. However, it is still recommended that a declaration name a Web Supplier: PG&amp;C carries and publishes the most useful information if a Web Supplier - with associated declaration recipients - is named; for example, those declaration recipients receive notifications. Note that there is no requirement that a declaration must have a supplier. Ensure the administrator has made the field 'not required'.</td>
</tr>
<tr>
<td>Corporate Currency</td>
<td>Default currency for this corporation</td>
</tr>
<tr>
<td>Address</td>
<td>Address</td>
</tr>
<tr>
<td>Geography</td>
<td>(This may have been set up by the administrator.)</td>
</tr>
<tr>
<td>City</td>
<td>City</td>
</tr>
<tr>
<td>Region / Province / State</td>
<td>(This may have been set up by the administrator.)</td>
</tr>
<tr>
<td>Country / Area</td>
<td>Country</td>
</tr>
<tr>
<td>Postal/Zip Code</td>
<td>Postal or ZIP code</td>
</tr>
<tr>
<td>Phone</td>
<td>Phone number</td>
</tr>
<tr>
<td>Fax</td>
<td>Fax number</td>
</tr>
<tr>
<td>URL</td>
<td>URL for supplier Web site</td>
</tr>
<tr>
<td>Maximum number of Contact Users</td>
<td>Maximum number of contact users you can create for this supplier</td>
</tr>
<tr>
<td>Maximum Number of Licensed Contact Users</td>
<td>Maximum number of supplier users you can assign Concurrent user licenses</td>
</tr>
<tr>
<td>Maximum Number of Named Contact Users</td>
<td>Maximum number of supplier users that can be assigned a Named user license</td>
</tr>
<tr>
<td>Default RFQ Recipient</td>
<td>Contact user in the PCM solution, main recipient of RFQs</td>
</tr>
<tr>
<td>Default Declaration Recipient</td>
<td>Contact user in the PG&amp;C solution, main recipient of declarations</td>
</tr>
</tbody>
</table>

**Buttons on the General Info tab**

The General Info tab contains the following buttons:

- **Edit** - appears when the General Info tab is not in edit mode. To edit the General Info tab, click Edit.
- **Save** - appears when the General Info tab is in edit mode. To save the changes that you made to the tab while it was in edit mode, click Save.
- **Cancel** - appears when the General Info tab is in edit mode. To undo the changes that you made to the tab while it was in edit mode, click Cancel.

The following sections describe additional tabs.
Creating Compliance Suppliers

Even if your administrator has created suppliers and declaration recipients, you may have to create more.

Supplier Types

There are several "out-of-the-box" supplier types in Agile PLM, but these were tailored for RFQs and the sourcing process. Your administrator may have created another Supplier subclass for your company’s PG&C work, or may have reconfigured and renamed one of the existing supplier types. If you are going to create suppliers to provide compliance information in support of your company’s manufacturing process, there must be at least one predefined "compliance-oriented" subclass that you and other compliance managers can select.

Note: "Web Supplier" is an attribute on General Information tab of a supplier, not a supplier type (subclass). See the Description of Web Supplier in the table in "Attributes in Suppliers" on page 13-1.

Supplier Lifecycle Phases

The lifecycle phase of the supplier can be either Active or Inactive.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The supplier is currently active and able to receive declaration requests/RFIs.</td>
</tr>
<tr>
<td>Inactive</td>
<td>The supplier is currently not active, and cannot be included in new RFIs.</td>
</tr>
</tbody>
</table>

Creating a Compliance Supplier

To create a supplier:

1. Click the Create New drop-down button to activate the menu.
2. Click the Suppliers link.
3. In the Create New Suppliers dialog, click the drop-down arrow next to the Type: field and select an appropriate supplier type. The default types are: Broker, Component Manufacturer, Contract Manufacturer, Distributor, and Manufacturer Representative.

Remember, the administrator may have changed the out-of-box names and created other supplier types for compliance-specific work.

4. There are several required fields. Specify a unique supplier Name.

In the Number field, an identifying number for the declaration is automatically generated. Accept or modify this identification.

Select appropriate settings for Lifecycle Phase (Active, Inactive), Web Supplier (Yes, No), and Corporate Currency (choose from list).

Note: If a supplier is not active (that is, if Lifecycle Phase is set to Inactive), this supplier cannot be added to a declaration

"Web Supplier” nominally indicates if a supplier logs in to Web Client to provide compliance information.
Creating and Adding Contact Users

Also enter a value for Maximum Number of Contact Users. This number should be known to you in conjunction with the number of licenses purchased by your company that can be distributed over all your Supplier users.

5. Click Continue to bring up the Add Contact Users dialog - declaration recipients. Click the Search to add icon to add existing supplier users in the Users Search dialog. Or click the Create to add icon to create a new supplier user object that you can add to the Supplier. Click to select supplier users that you want to add, and hit Enter; or you can double-click a supplier user to add it. You may run additional searches after this, too.

6. Click Save. The new supplier object appears with the General Info tab selected.

7. After the supplier is created, it can be modified at any time. This task continues with steps to add appropriate objects. Open the supplier, click Edit: to add information and populate enabled fields under the various tabs.

8. Enter general information, including flex field details.

9. Click the other tabs to add additional information about the supplier. However, note that the default tabs - RFx Routing, Manufacturers, Commodities, and PSRs - have more to do with the PCM solution (unless the administrator has renamed and reconfigured these tabs).

10. If you want to add attachments, click the Attachments tab. Now choose from the Add menu Files, URLs, or By Search, and navigate to the desired file or URL. When you are finished adding attachments, click Finish.

11. When your modifications are complete, click Save.

Creating and Adding Contact Users

The Contact Users tab defines which users can log in to Agile PLM to represent a compliance supplier. Supplier contact users - now called "declaration recipients" - have restricted privileges to the Agile PLM system that allow them to respond to RFIs.

An important setting for any declaration recipient is the Response Edit Mode user preference. This field controls which user interface in Web Client that the contact user sees. When creating a new supplier user, the default setting for Response Edit Mode is Basic; this means the supplier user will see the "Basic Supplier Interface" when they log in to Web Client. (See the PG&C Supplier Guide.)

If a supplier’s contact user were to change the setting of Response Edit Mode from Basic to Advanced mode (specifically Advanced Table Edit or Advanced Wizard Edit), he is prompted to log out and log back in; when he logs in to Web Client, he will see the normal user interface, constrained by his assigned privileges.

The PG&C Supplier Guide urges supplier users to let the setting to Response Edit Mode remain as it was set by you (or the administrator). If the supplier user in the above situation does log in to Web Client (Advanced mode), he has to click the My User Profile link and change Response Edit Mode field back to Basic, followed by logging out and logging back in to Web Client (Basic mode).

Declaration recipients who work frequently with your compliance requests may be required to create declarations, and you may want your administrator to assign
additional roles and privileges to enable them to work more effectively in Web Client (Advanced mode).

To add an existing supplier user or create a new supplier user that is associated with a supplier:

1. Open a supplier and click the Contact Users tab.
2. Click Add. Click the Search to add icon to add existing supplier users in the Users Search dialog.

Or click the Create to add icon to create a new supplier user object to add to the Supplier.

Click to select supplier users that you want to add, and hit Enter; or you can double-click a supplier user to add it. You may run additional searches after this, too.

---

**Note:** Named Users can be added to the Contact Users tab only if the Maximum Number of Named Contact Users field has been set to other than 0 (or blank) on the General Info tab of the supplier. Otherwise, only users with a Restricted user license can be assigned to a supplier.

---

3. If there are no supplier user(s) for this supplier, you have to create them; that process begins in the Navigation Pane: click the Tools and Settings button > click Address Book > Users tab > Add button.

---

**Note:** See the chapter, 'Users' in Agile PLM Administrator Guide for the Create Users process. Ensure you have the required roles and privileges or contact your administrator.

---

4. When you have completed the process of adding users, click Save.
In PG&C, searches are used to identify parts that require compliance data from suppliers, and also to find existing business objects in the Agile database - substances, specifications, declarations, and so forth.

The chapter "Finding Data with Agile Searches" in the *Getting Started with Agile PLM* describes many aspects of searches in Agile PLM that are not covered herein.

Below are the predefined searches for PG&C, and a review of how to use search options when building new objects with associations to existing objects.

### Accessing PG&C Saved Searches

To access PG&C saved searches, in the navigation pane, click Searches folder and expand Compliance Searches. These are the predefined searches available for PG&C.

- Custom Parts without Composition in a Top-Level Assembly (TLA)
  - Shows all items that do not have an AML and that do not have an active composition. If there is a part with a pending composition, this search does not show that part.

- Manufacturer Parts without Composition in a Top-Level Assembly
  - Shows all manufacturer parts that do not have an active composition. If there is a part with a pending composition, this search does not show that part.

- Manufacturer Parts for an Item
  - Shows all manufacturer parts for a given Item. So, it is similar to viewing the Item’s Manufacturers tab.

### Using the Search Options in Add Operations

In various "create" or "add" operations that are detailed in this manual, when you click the Add button, the dialog that opens may have a Search button. This is the procedure to decide what route to take to identify objects in the database that you can select in your "add" operation.

Agile quick searches, advanced searches, and parametric searches are documented in *Getting Started with Agile PLM*.

- Search (button and menu choice) opens a dialog with three Search tabs:
  - Search tab lets you run a simple search by entering a value in the field and clicking the Search button.
  - Click the Advanced Search link to set up an advanced search.
– Click the Search Attachment Contents check-box to include attachment files in your search.
– When the search results return, select and move objects from the Results table to the Selected table.
– Click OK, and you are returned to the Create wizard, and the selected objects are added where appropriate.

Saved Searches tab opens to your navigation pane where you can browse in search folders, select a search, and run it. Again, returned results may be moved to the Selected Items table, and click OK.

Shortcuts tab opens to your navigation pane where you can select objects from My Bookmarks or Recently Visited. The system displays shortcuts to only those objects that are appropriate to the operation you are performing.

Generally you can run multiple searches before completing the wizard step. Also, after you create the object, you can still run multiple searches.

**Searchable Attributes for PG&C**

PLM allows parametric searches. Many attributes in PG&C are searchable.

**Searchable attributes for PG&C** (Advanced Search and Parametric Search):

– All classes > Page One (Title Block, Cover Page, or General Info), Page Two and Page Three > all attributes > Enable for Search Criteria property = Yes/No

---

**Note:** Some attributes are available for parametric search by default.

**Searchable attributes in Substances:**

– Alias - available for substance and substance groups

**Searchable attributes in Declarations:**

– Has Invalid Substance - on Cover Page of all declarations classes except Supplier Declarations of Conformance and Part Declarations
– Need Rollup - on Cover Page of all declarations classes except Supplier Declarations of Conformance
– Mass Disclosure - on <Parts/PGs> tables of all declarations classes except Supplier Declarations of Conformance

**Searchable attributes in Parts/Part Groups:**

– Mass Disclosure - on Composition table

**Searchable attributes in Specifications:**

– Disallow Intentionally Adding - on Substances table

**Searchable attributes on Substances tables** (Declarations <Parts/PGs> tabs; & Part/Part Group Composition tabs):

– User-entered CAS Number
– Intentionally Added
– Calculated Mass
– Result Mass
- Result PPM
- Spec Intentionally Added

**Searchable Summary Compliance attribute:**
- Items > BOM tab > Summary Compliance
- Changes > Affected Items tab > Summary Compliance

<table>
<thead>
<tr>
<th>PG&amp;C Attributes</th>
<th>Enable for Search Criteria</th>
<th>Enabled Out-Of-Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substance.General Info.Alias</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Substance.General Info.CAS Number</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Declaration.Cover Page.Need Rollup</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Declaration.Cover Page.Has Invalid Substance</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Declaration.Part / Mfr.part / Part Group---Mass Disclosure</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Declaration.Part / Mfr.part / Part Group.Substances.User Entered CAS Number, User Intentionally Added, Calculated Mass, Result Mass, Result PPM, Spec Intentionally Added</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Specification.Substances.Disallow Intentionally adding</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Part / Mfr.part / Part Group Composition.Mass Disclosure</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Part / Mfr.part / Part Group Substances.User Entered CAS Number, User Intentionally Added, Calculated Mass, Result Mass, Result PPM, Spec Intentionally Added</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Agile reports provide you with the information you commonly need to analyze your business processes. You select predefined criteria and specify the results you want. These out-of-box reports are applicable in most situations. You can run them as they are, modify the default layouts, or create your own layouts. As in all solutions, Agile reports are run from Web Client.

The chapter "Working with Agile Reports" in the *Getting Started with Agile PLM* describes report layouts, working inside and outside the wizards, how roles and privileges affect reports, and the report output window.

---

**Note:** If your company has upgraded from an earlier version of PG&C, the report output fields (in the layout) may not include all the necessary attributes. Review the layout for each report to ensure that appropriate attributes are included in the report result.

---

**Accessing PG&C Reports**

To access PG&C standard reports:

1. In the Navigation Pane, click the Reports drawer (and expand Reports and Analytics if necessary).
2. Expand Standard Reports.
3. Expand Compliance Reports.

The Compliance Reports folder includes the following predefined reports:

- "Parts with Compliance Issues Report" on page 15-5.
- "Parts with Substances Report" on page 15-5.
- "Parts with Substance over PPM Report" on page 15-6.
Report Privilege

To use the Report wizard, you must have the Report privilege. If you are having difficulty, see your administrator.

All the Discovery privileges that are set up for your Agile content will be observed when you run a report with that content, including all rules about warnings set by the administrator.

If you do not have the Discovery privilege for an Agile object, you cannot include that object in a report. Parts for which you do not have the Discovery privilege are displayed in the same way they are displayed on BOMs, that is, you may see the object's ID as a placeholder, but it is not a live link. To view and open either objects or a class of objects, consult your Agile administrator.

View and Modify a Compliance Report

To view or edit an existing Compliance report:

1. In the navigation pane, open the Reports drawer, expand Reports and Analytics > Standard Reports > Compliance Reports. Click the Report Name of the default Compliance report you want to use as the basis for your Personal report. The report object opens.

2. Click a tab to view. If a tab, such as Layout tab, offers multiple reports (default or saved personal reports), you can click a link of Layout Name to view that layout. Or, double-click the editable cells to modify that report's layout.

Below is a task for modifying a default Compliance report into a Personal report. Until you have run enough reports to decide how to customize the default layouts, it is better to create, name, and save specific reports from the default layouts.

To modify a default report into a personal report:

1. In the navigation pane, open the Reports drawer, expand Reports and Analytics > Standard Reports > Compliance Reports.

2. Click the icon next to the default report you want to use as the basis for your personal report.

3. Click Actions > Save As, and give the new report a unique name. The new report object is created.


   At the Folder field, click the Launch the Palette button.

   You can browse to Personal Reports to add a location to store the executed report. You can also remove a location, such as Compliance Reports.

   When you are done, click Esc or "x" to close the palette.

5. Click Save if you made changes, or click Cancel.

   After creating and saving your report, it can be run at any time.

To add another object to a report while in the wizard, use one of the following methods:

1. Type in;

2. Search to add;

3. Copy and paste - copy the object from another table (including Advanced, Basic, or Saved search results) or the Navigation (left) pane and paste to the target table;
4. Custom search - launch the Advanced Search dialog and create an Advanced search, run the search, select the search you want, and copy/paste it to the table.

**Specifics to Compliance Report Layouts**

Use the general information below, and the specific information about each Compliance report, to populate fields when you generate your reports.

When you open a Compliance report, there are two ways to prepare the report for running, through the wizard or tab-by-tab.

- If you click Execute, the wizard is initiated. You are prompted to accept defaults or make choices on one or more dialog pages, but may not necessarily see all the tabs or fields in the report.
- Another method of generating a Compliance report is to open each tab and accept or choose values for editable fields. It also helps to open the Layout tab to edit the report’s layout. When you are done making changes, you click Execute and the wizard is initiated.

Whenever you run a Compliance report, or any PLM Standard report, you are prompted to select an Output Format from this list:

- PDF
- Word
- Excel
- HTML, or
- Standard.

No matter which output format you select, the modifications you have saved (in a standard Compliance report or in your Personal version of a Compliance report) are reflected when you run the report.

---

**Note:** Any report that displays substances on a declaration’s Part/PG tab > Substances table also displays the Unreported (System) substance, assuming it is used in the composition.

---

**Part Compliance Report**

This report returns a Result Compliance per specification for selected items or manufacturer parts, based on which layout is used for the report. You can run a compliance rollup before running the report.

To generate the Part Compliance report:

1. Open the Part Compliance report.
   - If you click Execute, the “Run Part Compliance” wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:
     - “Select Layout and Configuration” and
     - “Select Items and/or Manufacturer Parts for the Report”.
   - The steps below go through the tabs in the report and the fields you can modify.

2. On the General Info tab, click Edit.
   - At the Folder field, click the Launch the Palette button.
You can browse to Personal Reports to add a location to store the executed report. Click Esc or the Close button ("x") to close the palette. Click Save if you made changes, or click Cancel.

3. Click the Layout tab.
   You can click and drag the column separator to better read the options in the Name field. Release the mouse button.

4. Click the Default Layout For Item link (or Default Layout For Mfr Part).
   The Properties tab has several fields; for now, accept the defaults.
   Click the Format tab. You can add fields (attributes from the PLM objects) to be displayed in the report. To move an attribute from Hidden Fields to Displayed Fields, either double-click the row, or select the row and click the Display selected columns button.
   You can also move fields the other way, using the Hide selected columns button.
   Finally, there are buttons to order the display list, Move selected columns up and Move selected columns down.
   When you have completed moving fields, click Save.

5. Click the Schedule tab. Click Add.
   The "Add Schedule for Part Compliance" wizard begins. Click Next.
   You can add items to be the subjects of the report in a variety of ways:
   - Type-in, Copy-&-paste, Custom search, and Search to Add.
   - For example, click the Add button. Enter the desired information, and click the Search button.
     - You can use the familiar selection commands (Shift-click and Ctrl-click) to select the items you want.
     - To add them to the table, drag the selected items, or press Enter.
     - Hit the Esc key, or click the Close button.

6. Click the Next button.
   Make selections in the Schedule, Time, Date, and Users fields. To change the date, double-click the Calendar button.
   When you are finished scheduling the report, click the Finish button.

7. Click the Execute button to manually run report. (If you defined a Schedule, the report is generated automatically at the specified Date and Time settings.)
   The "Run Part Compliance" wizard is initiated. Look through the selections to ensure the report contains the fields you are interested in. Click Next.

8. Click Finish. The report runs. After running the report, you can Save it, Print it, and Export it to another format.

**Part Groups Compliance Report**

This report returns a Result Compliance per specification for selected part groups. You can run a compliance rollup before running the report.

To generate the Part Groups Compliance report:

1. Open the Part Groups Compliance report.
2. When you click Execute, the "Run Part Groups Compliance" wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:
   "Select Layout and Configuration" and
   "Select Part Groups for the Report".

3. When you are done, click Finish.

**Parts with Compliance Issues Report**

This report returns all active compositions (part-specification-supplier) with its compliance state (Result Compliance) set to Blank, Not Compliant, or Missing Info. There are layouts available for items and for manufacturer parts.

To generate the Parts with Compliance Issues report:

1. Open the Parts with Compliance Issues report.
2. When you click Execute, the "Run Parts with Compliance Issues" wizard is initiated. You are prompted to accept defaults or make choices on this dialog:
   "Select Layout and Configuration".
3. For Layout, select Default Layout For Item or Default Layout For Mfr Part.
4. When you are done, click Finish.

**Parts with Substances Report**

This report returns all parts that contain the selected substances in the active compositions, for items or manufacturer parts, that satisfy at least one of these conditions:

- Result Mass does not equal 0
- Result PPM does not equal 0
- Result Compliance is not blank.

---

**Note:** The Parts with Substances report recognizes Unreported (System) substance. Also, this report recognizes when a substance group should be used when its base substance is specified. For example, if a part has SG-Lead and Lead Compounds, and you name the base substance Lead in the report setup, those parts with SG-Lead & Lead Compounds are in the report results.

---

To generate the Parts with Substances report:

1. Open the Parts with Substances report.
2. When you click Execute, the "Run Parts with Substances" wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:
   "Select Layout and Configuration"
   "Select Substances for the Report".
3. For Layout, select Default Layout For Item or Default Layout For Mfr Part.
4. When you are done, click Finish.
**Note:** The Specification attribute may not be displayed in a part's Compliance tab > Substances table, but if it is enabled, it can result in two identical records in the Parts with Substances report.

---

### Parts with Substance over PPM Report

This report returns all parts that contain selected substances above a given PPM value, by part or material. The report takes the value from Result PPM field.

If an active composition contains a selected substance - or Unreported (System) substance - with a Result PPM value that is higher than the given PPM value, the part associated to the composition is returned.

If an active composition contains a selected substance with the Result PPM field blank, and Calculated PPM is higher than the given PPM value, the part associated to the composition is returned.

For a part-level specification, in order to get the calculated PPM value of the substance, the Mass value of the part and substance must be present. For a material-level specification, in order to get the calculated PPM value of the substance, the Mass value of the material and substance must be present.

---

**Note:** The Parts with Substance over PPM report recognizes Unreported(System) substance. Also, this report recognizes when a substance group should be used when its base substance is specified. For example, if a part has SG-Lead and Lead Compounds, and you name the base substance Lead in the report setup, those parts with SG-Lead & Lead Compounds are in the report results.

---

If the selected substance (other than the base substance) exists on the Substances tab of a substance group, and (only) when the active composition contains the substance, the part associated to the composition is returned.

To generate the Parts with Substance over PPM report:

1. Open the Parts with Substance over PPM report.
2. When you click Execute, the "Run Parts with Substance over PPM" wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:
   "Select Layout and Configuration"
   "Select Substances for the Report"
   "Set Mass PPM Level".
3. For Layout, select Default Layout For Item or Default Layout For Mfr Part.
4. Select a substance or substance group - you can select only one substance/substance group for this report.
5. Set PPM threshold for the report.
6. When you are done, click Finish.

### Supplier Compliance Report

This report returns all compositions (part-specification-supplier) with compliance state (Result Compliance) for selected suppliers. You can select multiple suppliers for this
Specifics to Compliance Report Layouts

This report cannot be selected. You can run the report, for items or manufacturer parts, against released declarations or non-released declarations. For released declarations, the report looks only at active compositions.

This report also supports the "non-Web Supplier" as well as previously supported Web Supplier.

To generate the External Rollup report:
1. Open the External Rollup report.
2. When you click Execute, the "Run External Rollup Report" wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:
   - "Select Layout and Configuration"
   - "Select Items/Manufacturer Parts or Part Groups for the Report"
   - "Select Specifications for the Report"
   - "Select Date Range".
3. For Layout, select Default Layout or Standard.
4. Select one or more items, manufacturer parts, or part groups for this report.
5. Select one or more specifications for the report.
6. Select a date range using the From and To fields.
7. When you are done, click Finish.

Missing Substances Report

This report returns active compositions for selected parts for which specified substances are missing. This can be from a single supplier or from multiple suppliers. The report shows a page for each supplier with Missing Substances information. Note that substances with blank values for Result Compliance, Result Mass, or Result PPM attributes from selected specification are considered "missing" - even if the substance exists in the active compositions.

This report also supports the "non-Web Supplier" as well as previously supported Web Supplier.

To generate the Missing Substances report:
1. Open the Missing Substances report.
2. When you click Execute, the "Run Missing Substances" wizard is initiated. You will be prompted to accept defaults or make choices on these dialogs:
   - "Select Layout and Configuration"
   - "Select Items or Manufacturer Parts for the Report"
   - "Select Suppliers for the Report"
   - "Select Specifications for the Report".
3. Select one or more items or manufacturer parts. See the list of refinements just below this task.
4. Select one or more suppliers for the report. If you do not select a supplier, this report runs against all suppliers. (This includes ASL suppliers and non-ASL suppliers that are associated to the active compositions for a selected specification.)
5. Select one specification for the report.

6. When you are done, click Finish.

**Refinements to Missing Substances Report**

This report looks at the following factors for an item or assembly:

- If the item or assembly has matching compositions (same supplier and same specification), the report runs against these compositions following these two rules: (1) if the composition is Fully Declared, the part is not reported; (2) if the composition is Partially Disclosed or Undisclosed, the system checks if the composition has the substance, and if so, the part is not reported.

- If the item or assembly have no matching compositions (same supplier and same specification), the system checks all active compositions supplied by the same supplier but with a different specification, following the same two rules (stated in first condition above).

- If there are no compositions with "same supplier and same spec" or "same supplier but different spec," the system returns the part with all the substances from the specification as missing and for the supplier.

- If a supplier is not specified at report setup, the system checks all compositions from all suppliers, without considering the specification: all Fully Disclosed compositions are not returned, Partially Disclosed and Undisclosed compositions are considered. "No supplier" is included when looking for all suppliers.

- The Alias attribute is displayed in the Missing Substances report. If a specification has a substance group, and the substance group has an Alias, the Missing Substances report returns only the base substance of the substance group, as well as the base substance’s Alias.

**Declaration Workflow Metrics Report**

This report returns metrics for declaration workflows, that is, how long it took for the declaration to advance from one specified status to another.

This report also supports the "non-Web Supplier" as well as previously supported Web Supplier.

To generate the Declaration Workflow Metrics report:

1. Open the Declaration Workflow Metrics report.

2. When you click Execute, the "Run Declaration Workflow Metrics" wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:

   "Select Layout and Configuration"

   "Select Suppliers for the Report"

   "Select Workflow and Status Range".

3. Select one or more suppliers for the report. You must select at least one supplier.

4. Select Workflow name for the report.

5. Select one Starting Status and one Ending Status for the report.

   For example, the Declarations workflow has these two consecutive statuses: Open to Supplier and Submitted to Manager. To find out how long a supplier took to reply to a declaration request, you would select a Starting Status of Open to Supplier and an Ending Status of Submitted to Manager.
6. When you are done, click Finish.

**BOM Compliance Report**

This report - the most important in PG&C - gives the user a complete view of compliance throughout a BOM for the given specifications. The report displays the AML of items (that have an AML) as well. The report is launched by the BOM Compliance Report button on the Compliance tab of an item (not a manufacturer part or part group).

This report can be set up to run against any revision of the part, even "future" revisions (in the forms of "Latest Released" and "All Pending" revisions).

The Scheduled report gives you the most options. When you add items to the report wizard, another wizard that prompts you to select one of these four options:

- Selected Revision
- Latest Released Revision
- All Pending Revisions
- Latest Released AND All Pending Revisions

After you collect compliance data on custom parts and manufacturer parts, running this report on an assembly helps you identify any items that are not compliant, as well as which manufacturer parts are causing the item to be not compliant. You can run this report on a top-level assembly (TLA), on subassemblies, or on "leaf items" (the last part of a branch in the BOM), against one or more specifications.

The system creates a separate page for each item listed in the report (that is, each item-per-spec).

---

**Note:** The BOM Compliance report displays items and manufacturer parts that do not have a specification associated. This ensures that any late-added parts (that is, a part added through a change but not yet associated with a specification because it has not yet been subjected to a rollup) are at least named in the report.

---

When running the BOM Compliance report from an item, the item and all specifications in its Specifications table are selected to the report automatically. You can optionally choose to run a compliance rollup before generating the report output to get the latest compliance data.

To generate the BOM Compliance report:

1. Open the BOM Compliance report.
2. When you click Execute, the "Run BOM Compliance" wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:
   - "Select Layout and Configuration"
   - "Select Items for the Report"
   - "Select Specifications for the Report"
   - "Select appropriate values for the report input parameters".
3. Select layout and configuration as described in the task for the Part Compliance report.
4. Select one or more items for this report. This requires the user to select a Revision (rev) per item. When adding items, there is a configurable option to run the report against any one of the following:

- Selected Revision
- Latest Released Revision
- All Pending Revisions
- Latest Released and All Pending Revisions

Items whose Exclude from Rollup attribute is set to Yes, this item and its BOM are not included in the report.

However, for those items (same setting), the BOM Compliance report does display the compliance state values. You can prevent compliance state values from being visible by setting Display Excluded Items to No in the report wizard.

5. Select one or more specifications for the report.

6. Select appropriate values for report input parameters:

- BOM Level: select a numerical depth (0-99) from the drop-down list or accept the default All Levels.
- Display Excluded Items: choose No - allows you to omit any items that do not play a role in compliance - or Yes.
- Run Compliance Rollup: choose Yes - allows you to request a calculation of compliance prior to generating the report - or No.

7. When you are done, click Finish.

In the BOM Compliance report result, clicking on the link under Item Number takes you to the Title Block of the corresponding rev of the item. Clicking on the link in Calculated Compliance value takes you to the Compliance tab of the item.

---

**Note:** If you have exported Excel files from the BOM Compliance report, you can link from the Excel file back to the Title Block and Compliance tabs of the item with corresponding revisions in exported Excel files. These links to items always load the Latest Released revision of the item, instead of the corresponding revision of the item. The same issue exists with links on compliance attributes.

---

If a selected specification does not exist in the Specifications table of a selected item, the system returns the message “There is no data to display.” This warning message is also displayed in the report result.

**External Rollups Report**

This report retrieves nightly rollup details of the external rollup task. It includes details about task types, times, and count of content, based on the available history, and includes links on object numbers that failed.

Records are stored for 31 days and then overwritten with new ones.
To generate the External Rollup report:

1. Open the External Rollup report.

2. When you click Execute, the "Run External Rollup Report" wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:
   "Select Layout and Configuration"
   "Select Items/Manufacturer Parts or Part Groups for the Report"
   "Select Specifications for the Report"
   "Select Date Range".

3. For Layout, select Default Layout or Standard.

4. Select one or more items, manufacturer parts, or part groups for this report.

5. Select one or more specifications for the report.

6. Select a date range using the From and To fields.

7. When you are done, click Finish.

Exemptions Report

This report rolls up exemptions for items, assemblies, and manufacturer parts for any given specification. A detailed list of BOM items shows the specific exemption invoked and the recorded expiration date.

To generate the Exemptions report:

1. Open the Exemptions report.

2. When you click Execute, the "Run Exemptions Report" wizard is initiated. You are prompted to accept defaults or make choices on these dialogs:
   "Select Layout and Configuration"
   "Select Item for the Report"
   "Select Specifications".

3. For Layout, select Default Layout or Standard.

4. Select one item, manufacturer part, or part group for this report.

5. Select one specification for the report.

6. When you are done, click Finish.
Appendices A and B are intended for the Agile PLM Administrator who needs to configure PLM and users to work in the PG&C solution.

Appendix A is the primary documentation of the Administrator nodes that are found in Java Client > System Settings > Product Governance & Compliance node folder, namely:

- Sign-off Message
- Compliance Rollup Scheduling
- Compliance Rollup Rule-Setting
- External Rollup (subnode folder)
- Declaration Process Extensions (subnode folder)
- Specification Mapping

The information in this appendix also provides an overview of settings across Administrator that are required to configure the PG&C solution for PLM users. It assumes that PG&C is being configured for the first time; the checklists in this chapter do not attempt to document adjustments that must be made to an upgraded PLM installation.

---

**Important:** In a clustered environment, PG&C External Rollup Task can be disabled on all except one node. Having the PG&C External Rollup task run on only one node will limit the impact of this task to users accessing other nodes in a cluster. To limit the nodes that can run PG&C Rollup, change externalrollup.skipServer to true in the agile.properties file on the cluster admin server. On one or more of the managed servers, alter the Weblogic App Server startup parameters by adding "-Dexternalrollup.skipServer=false". This JVM parameter will override the skip server setting read from the Admin server copy of agile.properties.

---

**Note:** For details about exceptions in configuring PG&C, see the PLM ReadMe and your Oracle Consulting - Agile Practice consultant.

---

The "PG&C administrator" will find the chapters for the end-user in this User Guide useful. It contains more information about:
Configuring the External Rollup Task

As mentioned previously, in a clustered environment, the PG&C External Rollup task can be disabled on all except one node. Having the PG&C External Rollup task run on only one node will limit the impact of this task to users accessing other nodes in a cluster.

To limit the nodes that can run PG&C Rollup, follow these steps:

1. Change externalrollup.skipServer to true in the agile.properties file on the cluster admin server.

2. On one or more of the managed servers, alter the Weblogic App Server startup parameters by adding "-Dexternalrollup.skipServer=false". This JVM parameter will override the skip server setting read from the Admin server copy of agile.properties.

If you do not want to skip rollup task in one node, run Agile as either a command or as a service, as described below.

To run Agile as a command, follow these steps:

1. Go to directory <Agile_home>/agileDomain/bin

2. Edit 'startServerAgileManaged1.cmd/sh', and add one JVM start parameter "-Dexternalrollup.skipserver=false"

   set JMX_SET=-Dcom.sun.management.jmxremote
   -Dcom.sun.management.jmxremote.port=9896
   -Dcom.sun.management.jmxremote.authenticate=false
   -Dcom.sun.management.jmxremote.ssl=false
   -Dexternalrollup.skipserver=false

3. Start Agile Managed Server by running 'startServerAgileManaged1.cmd/sh'

To run Agile as a service (Windows platform only), follow these steps:

1. Go to directory <Agile_home>/agileDomain/bin, and uninstall Agile Service (If the services has been installed before) by running 'UninstallServiceAgilePLMManaged1.cmd'

2. Edit 'InstallServiceAgilePLMManaged1.cmd', and add one JVM start parameter "-Dexternalrollup.skipserver=false"

   set CMDLINE=-server -ms3072M -mx3072M -XX:MaxPermSize=512M -XX:NewSize=1300M -XX:MaxNewSize=1300M -XX:+UseConcMarkSweepGC -Dexternalrollup.skipserver=false
   -Dweblogic.system.BootIdentityFile=C:\$username\cluster/agileDomain/config/boot.properties -Dweblogic.Stdout=%STDOUT% -Dweblogic.Stderr=%STDERR% -classpath "%CLASSPATH%" %JMX_SET%
   -Dweblogic.Domain=agileDomain -Dweblogic.Name=BEJ301279-ManagedServer1
Checklists for Configuring the PG&C Solution

Use the following checklists to configure Agile PLM server settings for PG&C. Again, the content of the chapters for end-users in this PG&C User Guide can be useful to the administrator for “filling in” information about the solution and how it can best be configured.

PG&C-supporting Configurations

- Configure Administrator Privilege - Make sure you can see UOM node and the Product Governance & Compliance node folder, both of which are under System Settings. If there are missing elements, configure the Administrator privilege. For more information, see in Agile PLM Administrator Guide, the chapter on Privileges, the topic “Administrator Privilege.

- Be aware of the log.xml file (established at Install time) and the added ComplianceRollup.log - It is likely that you do not need to configure this, as it should be enabled out-of-the-box; see "ComplianceRollup.log in Log.xml File" on page A-7.

- Ensure that the Microsoft Excel-based Client has been properly installed - Your company may want to use the integrated Microsoft Excel-based Client, which facilitates the process of your suppliers completing certain declarations.

- Configure process extensions - There are several out-of-box process extensions that apply to PG&C. Assign the PG&C extensions to the proper class, as described in Integrated Components for PG&C; also see the chapter on Process Extensions in Agile PLM Administrator Guide.

Modify Default Admin User Roles for Specification Management Task

For the Specification Management Task to work, the default admin account must have certain privileges added.

To add the privileges required for the Specification Management Task to work:

1. In the User Settings node of the Java Client Admin tab, double-click Users.
2. Select Last Name in the Filter By drop-down list.
3. In the Value field, enter the word Administrator and then click Apply to search for the Admin Administrator user.
4. In the search results, double-click the Admin Administrator account. (This is the default admin account created during installation).
5. On the General Info tab, scroll down to Role(s).
6. Click in the Role(s) field so that the selection window appears.

3. Run 'InstallServiceAgilePLMManaged1.cmd', then start Agile as service.
7. Find the Compliance Manager, Component Engineer, and Change Analyst roles on the Choices side.

8. Move the Compliance Manager, Component Engineer, and Change Analyst roles to the Selected side.

9. Click OK.

10. Click Save.

The Compliance Manager role is required in order to attach the resulting log file to the specification and modify pending declarations by adding the new specification. The Component Engineer role is required in order to modify manufacturer parts by adding the new specification. The Change Analyst role is required to modify preliminary items by adding the new specification.

If desired, the Agile administrator can create one role to perform these functions, and then add that role to the Admin Administrator account.

**PG&C-specific Nodes**

- Configure the PG&C nodes in Admin - These are:
  - System Settings > UOM node - see "Unit Of Measure (UOM)" on page A-12.
  - System Settings > Product Governance & Compliance node folder, which in turn includes:
    - Sign-off Message node - see "Sign-off Message" on page A-12.
    - Compliance Rollup Scheduling node - see "Compliance Rollup Scheduling" on page A-12.
  - Change the names of the compliance states, as needed - You can change the names of the compliance states to fit the requirements of your company. See "Renaming Compliance States" on page A-17.
  - External Rollup node folder -- see "Setting External Rollup" on page A-12.
  - Supplier Declaration Process Extensions node folder - see "Supplier Declaration Process Extensions" on page A-17.

**PG&C-specific Classes**

- Configure the PG&C-related classes - Substances, Specifications, Parts/Documents, Manufacturer Parts, Part Groups, and Declarations classes - see "Declarations Classes in Brief" on page A-6 and "Configuring the PG&C Classes" on page A-21; the items listed below are discussed in the latter section.
  - Configure the Composition Type attribute - The Composition Type attribute is required in a part or part group for a composition to be imported into the part. It must be set to Visible and Required, and users must be able to Read (privilege) it to ensure the View Substances link is enabled on the Compositions table in items, mfr. parts, and part groups. See "Composition Type in Parts and Part Groups" on page A-23.
  - Use the "mapping feature" to configure flex fields - Mapping of attributes is required for some Page Two / Page Three attributes in parts and part families
so they will distribute changed values on published declarations that are associated with those parts. See "Mapping Feature in Parts and Part Groups" on page A-24. Parts and Part Groups: Mapping Feature.

- Add applicable exempted substances to specifications from the Exemptions list (Lists node) - Exemptions field on General Info of a specification can be populated with substances selected from the Exemptions list.

- Configure the Part Groups class and create part families - If your company has purchased both Product Cost Management (PCM) and PG&C solutions, you must decide how to configure the Part Groups class. See "Part Groups: Configuring Part Families" on page A-26.

- Configure SmartRules - If you have both PG&C and PCM solutions, you must also properly configure the Force Commodity and Part Family to be Identical SmartRule.

**Note:** Please note that PG&C does not support compliance rollup of "recursive BOMs" (a BOM in which a subassembly "names itself" in its own BOM). To avoid recursive BOMs, set the SmartRule "BOM Multi-Level Recursion" to Disallow.

### PG&C Users and Workflow

- Define PG&C users and assign them appropriate roles - Define those users within your company who will create and manage compliance projects, RFIs, and the PG&C objects. Add users to Compliance Searches and Reports (detailed in PG&C User Guide). Assign those users appropriate roles; see "Defining PG&C Users - Roles and Privileges in PG&C" on page A-28. For information about setting up new users and user groups, see Agile PLM Administrator Guide chapters, "Users" and "User Groups".

**Note:** Be sure to understand how to enable users to archive compositions, and the hazard of assigning the appropriate privilege to too many users. See "Archiving and Unarchiving Compositions in Items and Mfr. Parts" on page 4-4.

- Configure the Declaration default workflow - See "Using the Declarations Workflow in RFIs" on page A-29.

The My Open Declarations criteria must be changed to permit suppliers receiving custom workflows.

### Suppliers

- Define a PG&C Supplier subclass and create PG&C supplier firms - Before you define specific supplier firms, examine the "out-of-box" Supplier subclasses. These were tailored for RFQs and the sourcing process (PCM). Note, for instance, that these objects all have a Commodities tab, which is the PCM-related subclass of the Part Groups class, instead of a Part Families tab. You might rename and reconfigure one of the existing Supplier subclasses; or, you might create "compliance-oriented" subclass(es) of Suppliers that pertain to your compliance requirements more specifically.
Note: Unless you define the Supplier field for a class of declaration (or all declarations) as 'Not Required', an Active supplier must be named by the user who creates a declaration. Currently it is not required that the supplier be a Web Supplier (that is, in Supplier object, Web Supplier field = Yes; when Web Supplier field = No, the supplier is called "non-Web Supplier"); PLM allows declarations to name either kind of supplier, but a Web Supplier must have at least one associated "Default Declaration Recipient", while a non-Web Supplier may be named in the declaration with no associated default declaration recipients.

For more information about creating and managing suppliers, see "Managing Suppliers" on page 13-1. You may also want to refer to the chapter on "Supplier Groups" in Agile PLM Administrator Guide.

- Populate supplier firms with Default Declaration Recipients - Most important is deciding which Restricted supplier users will work in Agile Web Client (standard user interface) and which in the "Basic mode" of Web Client (a modified interface for supplier users). The simplified version of Web Client is seen by Restricted users whose Response Edit Mode user preference is set to Basic. If the Response Edit Mode user preference is set to Advanced Table Edit or Advanced Wizard Edit, that user will see full Web Client.

Note: When you create default declaration recipients, decide whether their Approval Password can be the same as their Login Password.

Declarations Classes in Brief

The PG&C business classes - Substances, Specifications, Part Groups, Declarations - are described fully in the PG&C User Guide. This overview of the Declarations classes is for the administrator’s reference.

A declaration is the main object of record in the PG&C solution. Declarations keep track of all the substances and materials that are contained in parts and part groups. When a declaration is released, the information gathered from it is published to the product record, thereby updating the composition data contained by the declaration.

The Declarations base class has seven default classes of declarations, each with a single child subclass. The following table defines the kinds of declarations in PG&C.

<table>
<thead>
<tr>
<th>Declaration class</th>
<th>Definition</th>
<th>Specification type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substance Declarations</td>
<td>The supplier is requested to provide compliance information for each substance within the specification.</td>
<td>must be part-level spec</td>
</tr>
<tr>
<td>Homogeneous Material Declarations</td>
<td>The supplier is requested to provide a complete BOS breakdown of the part and provide compliance information at the homogeneous material level.</td>
<td>must be homogeneous-level spec</td>
</tr>
<tr>
<td>Part Declarations</td>
<td>Receive part-level compliance information as well as other composition information (manufacturing parameters).</td>
<td>can add any type of spec</td>
</tr>
</tbody>
</table>
This section provides information about configuring process extensions and other integrated components in PG&C. In some cases, the components may have been integrated during installation.

### ComplianceRollup.log in Log.xml File

A log called ComplianceRollup.log is a component of the log.xml file, which is established at Install time. You can change these locations as required. Log.xml is found in `<AgileInstallFolder>\AgileDomain\config`

ComplianceRollup.log is enabled out-of-the-box; whenever a scheduled compliance rollup is started, this log session is written to:

- In WebLogic environment: `<AgileInstallFolder>\AgileDomain\log`

Both the "one-time" special log for the Compliance Migration Task and the log of the nightly scheduled rollup are captured in this log.

Information written to this log can be set to one of these two log types: Info[rmation], or most complete information, or Error, or information about errors only. Also, it can be turned off.

Once a rollup is triggered, the log session is ongoing. The Info setting reports on such factors as how many parts are present in the rollup, how many parts have been processed, and how many there are still to run.

More specifically, the contents of ComplianceRollup.log are as follows ("flagged" refers to an object’s Need Compliance Check attribute changing from No to Yes and therefore being examined by the system for compliance during rollup):

<table>
<thead>
<tr>
<th>Declaration class</th>
<th>Definition</th>
<th>Specification type</th>
</tr>
</thead>
<tbody>
<tr>
<td>JGPSSI Declarations</td>
<td>The supplier is requested to provide compliance information (weights) according to the JGP standard. There is now a fully supported Japanese version of the JGPSSI template for creating JGPSSI Declarations; see your administrator.</td>
<td>must be part-level spec</td>
</tr>
<tr>
<td>Supplier Declarations of Conformance</td>
<td>A questionnaire to assess supplier compliance with specifications from customers and government agencies. The survey addresses compliance at a general company level. Can be used for CSR type declarations.</td>
<td>can add any type of spec</td>
</tr>
<tr>
<td>IPC 1752-1 Declarations</td>
<td>A Joint Industry Guide (JIG) substance declaration for electronic products. The 1752A type supports IPC 2.0 and REACH compliance.</td>
<td>specs should be part level</td>
</tr>
<tr>
<td>IPC 1752-2 Declarations</td>
<td>A Joint Industry Guide (JIG) homogeneous-material declaration for electronic products.</td>
<td>specs should be homogeneous-level</td>
</tr>
</tbody>
</table>

---

**Note:** Substances and substance groups are pre-populated only in Substance Declarations.
Part 1: a. Latest Released Shippable Items; b. Pending Shippable Items
Part 2: a. Flagged Part Groups; b. Flagged Items; c. Flagged Manufacturer Parts

For each part of the rollup, the Compliance Rollup log includes: Process Log—every 1000 parts; Large BOM info; and, Causes of rollup failure.

Note: The AXML schema has been changed from
http://support.agile.com/misc/axml/2006/03/ to
http://support.agile.com/misc/axml/2007/03/

Although installation of Agile PLM may have been successful overall, it is recommended that you confirm the results of this particular component so that users do not encounter problems later. Refer the Installing Agile PLM with WebLogic Server to install Agile PLM.

Also, the administrator must set users’ Language and Encode user preferences to the appropriate setting to work in that language in the Agile clients’ user interfaces.

Configure Process Extensions (non-Events-based) for PG&C

This information refers to “non-Events-based” process extensions.

The out-of-box process extensions specific to PG&C are listed below apply to the various Declarations classes. These special export and import commands let suppliers integrate data in declaration requests with other Agile PLM systems or complete the requests in other clients, such as Microsoft Excel or Adobe Reader.

Each process extension must be assigned to the appropriate classes. This likely has been done during installation; if it has not been done, please refer to Agile PLM Administrator Guide, chapter on Process Extensions, section on “Assigning Process Extensions to Classes”.

In other words, you must verify the URLs on the process extensions under Data Settings > Process Extensions: the server name on these URL-based process extensions should match the server name on the login URL; if the application server is pointed to a different database, you must configure these URLs manually (as follows).

To manually configure the Rollup in Excel, Import aXML, and Export aXML process extensions, set these values:

For <http>://<server>.<domain>.com:<port>/<virtual_path>/

- <http> should be replaced by "https" if SSL has been enabled
- <server> is the name of the server
- <domain> is the fully qualified domain
- <port> is the port number of the Web server (if port 80 is used, you can omit the port)
- <virtual_path> is the application server virtual path; the default is "Agile"

Below are examples for Export aXML and Import aXML:

Export AXML:
Import AXML:
http://pgcdemo.agile.agilesoft.com:8888/Agile/default/MDOImportPX.jsp?f

type=AXML&internalurl=true&height=190&width=350

You may need to work with an Oracle Consulting - Agile Practice representative or with Oracle Agile Support to effectively configure the PG&C process extensions: see the Preface of this guide.

Note: "Supplier Declaration Process Extensions" on page A-17 presents another aspect of process-extension configuration, namely, selecting which ones are visible to suppliers in their declaration requests.

<table>
<thead>
<tr>
<th>Process Extension</th>
<th>Assign To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import JGPSSI</td>
<td>JGPSSI Declarations class</td>
</tr>
<tr>
<td>Export JGPSSI</td>
<td></td>
</tr>
<tr>
<td>Import aXML</td>
<td>Homogeneous Materials Declarations class</td>
</tr>
<tr>
<td>Export aXML</td>
<td>Part Declarations class</td>
</tr>
<tr>
<td></td>
<td>Substance Declarations class</td>
</tr>
<tr>
<td></td>
<td>Although these two PXs are assigned to these 3 classes of declarations out of the box, they can be assigned to the other declaration classes.</td>
</tr>
<tr>
<td>Import IPC XML</td>
<td>IPC 1752-1 Declarations class</td>
</tr>
<tr>
<td>Export IPC XML</td>
<td>IPC 1752-2 Declarations class</td>
</tr>
<tr>
<td>Import IPC 2.0 XML</td>
<td>IPC 1752A Declarations class</td>
</tr>
<tr>
<td>Export IPC 2.0 XML</td>
<td></td>
</tr>
</tbody>
</table>

The data format for these export and import commands is predefined by the Agile XML (aXML) format, the JGPSSI template, and the IPC 1752-1 and -2 forms. You must work in Agile Content Service (ACS, see ACS Guide, administrator chapter) or Agile Integration Services (AIS, see AIS Developer Guide) to configure your system to export and import aXML files.

IPC 1752x Declarations

The IPC 1752 Declarations classes are material declarations which support the compliance data gathering for the EU RoHS regulations. Only the enhanced IPC-1752A standard includes China RoHS and REACH.

These declaration classes support compliance data gathering via the IPC-1752 standards. The IPC-1752x family of standards establishes a standard reporting format for material declaration data exchange between supply chain participants. IPC-1752A is the latest version of the standard, version 2.0, which supports REACH compliance. IPC-1752A supports reporting multiple parts, reorganization and simplification of the reporting levels. It removes the list of substances out of the standard into informative annexes to improve the ease of updating data exchange.

IPC past standards (IPC 1752-1) and homogeneous materials declarations (IPC 1752-2) supported data entry PDFs for collecting data. IPC-1752A does not support PDF forms; instead the electronic signature resides within the XML data.
BOS Data Delivered by Scriba Tool
To use the new IPC 175x Version 2.0, you need to download the Scriba1750a_beta06 from http://sourceforge.net/projects/ipc175xutils/. Scriba is a tool that allows you to enter BOS data. The BOS data is then imported using the Import IPC 2.0 XML process extension.

Privileges
A user must be assigned the Import and Export privileges to complete IPC declarations. If you think your privileges do not include these, see your Agile Administrator.

Classes and Subclasses
Your administrator must create a new subclass of IPC 1752-1 declarations in Java Client.

IPC Formats Supported in this Release

- IPC 1752A is supported by XML only; PDF forms are not supported.
- IPC 1752-1 and 1752-2 are supported by XML and PDF forms. Please note that while you can use PDF forms, they are no longer supported by IPC in version 2.0.

As you create 1752-1 and 1752-2 declarations, you are given the option to choose the 1752A version. We provided two new process extensions to support IPC 1752A version: Import IPC 2.0 XML and Export IPC2.0 XML. IPC1752-1 and IPC1752-2 declarations can enable the two PXs to implement IPC1752A version. This is described in this guide in "Creating Declarations" on page 9-10 and in more detail in the Agile PLM Administrator Guide.

We recommend your administrator create one new subclass of IPC 1752-1 Declarations and one new subclass of IPC 1752-2 Declarations using Java Client.

PDF forms for pre-version 2.0
IPC declarations prior to version 2.0 use PDF forms. Adobe Acrobat version 7.x is the minimal requirement, while Acrobat version 8.x is the recommended release for work with the IPC PDF forms. The website for Adobe Software is www.adobe.com.

The IPC1752-2 PDF form allows entry of unstructured substance data. For instance, the user can enter homogeneous material data in a hierarchical structure or in a flat structure. The system also stores the flat structure within the declaration, which can show the user how the data was retrieved from IPC and how PLM converted the data into a hierarchical structure.

The storing of the flat structure is accomplished through four flex-fields, Text01--Text04, on the part Substances tables. They are renamed as IPC Sub-item, IPC Material, IPC Category, and IPC Substance.

By default, these fields are disabled (not visible), and the flat structure is not stored. In order to capture the flat structure of the composition, these fields must be enabled by the administrator. Even with the flexfields enabled, a user must have Modify privilege for those fields; if not, the flat structure is not stored and the user sees an "Insufficient Privilege" error during the import procedure.
Guidelines for Parts and Specifications on IPC Declarations

In earlier releases, each IPC declaration carried just one specification and just one part/part group. Now, Export IPC 2.0 XML and Import IPC 2.0 XML can support multiple objects.

There is no restriction to the number of specifications or the number of parts/PGs that can be added to IPC declarations. However, if a declaration carries multiple items, manufacturer parts, or part groups and multiple specifications, Export IPC 2.0 XML supports multiple Parts/PGs. This means Export IPC 2.0 XML will export all compositions from the declaration’s <Parts/PGs> tables. Export IPC XML will only export one composition from the declaration’s <Parts/PGs> tables.

Similarly, Import IPC XML will update only one composition, that of the part that was exported. The system identifies this by the part number, rev, and the first specification in the declaration’s Specifications table, which is sorted alphabetically.

Import IPC 2.0 XML will update all compositions, that of the parts that were exported. The system identifies these by the part number, rev, and the related specifications in the declaration’s Specifications table, which are sorted alphabetically. As part of Import IPC 2.0 XML support of multiple compositions, for one item with different revisions, the revisions are distinguished by like this format: 'NumberId [Rev]'.

Administrator Nodes for PG&C-specific Settings

This section describes configuring the following nodes:

- **System Settings > UOM node**
- **System Settings > Product Governance & Compliance node folder, which in turn includes:**
  - Sign-off Message node - configure the sign-off message that your suppliers will (electronically) sign
  - Compliance Rollup Scheduling node - configure Rollup Time and Recurrence Pattern
  - Compliance Rollup Rule-Setting node - configure the AML Rollup rule, Composition Rollup rule, Treat Exempt as Compliant in BOM Rollup rule, and Mass Tolerance Percentage setting
  - External Rollup node folder - for external rollups, includes:
    * Rollup Scheduling - configure the time and recurrence of external rollups
    * Rollup Task Settings - configure external rollup default setting and process extension
  - Supplier Declaration Process Extensions node folder - for each class in the Declarations base class, configure which process extensions will appear in the declaration requests to your information suppliers.
    * Specification Mapping - for Parts, Documents, and Manufacturer Parts classes, configure a mapping between each specification and a PageTwo field that displays the Result Compliance for the part-spec combination
- **Server Settings > Task Configuration node, which includes:**
  - Compliance Rollup Task - configures compliance rollup calculations
  - Compliance Migration Task
- Specification Management Task - configures specification management tasks such as add and replace
- External Rollup Task - configures external rollups

**Server Settings > Preferences node, which includes:**
- Number of Archived External Compositions - configures archived external compositions

**Unit Of Measure (UOM)**

The UOM node allows you to define different units of measure for use in Agile PLM. Units of measure are important in the PG&C solution with so much emphasis on the weight or quantity of restricted substances contained in your products.

**Sign-off Message**

The Sign-off Message node provides a legal disclaimer that is configured at your site. The message field allows an unlimited number of characters. The sign-off message is visible to each supplier who receives a declaration from a compliance manager at your company. The supplier "signs" and returns the declaration to the compliance manager. The text should affirm that the information tendered by the supplier is true, and that the supplier is responsible for any mis-statements in the returned declaration.

---

**Note:** Although the supplier would likely sign off any declaration only once, the rule is that the supplier must sign off for any status he changes in a workflow. This could be a factor to consider if you create a custom declaration workflow in which the supplier is expected to change more than one status. Suppliers can respond to custom declaration workflows, not just the default Declarations Workflow.

---

**Compliance Rollup Scheduling**

This node allows you to manage the start time and periods for a recurring, scheduled rollup to be executed by the system. This will roll up any items marked as Shippable Items, as well as all parts/part groups that have specifications where the Need Compliance Check attribute has switched to Yes.

For rollup scheduling to function, the Compliance Rollup Task in Server Settings > Task Configuration must be enabled. See *Agile PLM Administrator Guide* chapter on Task Configuration.

The Rollup Time settings let you set a start time (Hour:Minute) for your regular rollup. The Recurrence Pattern settings let you select a daily (or nightly) or weekly regular rollup schedule.

**Setting External Rollup**

The External Rollup node includes two settings, Rollup Schedule and Rollup Task Settings, which are used to enhance performance on scheduled rollups.

**Rollup Scheduling**

Administrators use the Rollup Scheduling rule to manage the start time and periods for a recurring, scheduled external rollup to be executed by the system.
Note: The rollup task may take some time to complete. As you estimate the total time for extract data and rollup, if the two actions cannot be done in 48 hours, you must adjust the following parameter in agile properties file for PG&C external rollup. Otherwise the external rollup task may fail. The configuration setting is:
EXTERNAL ROLLUP (IN DB LEVEL) DEFAULT TIMEOUT IN SECONDS
externalrollup.UserTransaction.timeout=172800

Note: The default value is 172800 seconds (48 hours).

Rollup Task Settings
Use the Default External Rollup field to set external rollup as the default rollup.
A process extension is then associated to the server task using the Process Extension attribute. Refer to the Agile PLM Administrator Guide for instructions for setting up process extensions.

Compliance Rollup Rule-Setting
This node sets rules that operate during compliance rollups, whether they are started manually or automatically.

Strict and Relaxed Rollup Rules
The AML Rollup and Composition Rollup rules let you select Relaxed or Strict for these two types of compliance rollup. The default for both these rules is Strict, or "worst" case. This means that all present elements must be compliant. The Relaxed setting ("best" case) means that only one element present must be compliant. ("Relaxed/strict" is also known as "best/worst."). Compliance rollups are documented in Chapter 10 of PG&C User Guide.

AML Rollup Rule
The AML Rollup rule sets the best/worst guideline on how the compliance of an item is determined, based on compliance of the manufacturer parts associated with the item. For instance, if there are two manufacturer parts in an item, the Strict setting means that the item will be compliant only if both manufacturer parts are compliant. The Relaxed setting means that the item can be compliant as long as just one manufacturer part is compliant.

Composition Rollup Rule
The Composition Rollup rule sets the best/worst guideline on how the compliance of a part or part family is determined, based on compliance of the compositions of the part/PG, which implies the presence of suppliers. So, if four suppliers are represented on a part's compositions, the Strict setting means all four suppliers have to declare the part is compliant for the composition rollup to result in the Compliant state.

Scheduled Rule
Scheduled Rollup offers a choice to the administrator that can enhance performance on scheduled rollups.
The setting All Shippable Items is the general setting, and reflects how PG&C operated in Rel. 9.2.x (without this rollup rule and its optional setting, below). By setting the rule to All Shippable Items, every scheduled rollup - that is, those run automatically per the settings in Java Client > Admin tab > Server Settings > Task Configuration > Compliance Rollup Task - calculates the current compliance for both Pending revisions and Latest Released revisions of all shippable items in the product record. This is the preferred setting for companies that are in the initial phase of evaluating compliance across the product record.

However, for large companies with many products, this system calculation could take a long time. The option is to set this rule to Impacted Shippable Items. This setting instructs the system to find those items and manufacturer parts that have been modified since the last scheduled rollup, which are "impacted parts". Based on these impacted parts, the system determines their shippable TLA’s (top-level assemblies), again Latest Released revisions and all Pending revisions, and then performs the rollup on these, the "Impacted Shippable Items".

Once your company has been evaluating products and components for compliance through PG&C for some time (what can be called a "steady state"), you may realize a performance benefit by changing the setting of this rollup rule to Impacted Shippable Items.

**Automatic "Fallback"**

There are a couple of situations that will prompt the system to "fall back" to the full rollup of "all shippable items" even if this rollup rule is set to Impacted Shippable Items:

- If the number of impacted parts is greater than 5% of all shippable items, the system automatically reverts to full rollup;

- As stated above, Internally the system tries to identify the top-level shippable item for the impacted parts; however, if the system determines that it will take more time to find the shippable parents for the impacted parts in the record, the application automatically reverts to full rollup.

**Note:** This automatic "fallback" capability is in place for performance reasons.

**Treat Exempt as Compliant in BOM Rollup Rule**

This rollup rule governs the special use of the Exempt compliance state: Treat Exempt as Compliant in BOM Rollup is a Yes/No setting (No is the default) that permits a company to declare a BOM (that is, an assembly or product) as Compliant even if some components are flagged Exempt.

Because Exempt is one of the ‘non-compliant’ compliance states, a part that is declared Exempt can render the entire assembly Exempt. By setting this rule to Yes, once a part is Exempt, the rule prevents "Exempt" from rolling all the way to the top of the assembly.

Of course, other parts in the assembly may have more serious non-compliance problems, so this setting does not bypass those states being rolled up.

Also note that the ability of the administrator to change the names of default compliance states makes it possible to change Compliant to, for example, "Compliant with possible Exemption."
Mass Tolerance Percentage Setting

Mass Tolerance Percentage ("MT%") is used to determine if a composition can be considered “fully disclosed” despite a slight discrepancy.

(Although it is located in Compliance Rollup Rules subnode, because this value does not govern outcomes of compliance rollups in the same way that the other rollup rules do, Mass Tolerance Percentage is really a “setting”.)

The MT% setting enables the system to determine the disclosure type of the composition, and whether an "Unreported" substance needs to be added to a composition (more detail is given below after other concepts are introduced).

Mass Tolerance Percentage facilitates error correction, so the setting will likely be quite small, for example, perhaps 0.1%. The default is 0%, which is equivalent to "no tolerance" of any discrepancy. The discrepancy can be set to a maximum of 5%; the system will not accept a value greater than 5%. Values can be expressed in decimals to an unlimited place.

The concept of mass tolerance works with other "substance-disclosure" features, including mass disclosure (discussed in next section) and the use of the "Unreported (System)" substance. These features are described below, even though the administrator does not have to configure them; for more information, see the PG&C User Guide.

---

**Caution:** The Mass Tolerance Percentage setting and the "Unreported (System)" substance feature are used expressly to account for small discrepancies between part mass and substance mass. They are *not* to be used to "hide" a portion of substances in a declaration that could be thought of as a proprietary formula (or "recipe") in a manufacturer's product. Although this may be in a future release of PG&C, proprietary hiding is currently *not* supported in PG&C.

---

How System Uses Mass Tolerance Percentage

For example, let Mass Tolerance Percentage be set to 1% and part P1’s mass is 90 g. The composition will be identified as Fully Disclosed as long as the sum of its materials (the Bill Of Substances mass) is at least 89.1 (because 1% of 90 is 0.9). (This is a simplification to illustrate MT%: for the composition to be considered Fully Disclosed by the system, it would also check the substances under each material, not just the material weight, as mentioned here.)

Mass Tolerance Percentage is used only when the sum of the substances’ mass is lower than the immediate parent’s mass, whether for a substance composition or for a homogeneous material composition.

When the sum of substances’ mass is higher than the parent's mass, the system automatically considers the composition as Fully Disclosed.

Note that in homogeneous material compositions, MT% is actually used twice:

- First, when the sum of materials (parents of substances) is less than the part mass. In this case, when the difference is greater than the MT% value, the composition becomes Partially Disclosed (there is no "Unreported Material").
- Second, when the sum of substances’ mass is less than the material (or subpart) mass. In this case, if the difference is within the MT% value, no unreported substance is added; if the difference is greater than the MT% value, the system adds the "unreported substance" to accommodate the difference in mass under that material or subpart.
The MT% setting operates “going forward” upon any composition that is calculated by a user from the time it is set in Administrator. When you change the MT% value, the system gives this warning: “Changing the Mass Tolerance Percentage value does not automatically affect previously calculated rollup results for existing compositions. If you want to recalculate the rollup result for an existing composition, run Calculate Compliance on its declaration. Click Yes to change the value.”

Mass Disclosure - Full, Partial, and No Disclosure - and Unreported Substances

The Admin List "Mass Disclosure" (Admin > Data Settings > Lists > Mass Disclosure list > Lists tab) has three values: Fully Disclosed, Partially Disclosed, and Undisclosed. The correct value is generated by the system during composition rollups. The attribute is found on the Composition tab of parts and part groups, and on the Part/PG tabs of declarations.

■ Full Disclosure or Fully Disclosed composition:
  – A Substance composition is considered to be Fully Disclosed if the difference between the part’s mass and the sum of the masses of all the substances is less than or equal to the Mass Tolerance Percentage setting.
  – A Homogeneous Material composition is Fully Disclosed if this two-step process is satisfied: (1) The difference between each material’s mass (that is, the immediate parent of the substances) and the sum of mass of the substances under that material is less than or equal to the Mass Tolerance Percentage setting; and, (2) The difference between the part’s mass and the sum of mass of the parents of the substances should be within the Mass Tolerance Percentage.

■ Partial Disclosure or Partially Disclosed composition: The difference is more than the Mass Tolerance Percentage, in which case an “Unreported” substance is added by the system to fill in the missing mass.

■ No Disclosure or Undisclosed composition: If the mass is missing for the part, substance, or the immediate parent of the substances, it is considered an Undisclosed composition.

So, if the part and all the substances/materials have masses, and the sum of their masses does not match exactly, the system checks whether the sum of the material masses falls within the tolerance (%) of the part’s mass.

Unreported Substances in Partially disclosed Compositions

When there is discrepancy between the total mass of the part or assembly and the sum of all its constituent substances, PG&C adds a system-generated entity or object that "fills in" the unaccounted difference. The name in the application is “Unreported (System)” and it can simply be referred to as "unreported substance."

The unreported substance is searchable in the application; the user can edit any field in the PageOne or PageTwo of unreported substance, excluding the name. But the user cannot delete the unreported substance once the system has created it. Its presence in a composition is inferred when compliance rollups mark a composition as Compliant but the weights of the part and its substances do not match.

---

Note: An unreported substance should not be added manually by a user. The purpose of the system-generated unreported substance is circumvented if an object called “Unreported Substance” or the like is created and used as a “filler” - the system should be allowed to work its calculations and create the entity as needed.
Renaming Compliance States

Compliance states, compliance rollups, and the business logic at work in rollups are fully described in the Internal and External Rollups chapters in this guide. The default compliance states are Not Applicable, Compliant, Exempt, Waived, Missing Info, and Non-Compliant, the latter four all being 'non-compliant' compliance states.

You are able to change the names of compliance states to fit the requirements of your company. However, you cannot add or remove compliance states, nor change their essential meaning. For example, you might change Compliant to Accepted, and Non-compliant to Rejected. Assigning names that are not consistent with the meaning of the original name could compromise the reliability of compliance rollups.

There are three Administrator lists for compliance states (Data Settings > Lists). When a compliance state's name is changed in the lists (below), it is changed in all existing business objects. It is recommended that name changes be made across all three lists, for consistency and users' clarity. The lists are:

- Part Compliance List
- Calculated Compliance List
- Declared Compliance List

**Important:** Besides making these lists consistent, you must also adjust any process extensions that use the original names in Declared Compliance field. Also, if you are using the Microsoft Excel-based client, you must make Excel style sheets consistent.

For more information about the Administrator lists, see the *Agile PLM Administrator Guide*.

Supplier Declaration Process Extensions

Under the Product Governance & Compliance node folder is a node folder called Supplier Declaration Process Extensions. Here you set which process extensions are visible for each type of declaration request that your Restricted supplier-users receive.

This pertains to the "Basic supplier interface," that is, the simplified version of Web Client that is seen by Restricted users whose Response Edit Mode user preference is set to Basic.

The seven Supplier Declaration PXs are:

- Supplier Declarations of Conformance
- Part Declarations
- Homogeneous Material Declarations
- JGPSSI Declarations
- Substance Declarations
- IPC 1752-2 Declarations
- IPC 1752-1 Declarations
Note: This subnode is not the location to configure process extensions, which is done in Data Settings > Process Extensions, as described in Agile PLM Administrator Guide.

For example, if your PG&C solution does not use aXML, you may remove the Export aXML and Import aXML process extensions from all declarations so they are not potentially confusing to your suppliers.

Important: In the Selected field, the first-listed process extension will appear in each declaration (of that type) as a live link next to the declaration’s name on the home page of the Basic supplier. The other “Selected” process extensions appear when the Default Declaration Recipient opens the declaration itself.

Note that if a process extension is disabled in the Process Extensions node, its name still appears in the Supplier Declaration Process Extensions subnodes. These subnodes configure what Restricted supplier-users potentially see: all Restricted users do not see those process extensions that you leave in the Choices fields in these subnodes. Neither the supplier-users nor your users ever see disabled process extensions.

Note: While it would not make sense to assign the "JGPSSI" process extensions to the "non-JGPSSI" classes of declarations, you can assign the "aXML" process extensions to the JGPSSI Declarations class, depending on your anticipation of what method your suppliers might use (in fact, the "AXML" process extensions can be applied to all the declaration classes). However, there are already three process extensions available to complete JGPSSI-based RFIs, and they are much simpler than working with aXML files, so it is generally not necessary to add the aXML process extensions to the JGPSSI Declarations class.

To configure a class of declarations with process extensions:

2. Double-click one of the Declarations classes. The Choices-Selected dialog appears.
3. Use the Move Right and Move Left arrows to move process extensions to Choices or to Selected.
4. Use the Move Up and Move Down arrows to set the order of the process extensions that are in the Selected field.
5. Click Save. The first process extension in the Selected field automatically appears for those type of declarations as a live link in the Basic supplier interface.

Specification Mapping

Specification Mapping is a node where the administrator can set up a mapping between each specification and (for Parts, Documents, or Manufacturer Parts class) a PageTwo field that displays the Result Compliance for the part-spec combination. This mapping simply allows users to see the Result Compliance for a specification on the
PageTwo of the part, rather than forcing them to go to the Compliance tab > Specifications table.

For each specification in the PG&C system, the administrator can choose an attribute (or creates a user-defined flex field) of List type on PageTwo (of Parts class or Documents class or Manufacturer Parts class), in which its value is copied from the Result Compliance field (Compliance tab > Specifications table > Result Compliance).

You can map the same specification to different PageTwo attributes for the different Items and Mfr.Parts classes.

Then, when a part is rolled up for compliance, and therefore has a value (a compliance state) in the Result Compliance field on its Specifications table, that value is also copied to the mapped attribute on PageTwo of the part. More specifically, the Result Compliance (RC) value of the specification is copied to the mapped PageTwo field if any one of the following events occurs:

- a rollup is done on the Latest Released rev (LRR) or Pending rev of a part or document;
- a rollup is done on a manufacturer part;
- a rollup is done on a BOM: if a child is the LRR, its RC value is copied to the child's PageTwo field; or,
- a rollup is done on an item that is associated with a manufacturer part: the RC value of the mfr. part is copied to the mfr. part's PageTwo field.

To map a specification to a PageTwo field (within Items or Manufacturer Parts):

1. Double-click the Specification Mapping node, the page opens. You will see listed all the specifications entered in your PG&C solution.
2. Select a row for a spec, and select Parts, Documents, or Manufacturer Parts tab (since the mapping can be different for each of these classes).
3. Click the Edit Selected Mapping button. The Update PGC Spec Mapping dialog appears.
4. The Specification field has been selected, and so cannot be changed in the dialog. For the Attribute field, use the drop-down list to select the name of the attribute that you want mapped. (They appear because they are already mapped to the Result Compliance list. Details of the mapping are listed below.)
5. Click OK. Now the row for the spec you selected (for Parts, Documents, or Mfr.Parts) also shows the Attribute you selected.
6. Later, when the part (item Latest Released rev, or mfr. part) has gone through a compliance rollup, that value will appear in the mapped attribute on PageTwo of the part.

For a PageTwo attribute to appear in the Attribute drop-down list of the Update PGC Spec Mapping dialog, all of the following must be true:

a. It must be a List attribute;

b. It must be enabled (Visible = Yes);

c. It must point to the Administrator List "Calculated Compliance".

Note that the fields Result Compliance and Calculated Compliance both point to the "Calculated Compliance" Admin List.
Notes on Changed Mappings and System Cleanup

You can edit the mappings in the node. Changed mappings affect future rollups; objects that might be affected by the changed mapping do not change if they are not rolled up.

Every time you change the mapped attribute to a new mapping, the system removes the previous mapped attribute and also "erases" the old values from the Pg2 field. Also, if you change the attribute to point to a different list (not Calculated Compliance List), the system removes the mapping and also "erases" the old values from the Pg2 field.

A potential inconsistency can occur if the end-user were to manually change the value in the (mapped) Pg2 field, this change would not be read back to the Specifications table. If this is a concern, the solution is to turn off Modify privilege for the Pg2 field.

The copying of Result Compliance to a Part's Pg2 happens only for the LRR of the part, since Pg2 is always applicable to LRR. So, if the rollup changes the RC of a previously Released rev (or a Pending rev), that value is not copied to the mapped Pg2 field. Similarly, if that Pg2 field is enabled in the item BOM tab, it only displays the value corresponding to the LRR of the item.

When a specification is removed from the system, you do not need to do "cleanup" on the classes. "Cleanup" is automatic the next time you open the Specification Mapping node in Java Client.

Compliance Rollup Task

Administrators use the Compliance Rollup Task to configure compliance rollup calculations. This is addressed in more detail in "Scheduled Rule" on page A-13.

Note: The Compliance Rollup task is run only after the Specification Management task has completed.

Compliance Migration Task

Administrators use the Compliance Migration Task to configure compliance migration. The only settings are whether the task is disabled or not, and the task start time.

Note: Changes are written to a log file, as described in “ComplianceRollup.log in Log.xml File” on page A-7.

Specification Management Task

Administrators use the Specification Management Task found in Admin > Server Settings > Task Configuration to enable the add and replace functions. When users select objects to add or replace specifications, the objects are added to a queue to process when this task starts. Duplicate objects are filtered out of the queue.

Note that the Compliance Rollup Task is run only after the Specification Management task has completed.

External Rollup Task

Administrators use this task to configure the Add and Replace specification management functions.
Number of Archived External Compositions Preference

Under Server Settings > Preferences, use the Number of Archived External Compositions field to configure archived external compositions. This parameter is used to limit the number of archived external compositions.

On creation of new external compositions, the oldest archived composition will be deleted if the number of archived compositions exceeds the Number of Archived External Compositions setting.

The default setting is 2; you cannot choose a number less than 0.

For more information on the impact of this parameter in archiving external compositions, see "Archiving and Unarchiving Compositions in Items and Mfr. Parts" on page 4-4.

Configuring the PG&C Classes

When you customize a PG&C-related class, all its subclasses are affected. Items and Manufacturer Parts are already likely involved in the Product Collaboration solution for your company, so you must be careful when working at the class level of these business objects. Similarly, the Part Groups class may be involved with the Product Cost Management solution as well as PG&C. You can configure Items, Manufacturer Parts, and Part Groups tab attributes to pull values from other parts and part groups.

More information about configuring Classes, Users, and Roles are found in Agile PLM Administrator Guide.

Subclass required for IPC 2.0

With the introduction of IPC 1752A, your administrator will create a new subclass of IPC 1752-1 Declarations:

Name: IPC 1752-1 Version 2
Description: IPC 1752A Version 2.0 for IPC 1752-1 (Substance Declaration)
Class: IPC 1752-1 Declarations
AutoNumber: Declaration Number

Overall Compliance / Summary Compliance in PG&C Business Objects

This clarifies the presence of an attribute that is named slightly differently in different objects and tabs.

Overall Compliance indicates the compliance state of the part using the worst-case scenario and matched across all specifications associated with the part. This attribute is found on these objects:

Items > Title Block tab > Overall Compliance
Manufacturer Parts and Part Groups > General Info tab > Overall Compliance

The Overall Compliance attribute also reads through to these objects, although in these cases it is named "Summary Compliance". It should be enabled in these tabs as well as those listed above:

Items base class (Parts and Documents) > BOM tab and Manufacturers tab > Summary Compliance
Changes base class (ECOs, MCOs, etc.) > Affected Items tab > Summary Compliance
Adding Exemptions to Specifications

When you or a compliance manager creates a new specification, it can be associated with substances of concern to the regulatory agency. To add exemptions to a specification (Exemptions field on General Info of a specification), first add exempted substances to the Exemptions list; then they are available for selection by the user who creates a specification object. See the chapter on Lists in Administrator Guide.

**Note:** It is a best practice to add exemptions with a "Spec Name" added to each item, facilitating the process when the user selects appropriate exemptions. For example, all the RoHS-related exemptions in the global Exemptions list might begin with "RoHS-".

**Note:** There are also Exemptions fields in declarations (on the <Parts/PGs> tab and on a declaration’s <Parts/PGs> Substances table). The values a user sees for Exemptions in a declaration comes from the associated specification.

Length of Name in Declarations

To avoid potential problems opening declarations with long names, you should restrict declaration names to less than 50 characters for every class that you are enabling the Microsoft Excel-based client. You can do this by making autonumbers required (assuming that each number in the autonumber sequence is less than 50 characters) or by adjusting the maximum length of the Cover Page > Reference Number attribute.

Need Compliance Check attribute not visible in Items

The Need Compliance Check field is no longer visible on items; however, the system still recognizes it and reacts to it in items during rollups. (It remains visible on manufacturer parts and part groups Compliance tab > Specifications table.) The reason for this has to do with items being so central to the Product Collaboration solution. PC-specific change orders means that the Need Compliance Check value (Yes or No) may not reflect the actual compliance state consistently: even if the field is No, the system should run the rollup since a non-PG&C-related change to the item might affect its compliance.

Elapsed Time since Last Rollup Attribute Added in Parts and Part Groups

Elapsed Time since Last Rollup field indicates how long it has been since the previous compliance calculation was done. You do not need to configure this field. You may assist your users by pointing it out on the Compliance tab of parts and part groups, and its use may influence your settings for rollups and the objects involved.

Archiving and Unarchiving Compositions in Items and Mfr. Parts

The Archive and Unarchive buttons are now on the Declarations and Compositions table of items and manufacturer parts. This button is enabled only if the user has the proper Modify privilege for the Declared Compliance attribute on the Compliance tab > Declarations and Compositions table for that part.

On the same table, the user can select in the Views field to filter for Active, Archived, and Pending parts and declarations.

To clarify terms that can be confusing:
- Archive = make a composition Inactive = inactivate the composition
- Unarchive = make an inactive composition Active = re-activate the composition

The use case for "archiving" considers the possibility that non-compliant declarations, when published, could render an entire top-level assembly in the Non-Compliant state.

Those users who have the authority to decide not to buy non-compliant parts should be enabled to use the Archive button to remove offending compositions from the product record.

When a composition is inactivated, that is, removed from Active status, those assemblies containing that part now have a better chance of being in compliance.

However, it is possible that a mistake has been made, and to decide that an archived, Inactive composition should be reinstated as Active. This is accomplished more simply now by filtering for Archived compositions (of the part), selecting the composition (select the row), and clicking the Unarchive button. Re-activation of compositions also applies only to items and manufacturer parts.

When the system is told to unarchive a composition, it automatically archives any "matching" Active compositions (compositions with the same supplier and specification).

If there are compositions with the same specification and same supplier for one item, so that one composition is seen when Views filter is set to Active, and one is seen when Views filter is set to Archived, when you select the archived composition and click Unarchive, the system automatically archives the active composition. This is consistent with established behavior of the system when importing compositions.

Note that, on the item's or mfr.part's History tab, both the Archive and Unarchive actions are recorded. External compositions may not have the Archive action record if the external composition is deleted during the archiving action. For more information about archive settings, see Number of Archived External Compositions Preference.

Both the archiving and unarchiving process cause the Need Compliance Check field on the part to be re-set to Yes, except for external compositions. While that change is visible in manufacturer parts, the field is not visible in items. Moreover, the Archive and Unarchive action may change the compliance states for all specifications on the part or assembly. The best practice is, whenever you change a composition's Inactive or Active state, do a compliance rollup on the part or related assemblies.

**Composition Type in Parts and Part Groups**

The Composition Type attribute is essential to a user's ability to import compositions and substances into parts or part groups (see next topic). When a declaration is published, this field has a value that corresponds to the type of the declaration. If the composition is imported to a manufacturer part, it is "marked" as one of these three types:

<table>
<thead>
<tr>
<th>Composition Type has this value...</th>
<th>...if the composition came from this type of declaration:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Composition</td>
<td>Part Declaration</td>
</tr>
<tr>
<td>Substance Composition</td>
<td>Substance Declaration, JGPSSI Declaration, IPC 1752-1 Declaration, IPC 1752A</td>
</tr>
<tr>
<td>Homogeneous Material Composition</td>
<td>Homogeneous Material Declaration, IPC 1752-2 Declaration</td>
</tr>
</tbody>
</table>
Also, when running a compliance rollup against a specification that has no composition, the system looks at any compositions with no spec that are of the same Composition Type as the specification's Validation Level.

Composition Type is a List attribute (Admin > Data Settings > Lists), with these entries:

- Part Composition
- Substance Composition
- Homogeneous Material Composition.

You must ensure that Classes > <Parts/PGs> clases > User Interface Tabs > Compliance tab > Composition table > Composition Type attribute is visible (Visible = Yes) and required (Required = Yes). Then, ensure that the attribute is included in the AppliedTo property of the appropriate Read and Modify privilege masks (that is, Read Mfr Parts, Read Items, and so forth). There is no default value for Composition Type.

For compositions published from declarations, the system will determine the composition type based on declaration class. For the compositions that are being imported into parts, the user must specify the Composition Type.

Importing Compositions and Substances into Items and Mfr. Parts

PG&C enables users to import compositions and substances into items and manufacturer parts (using Compliance tab > Compositions table). Users can also import specifications (Compliance tab > Specifications table) and suppliers (Suppliers tab) into items, manufacturer parts, and part groups.

You must create Agile-XML (aXML)-format files with composition and composition substances. Then Agile Import is used to import the compositions and composition substances into the system.

Users who need to import PG&C data must be assigned Create, Discover, Read, and Modify privileges for each kind of PG&C object including items and manufacturer parts.

You may consult these Agile documents:

- Importing compositions for the user: PG&C User Guide, Chapter 9, "Importing and Exporting Data in PG&C"
- Using the Import and Export tools: Import and Export Guide

---

**Note:** Contact the Oracle Consulting - Agile Practice for information about Agile XML (aXML) format and to refine your import procedures.

---

Mapping Feature in Parts and Part Groups

Mapping of attributes is required for some Page Two/Page Three attributes in parts (items or manufacturer parts) and part groups so they will distribute changed values on published declarations that are associated with those parts.

---

**Note:** Although attribute versioning is supported in PG&C-attributes on Page Two and Page Three are change-controlled, mapped attributes on Page Two cannot be change-controlled.
For example, let us map some attribute of a part’s Compliance tab:
Part > Compliance tab > Declarations and Compositions table attribute > Date02 field is mapped to
Part > Page Two > Date05.

This can be enabled on PageTwo (class level) or PageThree (subclass level). The crucial attribute is Map Data To. When this part is added to a declaration, the system pulls the Date02 field's value into
Declaration > Items tab > Date05.

Assuming that you have enabled and mapped Part > PageTwo > Date05 and Part > Compliance > Declarations and Compositions > Date02, these two things are true:

1. If you enabled Declaration > Items tab > Part (link) > PageTwo tab > Date02 attribute, then the value from Part > PageTwo > Date02 is pulled into this attribute; however, you cannot edit this attribute since it is a "read-through" attribute.

2. If you enabled Declaration > Items > Part (link) > PageTwo > Date02 (which corresponds to Part > Compliance > Declarations and Compositions > Date02), then you can edit this attribute and the value is published back to Part > Page Two > Date05.

Now let us say the supplier alters the Date02 field while completing the declaration. When the declaration is returned, released, and the data is published to the system, this new value automatically carries over to
Part > Page Two > Date05.

that the mapping works two ways: when adding this item to the declaration, the system pulls the value from the item’s Page Two / Page Three into the declaration's <Parts/PG> table onto the mapped attribute.

Mapping Feature Use Case
Here is a use case: in PG&C there are six Declarations classes that hold compositions (only Supplier Declarations of Conformance do not). Let a List field called List01 be enabled in Parts > Compliance > Declarations and Compositions and be mapped to Parts > Page Two. Be aware that there is a corresponding List01 field in Declaration > Items tab, and that the mapping must be set up in all six classes of Declarations. So, if Parts > Compliance > Declarations and Compositions > List01 is set to point to Continents list, List01 in all of Declaration > Items tab should point to Continents list.

Enabling the Mapping Features
To enable mapping for a given part/part group:

1. For any part, enable some attributes on PageTwo (class level) or PageThree (subclass level).

2. On the part’s Compliance tab, enable some attributes on the Declarations and Compositions table.

3. Map the respective fields:
   Compliance tab > Declarations and Compositions table > flex fields to PageTwo / PageThree attributes.

4. Enable the respective fields in the parts and part families tables of an associated declaration.
5. As pointed out in the use case above, when mapping list/multilist attributes, the corresponding list/multilist attributes in the following should all point to the same list:

- Part or Part Group > Compliance tab > Declarations and Compositions table
- Part or Part Group > Page Two/Page Three tab, and
- Declaration > Items, Manufacturer Parts, or Part Groups tab

For example, if you want the supplier to be able to edit a list attribute that points to "countries" and also want the value to be copied into PageTwo/PageThree when the Declaration is released, make sure all the list attributes in the tabs listed above point to the "Countries" list.

When multiple declarations regarding the same part are sent to different suppliers, the rule in Agile is "Latest Released Wins." This means that the value of a mapped attribute can change if later declarations dictate it. If the new declaration did not have a value on one of the mapped attributes, when it is released, the value on the item’s Page Two / Page Three mapped attribute is not removed.

**Part Groups: Configuring Part Families**

Objects from the Part Groups base class and Part Groups class are used for several purposes in Agile PLM, as reflected by the default subclasses:

- Part Family subclass applies to PG&C
- Commodity subclass applies to PCM (Product Cost Management)
- Item Group subclass applies to PC (Product Collaboration).

★ The configuration information below applies only if your company has purchased both the PG&C and PCM solutions; if not, you can skip this section.

If your company purchased both PG&C and PCM, you can set part families and commodities to behave identically - the default setting - or differently. If you want to use different business rules for PCM commodities and PG&C part families, you have to complete the steps in the task in "Make Available As Attribute".

In the PG&C solution, part families allow compliance managers and suppliers to quickly categorize parts, and are used to collect compliance information on restricted substances for groups or "families" of parts. In the PCM solution, commodities are used to categorize parts for product sourcing. It is important for you to define the part families in your system because RFI responses can be disseminated by the part families that suppliers offer.

**Caution** If the Part Groups class is disabled, you must hide the Part Groups tab in each Declarations class, or the Microsoft Excel-based Client will not properly work for those declarations. Go to Classes > each Declarations class > User-Interface Tabs > Part Groups and set Visibility property to No.

**Force Commodity and Part Family to be Identical SmartRule**

The Force Commodity and Part Family to be Identical SmartRule ("Force/Identical" SmartRule) can be set to Yes or No. This setting has no impact if your company does not own both PG&C and PCM. Assuming your company owns both these solutions, you must decide how your company will use objects from the Part Groups class. You then make the Make Available As attribute visible or not, as needed (using the task in "Make Available As Attribute").
If the "Force/Identical" SmartRule is set to No, the Make Available As attribute could be visible if there are reasons for your users to be able to choose what kind of commodity they create. If the "Force/Identical" SmartRule is set to Yes, it is unlikely you would make the Make Available As attribute visible.

**Make Available As Attribute**

With the Make Available As attribute visible (and assuming the "Force/Identical" SmartRule is set to No), users that create an object from the Part Groups class will be prompted to choose whether to make the Part Group object available in one of these four formats:

- **Commodity and Part Family (the default)** - The part group object is used for collecting parts with similar substances in a compliance context (PG&C) and for collecting similar parts in a sourcing context (PCM).

  **Note:** When the "Force/Identical" SmartRule is set to Yes (that is, the two solutions share the Part Groups class), and a user updates both the Item.Commodity and Item.Part Family attributes, the user must enter the same value for both the Commodity and Part Family attributes. If the values are different, the Agile system ignores the Part Family attribute.

- **Commodity Only** - The commodity object is used for collecting similar parts in a "sourcing" (PCM) context. Only items can be added to the Contents tab. In this configuration, the commodity object cannot be used in declarations.

- **Part Family Only** - The part family object is used for collecting parts with similar substances in a "compliance" (PG&C) context. Both items and manufacturer parts can be added to the Contents tab.

- **Item Group Only** - The item group object is used for collecting parts in the context of "change control" (Product Collaboration). Both items and manufacturer parts can be added to the Contents tab.

To make part group objects behave differently for PCM and PG&C:

1. Under System Settings, double-click the SmartRules node. The SmartRules window appears.
2. In "Force Commodities and Part Families to be Identical," select No, and click Save.
3. Under Data & Workflow Settings, double-click the Classes node. The Classes window appears.
4. Open the Part Groups > Part Groups class, and click the User Interface Tabs tab.
5. Double-click General Info to open it, then click the Attributes: General Info tab.
6. Double-click the Make Available As attribute.
7. In the Visible attribute, select Yes.
8. Click Save.
Defining PG&C Users - Roles and Privileges in PG&C

A user must be assigned the Import privilege to work in Agile Import. This privilege must be added to existing roles and certain "restricted" roles. Because the restricted roles cannot be changed in Java Client, please contact Oracle Agile Support.

A user must be assigned the Import and Export privileges to complete IPC declarations.

A user must have the Add and Replace values applied in the Specification Management privilege in order to use the Add and Replace specification management options.

Be sure to review the section "Setting Privileges for PG&C Objects" in the PG&C configuration chapter in *Installing Agile PLM with OAS / WebLogic*.

Adding Users to Compliance Manager Lists and Compliance Searches

As you configure users for PG&C, remember to consider these two items: users who will work in the capacity of Compliance Manager must have Compliance Manager List selected in their Lists user property; this results in those names appearing in the drop-down list when a user creates a declaration. Also, users must have Compliance Searches selected in their Searches user property to see the folder of compliance searches in Web Client.

There are two out-of-box roles that are specific to PG&C:

- **Compliance Manager (buyer side)** - Provides privileges needed to create and manage PG&C objects and run PG&C reports. This role also has read-only access to parts (items and manufacturer parts). Compliance managers are responsible for routing declarations to suppliers.

  **Note:** When a user creates a declaration and selects a compliance manager, the values on these attributes are added immediately: Title, Phone, email, and Fax.

  The Compliance Manager role has been enhanced to permit configuring the AppliedTo fields in the Read and Modify privileges. This pertains to the Supplier Read Items privilege discussed below.

- **(Restricted) Material Provider (supplier side)** - Provides privileges needed to create, modify, and complete declarations, as well as read all other types of PG&C objects. This role is typically assigned to supplier users, who have restricted access to the Agile PLM system.

  **Note:** The (Restricted) Material Provider role had the (Restricted) Read Items privilege mask; it has been replaced by the Supplier Read Items privilege mask.

  **Caution:** It is possible to remove the (Restricted) Material Provider role from the Modify My Open Declarations privilege mask (Where Used tab), and then it is not possible to restore it, which would be a bad situation. Should this happen, you would start with the Example Roles to save the Material Provider role to a new instance, which will contain the Modify My Open Declarations privilege mask.
**Important:** If you have upgraded your PG&C system to Rel. 9.2.2.4, you will need to manually modify a specific privilege mask in two specific roles. You must add the new Default Declaration Recipient attribute to the AppliedTo field in the privilege mask, as follows.

To Compliance Manager role, Read Supplier privilege mask: add "Suppliers.General Info.Default Declaration Recipient" to the AppliedTo list;

To (Restricted) Material Provider role, (Restricted) Read My Supplier Profile privilege mask: add "Suppliers.General Info.Default Declaration Recipient" to the AppliedTo list.

**Supplier Read Items Privilege**

A new privilege called Supplier Read Items has been added to the following restricted roles: Material Provider, RFQ Responder, and Supplier Manager. You can decide what attributes are enabled for the supplier to see. Previously, the Restricted Read Item privilege was part of these roles, which lacked control over some kinds of information.

**Using the Declarations Workflow in RFIs**

The Request For Information (RFI) process is initiated by a compliance manager, that is, an Agile user who has been assigned the Compliance Manager role. This user creates a new declaration, or modifies an existing declaration, to specify the components for a parts assembly.

The following table shows how the RFI process unfolds via the default Declarations workflow.

<table>
<thead>
<tr>
<th>Status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Compliance Manager creates a new declaration or modifies an existing</td>
</tr>
<tr>
<td></td>
<td>declaration and adds new items, manufacturer parts, or commodities</td>
</tr>
<tr>
<td></td>
<td>Adds specifications to the declaration</td>
</tr>
<tr>
<td></td>
<td>Invites the Supplier of those parts to confirm that they comply with</td>
</tr>
<tr>
<td></td>
<td>the specified regulations</td>
</tr>
<tr>
<td>Open to</td>
<td>The supplier is at the supplier firm, and is an Agile user who has</td>
</tr>
<tr>
<td>Supplier</td>
<td>been assigned the (Restricted) Material Provider role</td>
</tr>
<tr>
<td></td>
<td>Supplier confirms or denies that those parts comply with regulations</td>
</tr>
<tr>
<td></td>
<td>Supplier may also suggest alternative parts that do comply, or comply</td>
</tr>
<tr>
<td></td>
<td>better</td>
</tr>
<tr>
<td></td>
<td>Electronically &quot;signs&quot; and returns the declaration to the compliance</td>
</tr>
<tr>
<td></td>
<td>manager</td>
</tr>
<tr>
<td>Submit to</td>
<td>Compliance Manager verifies the contents of the declaration have been</td>
</tr>
<tr>
<td>Manager</td>
<td>completed by the supplier, and he routes the declarations to approvers,</td>
</tr>
<tr>
<td></td>
<td>acknowledgers, and observers</td>
</tr>
<tr>
<td>Review</td>
<td>Approvers and observers approve or reject the declaration; acknowledgers</td>
</tr>
<tr>
<td></td>
<td>acknowledge the declaration</td>
</tr>
<tr>
<td>Released</td>
<td>By moving the workflow to Released status, compliance manager</td>
</tr>
<tr>
<td></td>
<td>publishes the materials into the product records. Once published, the</td>
</tr>
<tr>
<td></td>
<td>materials are visible on the Item tab, Composition tab, and the</td>
</tr>
<tr>
<td></td>
<td>Manufacturer Part Composition tab</td>
</tr>
</tbody>
</table>
The declaration lists the parts in a product assembly and shows the substances and materials that are contained in those parts. It is linked to one or more specifications, which may restrict how much of a particular substance that product assembly may contain. A declaration is always sent to only one supplier.

When the declaration is returned to the compliance manager, reviewed for verification, and released, the data in the declaration is published to the rest of the system. Unlike other Agile Changes (that is, routable objects that move through workflows), a declaration cannot be unreleased. It can, however, be moved to a previous status without affecting any of the contents.

**Deploying Custom Workflows in PG&C**

Whereas suppliers have previously been able to access only the default Declarations workflow, PG&C permits suppliers to access custom declarations, as long as they are properly set up. To permit access to custom workflows, you must change My Open Declarations from this:

Declarations Cover Page.Status Equal To Default Declarations.Open To Supplier AND Cover Page.Supplier Equal To $USERORG

to this:

(Declarations Cover Page.Status Equal To Default Declarations.Open To Supplier OR Cover Page.Status Equal To Custom workflow <Name>.Open To Supplier) AND Cover Page.Supplier Equal To $USERORG

**Declaration Notifications**

Declaration notifications behave like Changes in Agile. When a declaration is sent to the supplier, the default recipient in the Suppliers tab is notified (of course, depending on the supplier user being correctly configured). When the declaration is returned to the buyer, the compliance manager is notified.

Other PG&C objects support notifications similarly to objects in Product Collaboration.

**Event Management in PG&C**

The Event Management framework can provide benefits to users working in the PG&C solution. Event Subscriptions for compliance rollups can be built on the Compliance Rollup on Object event type.

The Compliance Rollup on Object event type is triggered when a compliance rollup is initiated in these PLM business objects:

Items, Manufacturer Parts, Part Groups:
- when user clicks the Calculate Compliance button;
- when the part is included on a Scheduled Rollup.

Declarations:
- when user clicks the Calculate Compliance button;

<table>
<thead>
<tr>
<th>Status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implemented</td>
<td>Compliance Manager changes the status of the declaration to Implemented once it is manufactured and disseminated in the field.</td>
</tr>
</tbody>
</table>
when a declaration’s Workflow changes status, regardless if this is done manually or automatically.

Additionally, the PG&C business objects support the following Event Types.

Substances, Specifications, Part Groups, Declarations:
- Create Object, Delete Object, Save As Object, Export Object
- Update Title Block
- Update Table (for example: updating Declaration > Parts table, Declaration > Parts tab > Substances table, Part > Compliance tab > Specifications table)
- Update Relationships
- Check In Files, Check Out Files, Cancel Check Out Files

Declarations:
- Approve for Workflow, Audit for Workflow, Change Approvers or Observers for Workflow, Change Status for Workflow, Comment for Workflow, Escalation for Workflow, Promotion Failure for Workflow, Reject for Workflow, Reminder for Workflow.

Examples of PG&C Events

These examples give an idea of how the administrator might tailor Event Subscriptions to benefit users in PG&C. You must read the chapter "Event Management" in Agile PLM Administrator Guide; developers of the (Java and Script) process extensions used by the Events framework must read appropriate chapters in Agile PLM SDK Developer’s Guide.

Example 1
After a compliance rollup is done, could PLM automatically generate a report that summarizes the results of the rollup, or send a notification?

Yes, using the Compliance Rollup on Object event type, you can create an Event Subscription. In a Java PX Handler mask, the system uses SDK calls to retrieve the rollup result, and then it writes the result to a file. You can also create a Notification mask to send the notification.

Example 2
When a user manually initiates Calculate Compliance on a part group, could PLM automatically calculate the compliance of associated items and manufacturer parts?

Yes, using the Compliance Rollup on Object event type, you can create an Event Subscription (with Post-event trigger type). In a Java PX Handler mask, the system uses SDK calls to find the associated items and manufacturer parts, and then it performs the rollup on each of them.

Example 3
When a user initiates a SaveAs from a part, could PLM carry over compliance information, providing certain safeguard conditions are met?

Yes, using the Save As Object event type, you can create an Event Subscription that copies the data from the Specifications table to the newly created object (Post-event trigger type).

Example 4
When a Compliance Manager creates an IPC Declaration (which is for the RoHS specification), could PLM automatically add the RoHS spec to that declaration, instead of the user having to add it manually?

Yes, by doing the following steps:

1. Create a Java PX Handler mask that names a Java process extension that calls SDK APIs to add the RoHS specification into the newly created declaration (the PX needs to be created).

2. Create an Event mask for the purpose, example name Create Object on IPC Declarations.

3. Create a Subscriber mask that binds the Event and Handler masks. The Subscriber would be of Post-event trigger type.
The internal business logic described below is provided for those compliance managers who want to analyze precisely how the system arrived at calculated or result compliance states.

Compliance rollups can be managed by logic built into the Agile PG&C application; we use the shorthand “internal engine” for this approach to compliance management. The internal engine determines compliance at the lowest level within the top level object (part or top level assembly) such that it compares the amount of a substance within each sub-object (part or subpart) against the weight/mass of that sub-object. The rollup is then the worst case scenario of the compliance statuses of the individual sub-objects.

Examples:
- Compliance status of subparts rolls up to set compliance of a part.
- Compliance status of parts rolls up to set compliance of top level assembly.

Alternatively, compliance rollups can be managed by customer-originating systems; we use the shorthand “external engine” for this approach to compliance management. The external engine determines compliance for the top level object (part or top level assembly) such that it rolls up the amount of a substance from all of the sub-objects in the top level object and compares it to the weight/mass of that entire top level object.

Examples:
- Compliance status of a part is the total weight/mass of a substance in all the subparts compared to the weight/mass of the part.
- Compliance status of a top level assembly is the total weight/mass of a substance in all the BOM parts compared to the weight/mass of the top level assembly.

**Internal Rollup Engine Rule Change**

As mentioned earlier in the guide, the internal rollup engine does not handle rollup for REACH; only the external rollup engine does. A specification's attribute of Internal or External qualifies it for the related rollup.

For internal specifications, if no information is found in ‘calculated compliance’ or ‘declared compliance’ attribute, logic treats this as ‘missing info’. The engine rolls up the status to make the bubble red on the Compliance tab header by updating the summary compliance to ‘Missing Info’.

If the rollup engine finds no specifications with rollup set to Internal, the internal rollup engine task is stopped, and instead a rollup of the calculated compliance
System Logic of BOS/Composition Rollups

Be sure you have read "Composition Rollup on Bill Of Substances" on page 7, the following information is supplemental to that section. This summarizes how the rollup works for BOS tree with various substance objects.

Rollup Logic for Substances

If there is a value in the Declared Compliance attribute, the rollup uses this value. If there is no value in the Declared Compliance, the system looks for Declared PPM and uses it for the rollup. If there is no value in Declared PPM attribute, the system looks for substance mass and part mass. If both values are available, the system calculates the PPM, compares it with threshold PPM, and sets the proper value in the Calculated Compliance attribute.

In a Fully Disclosed composition, if the substances or substance groups in the spec are missing in the composition, they become compliant automatically.

In a Partially Disclosed composition, the system checks compliance against the Unreported substance for all the spec substances or substance groups that are missing in the composition. Only when all the specifications' substances or substance groups that are missing in the composition are compliant against the Unreported substance, the composition is considered as compliant for that spec.

If the "Unreported (System)" substance PPM is higher than on the specifications' substances or substance groups that are missing in the composition, then the calculated compliance for that composition or parent of the substances will be Missing Info because the missing substance could be that substance or substance group from the spec, so the system cannot determine the compliance.

Rollup Logic for Substance Groups

If there is a value in the Declared Compliance attribute at the substance group level, the rollup uses this value. If there is no value in the Declared Compliance attribute at the substance group level, it looks for Declared PPM or Declared Mass at the substance group level and uses it for the rollup. If there is no value in the Declared PPM or Declared Mass at the substance group level, it looks for substance mass and conversion factor for all the substances in the substance group (the system does not calculate the compliance for substances within substance group, even if user provided Declared Compliance attribute value, it is ignored), then it calculates the base substance mass for each of the substances (substance mass multiplied by conversion factor), and it updates the calculated mass at the substance group level. If user provided the mass for immediate parent of substance group (it could be part or part group, subpart or material), the system calculates the PPM, compares it with threshold PPM for the substance group (it reads the threshold PPM from spec), and sets the appropriate value in the Calculated Compliance attribute.
Rollup Logic for Materials
If there is a value in the Declared Compliance attribute at the material level, the rollup uses this value. If there is no value in the Declared Compliance attribute, it looks at the children of the BOS tree under the material (it ignores the value in the declared PPM at the material level). If the BOS tree contains a substance group or substances, it uses the logic above to calculate the compliance. If there are multiple substance groups, the material is compliant, providing all the substance groups are compliant. If any one of the substance groups is missing info or not compliant, it affects the Calculated Compliance of the material.

Rollup Logic for Subparts
If there is a value in the Declared Compliance attribute at the subpart level, the rollup uses this value. If there is no value in the Declared Compliance attribute, it looks at the children of the BOS tree of the subpart (it ignores the value in the declared PPM at the subpart level). If the BOS tree contains materials, substance groups or substances, it uses the logic above to calculate the compliance. If there are multiple materials, the subpart is compliant, providing all the materials are compliant. If any one of the materials is missing info or not compliant, it affects the Calculated Compliance at the subpart level.

Rollup Logic for Parts and Part Groups
If there is a Declared Compliance, the rollup uses this value. If there is no value in the Declared Compliance attribute, it looks at the BOS tree for that part. If the BOS tree contains subparts, materials, substance groups and substances, it uses the logic above to calculate the compliance. If there are multiple subparts, the part is compliant, providing all the subparts are compliant. If any one of the subparts is missing info or not compliant, it affects the Calculated Compliance at the part level.

Special Cases that can Result in Missing Info Compliance State
Let there be five substances in a substance group; two of them do not have a conversion factor. The system calculates the substance group mass based on the other three substances, calculates the PPM, and compares it with the threshold PPM from the specification. (Actually, this is only true if the substance has mass, but no conversion factor; if the substance doesn’t have mass, the system just ignores it.) If it is not compliant, it sets the Calculated Compliance to Not Compliant. If it is compliant, then it sets the Calculated Compliance to Missing Info, because the other two substances do not have a conversion factor.

Here are some other potential use cases where Missing Info can be returned as Calculated Compliance:

- The parent mass is not provided to calculate Calculated PPM, so the rollup has nothing to compare with Threshold PPM from the specification, so it results in Missing Info.
- If some of the mandatory substances from the specification are missing in the declaration, even if all the existing substances are compliant, the parent - either material or subpart or part - is marked as Missing Info.

As of Rel. 9.2.2, this depends on the Mass Disclosure Type. The initial statement is true for Undisclosed compositions. For Partially Disclosed compositions, the system attempts to access compliance of missing substances against the "Unreported (System)” substance added by the system. For Fully Disclosed compositions, the missing substances are automatically Compliant.
If the Conversion Factor for a substance under a substance group is missing, but the substance has value in the Mass field, the system flags Missing Info at the substance group level.

In 9.2.2, if the same substance exists in the substance group during import, the system attempts to copy over the Conversion Factor from the substance group.

If the specification does not have any substances (or only "optional" substances), Calculated Compliance is Missing Info.

**Additional Information**

Declared PPM values at the material level and subpart level are not considered by the rollup.

The Calculated PPM is set at the leaf substance and substance group level only (the Calculated PPM for substances within substance group are not calculated).

Declared Compliance values for substances within substance group are not considered by the rollup.

The Calculated Compliance and Result Compliance for substances within substance group and for all Optional substances (either Reporting set to Optional in the spec or substances do not even exist in the spec) are not calculated. In 9.2.2, the system calculates compliance for Optional substances as well, but these results are ignored when calculating the compliance of the parent of substances.

In cases where the system uses the value in Declared Compliance field, it still updates the Calculated Compliance, but the Result Compliance is set to the value in Declared Compliance field.

In cases where the system uses declared PPM, it still calculates the calculated PPM if all the values (mass and parent mass) are available.

**Corner Case**

If the user provided declared PPM for substances within a substance group, the system calculates the substance mass based on the PPM and mass of the parent of the substance group (material, subpart or part), then it uses the same logic for substance group to calculate the compliance. If the parent mass is missing, then it uses the declared mass (if its available) to calculate the mass at substance group level.

**System Logic of BOM/Compliance Rollups**

Be sure you have read "Compliance Rollup on BOM/Items, Mfr.Parts, and Part Groups" on page 10, the information below is supplemental to that section.

**Compliance Calculation**

Compliance Validation is a very taxing operation within Agile PLM. It is currently impossible for the system to catch up in a split second (like Excel) with all changes a user makes in the system that might impact compliance, although this is clearly the goal. The problem is clearly exponential. A compliance change to a manufacturer part will impact all items that have this manufacturer part in their AML. This in turn will impact all top level assemblies and all intermediary assembly levels that have that item in their BOM. In the worst of cases, a small change may require the calculation of the whole system.
Excel has the same problem when spreadsheets get too big. Therefore Excel has introduced the ability to turn automatic calculation off and to use a manual calculation.

PG&C has the same type of a user launched manual calculation option. On top of that PG&C has a timer-based automatic calculation that recalculates the compliance state of everything in the system based on some rules.

**Automatic Calculation**
The system performs a compliance rollup automatically in these cases:

- Per the schedule set by the administrator using Compliance Rollup rules;
- For all items flagged as Shippable Items, all Latest released revs and Pending revs (previously released revs of shippable items are not rolled up again);
- Every part which has Need Compliance Check to Yes for at least one spec.

**Manual Calculation**
Manual calculations always run in the foreground. The calculation happens for the currently selected rev of the item. The user can use the manual calculation to recalculate a back rev if required.

**Calculation and Publishing of Compositions**
Compliance calculation does not happen automatically for an item or manufacturer part upon publishing data from a declaration to the part. When a composition is published, all the specifications for that part are flagged with Need Compliance Check, because the new composition could be Fully Disclosed and it may influence the compliance of existing specs that do not have matching spec compositions; it is set on the corresponding part's Compliance tab > Specifications table (again, it is not visible on items, but it is present and the system responds to it). Its compliance is evaluated either when the user launches the calculation or the next time the automatic compliance validation runs.

When there are changes in an assembly (that is, an ECO changes a BOM or an MCO changes a manufacturer part), there is no trigger to recalculate the compliance. If the item is marked as Shippable Item, the scheduled rollup recalculates the compliance; otherwise, you have to manually run the rollup to calculate compliance.

When importing specifications directly into an item or manufacturer part, after the Import procedure is completed, the system does a composition rollup and updates the Calculated Compliance and Result Compliance on the Composition table; however, it does not recalculate the compliance of all the specifications in the item or manufacturer part. It adds the specifications from the compositions being imported to the item or manufacturer part's Specifications table and sets the Need Compliance Check to Yes.

Note that if the composition being imported does not have a specification, the system does not do a composition rollup after the import. However, as of 9.2.2, it still calculates the PPM for substances and substance groups in the composition, identifies the Mass Disclosure type, and sets Need Compliance Check on all existing specs to Yes.
This appendix includes more details about External Rollups, which were created to deliver REACH compliance. Unlike regular internal rollups, which are built into Agile, the external rollup task can be modified by users. See "Modifying the External Rollup Script" on page C-5.

Excel rollups occur automatically via rollup tasks or actions from the user, such as workflowing a declaration to the ‘Open to Supplier’ status, but they also are performed manually via the Excel Add-In.

Rollup Tasks

As part external rollups, a new server task called External Rollup Task has been created in Admin > Server Settings > Task Configuration. This task operates independently from the internal rollup task. It must be configured to set the time of type of nightly rollup. Actions by the user in the PG&C user interface trigger declaration release and compliance calculation.

For nightly rollups, a server task collects all the objects that need rollup and does compliance rollup on all of them. It executes at the time set by the administrator. When the rollup is complete users receive a notification.

Calculate Compliance occurs as synchronous rollup based on the user selecting Calculate Compliance from the Actions menu.

Declaration Release rollup occurs when a user workflows a declaration to Released status.

For information on configuring the External Rollup Task, see Rollup Task Settings in "Configuring Product Governance & Compliance" on page A-1.

Excel-Based Rollup as an Alternative to External Rollups

An alternative method to the automated external rollup is delivered via Excel-based rollup. This method is described later in this appendix in "Excel Sample for REACH Rollup" on page C-10.

Defining Approach to Compliance Management

Compliance rollups can be managed by logic built into the Agile PG&C application; we use the shorthand “internal engine” for this approach to compliance management. The internal engine determines compliance at the lowest level within the top level
object (part or top level assembly) such that it compares the amount of a substance within each sub-object (part or subpart) against the weight/mass of that sub-object. The rollup is then the worst case scenario of the compliance statuses of the individual sub-objects.

Examples:

- Compliance status of subparts rolls up to set compliance of a part.
- Compliance status of parts rolls up to set compliance of top level assembly.

Alternatively, compliance rollups can be managed by customer-originating systems; we use the shorthand "external engine" for this approach to compliance management. The external engine determines compliance for the top level object (part or top level assembly) such that it rolls up the amount of a substance from all of the sub-objects in the top level object and compares it to the weight/mass of that entire top level object.

Examples:

- Compliance status of a part is the total weight/mass of a substance in all the subparts compared to the weight/mass of the part.
- Compliance status of a top level assembly is the total weight/mass of a substance in all the BOM parts compared to the weight/mass of the top level assembly.

## Concepts

A few concepts in PLM (Product Lifecycle Management) and SCM (Supply Chain Management) are described below. It is important to understand these concepts, as they play a very crucial role in this proposed feature or solution for REACH rollup.

### Alternate IPNs or Items

In manufacturing world, it very common to have a two parts which are interchangeable while building a product. In other words, there are parts, which are of the same F3-form, fit and function where one can be used instead of the other.

Agile, today, does not have a very efficient or mandated way of handling this in a BOM structure. Each customer handles this scenario differently. A very common way of handling this is to put both parts on the BOM of the product and mark one part as alternate with a quantity zero.

### Alternate Manufacturer Parts

Agile allows customers to add more than one manufacturer part (MPN) to an item (IPN). These manufacturer parts are of the same F3 - form, fit and function. In production line or on shop floor at the manufacturing site of the product, these parts will get used interchangeably based on inventory and many other decision factors.

Considering the fact that this is a very common scenario in the industry, we have to take this into account while calculating compliance as any of one the attached manufacturer part can end up in the final product.

### Active Compositions or Declarations

A chemical composition of a given part is called a composition in PG&C. These are gathered using the object type called declarations. A part can have multiple compositions and more than one of them can be active.
If we were to generalize, two active compositions on the same part can be differentiated by looking at which supplier and specification (an object used in PGC to capture compliance regulation thresholds on regulated substances) it belongs to.

Consider an example where a MPN - MPN0023 is being sourced from two different suppliers - ACME and EMS. Assume compliance data or compositions are being gathered for two regulations - REACH1 and REACH2. To gather compliance data (composition) two declarations can be raised, one for ACME and another for EMS, with REACH1 and REACH2 on the MPN - MPN0023. Upon supplier responses agile would have four compositions for the same MPN.

- REACH1 composition by ACME
- REACH2 composition by ACME
- REACH1 composition by EMS
- REACH2 composition by EMS

All the above unique compositions can be active at the same time and are considered while doing rollups.

**Manufacturer Part on Root Node of BOM (Product)**

There are situations where customers associate a manufacturer part to the root node of an assembly. This is to say the product or the BOM is equivalent of the manufacturer part.

In PG&C if a manufacturer part is associated to a product or an assembly, we ignore all of its BOM and rollup the compliance information associated with the manufacturer part.

**External Rollup Flow**

PL/SQL based REACH rollup solution focuses on enabling BOM and substance rollup in a set of external rollup tables. Multiple components join together to become the whole REACH rollup solution.

The External Rollup works by:

1. Extracting Objects that need rollup from the PG&C database (Extract Data PL/SQL)
2. Storing rollup data in staging database tables
3. Running compliance rollup using Rollup PL/SQL (Can be replaced with other rollup engines of choice that can work with tables)
4. Pulling results back in to Agile PG&C tables

These steps are explained more in the following paragraphs.

**Extracting Data**

This component allows extraction and transformation of data from PG&C. The data is extracted at a database level to avoid any performance barriers of Java or Agile SDK.

Data extraction out of Agile is performed using PL/SQL procedures.

- This component resides at the database level as a stored procedure and should not be embedded in Agile server or java code.
Your database administrator can export data out of PG&C database using this procedure by providing object identifiers (for example part number) that are visible in the UI.

**Data Extraction Rules**
Agile PLM stores multiple revisions of any given item. But, not all of them have to be retrieved for REACH rollup.

**External Specifications**
All items or products, Manufacturer Parts and Part Groups with one or more specification marked external are extracted.

**Need Compliance Check Flag**
Check if Need Compliance Check Flag is set.

**Revisions**
Only "Latest" and "Pending" revisions are extracted.

**BOM, AML and BOS**
For each item or product, their BOMs and or AMLs (corresponding Manufacturer Parts) and their Bill of Substances are extracted. If it is a single item, AML and Bill of substances are exported. If it is a product, the BOM, AML and Bill of substances are exported.

**Mass**
If the declared mass is not available no rollup can occur. When mass is not available on any given item, exclude the item from extraction into external rollup tables. RoHS rollup occurs the same as in prior releases.

A script will be provided to find the list of objects that were not successfully extracted to the staging table so that customers can fix the associated data problem and rerun the extract logic.

**Compositions**
PG&C allows multiple compositions for any given item or manufacturer part.

- Only "Active" compositions are extracted.
- Bill of substances are extracted - Materials, Subparts, Substance Groups, Substances, etc. Conversion is done during extract data.

**Compliance Status Normalization**
Normalize the 'Compliant', 'Non-Compliant' and 'Missing Info' flag data with the below given rules when extracting data to external rollup tables.

- If the declared compliance is marked as 'Compliant', treat this as '0' PPM.
- If the declared compliance is marked as 'Non-Compliant', treat this as threshold PPM + 1.
- For 'Missing Info', as per worst-case scenario, we will treat this as threshold PPM + 1 (as this is unknown, the worst case scenario is it can be non-compliant).
Order of Precedence
Follows the same logic that exists for internal rollups (9.3.1).

- Declared Compliance, Declared PPM, Calculated PPM (Mass of the item is required for this).
- For Substance Group without any declared compliance, declared PPM and declared mass value, use the values of declared PPM, declared mass for the child substances under the substance group. In this case, the order of precedence to calculate the mass of substance group will be the declared mass for the substance followed by the declared PPM of the substance. Declared Compliance value for the substance is ignored.

Data Consistency
After the data is extracted, the 'Need Compliance Check' flag is updated to 'Processing'. After external rollup is completed, this flag will be set as 'No'.

Following is the existing logic to reset the external specification's 'Need Compliance Check' flag to 'Yes'

1. New composition (not external composition) is added
   - MDO Publish
   - Import a composition
   - MDO publish with PF (has part association)
   - Composition is Activated
2. A composition (not external composition) is archived/activated
3. Save as item/mfr part/PF with specification
4. Create new revision
5. Add a specification or set the declared compliance with the flag set to Yes

Calculate Compliance and Declaration Release
In external rollup, a server based queue mechanism allows multiple users to submit Calculate Compliance requests at the same time. Clicking Actions > Calculate Compliance submits a job in the queue. Users can navigate to other objects without waiting for the job to complete.

Asynchronous rollup occurs, and records are processed using First In First Out method.

Modifying the External Rollup Script
This external rollup engine is a PL/SQL script shipped with Agile schema. Customers can follow the data schema and modify this with their own rollup logic.

To modify the PL/SQL script, contact Agile Support. The script is shipped as a package, named agile_pgc_external_rollup.

Database Tables
The database contains all the tables needed to store extracted data, to do rollup and to store the rollup results:

- FACT_TABLE - Record the leaf objects along with their compositions info including Qty, composition specification, disclosure type, and so on. On demand
and declaration release use this table. The data out of date will be deleted according to job id.

- **FACT_TABLE_TASK** - Same as FACT_TABLE but is only used for scheduled task type rollup. Considering performance data is truncated directly during the process.

- **RESULT_OBJECT_COMPLIANCE** - Record the top level objects and final rollup results (compliant or non-compliant) in this table. Each top object generates one extract id.

- **RESULT_SUBSTANCE_COMPLIANCE** - Record the detail rollup results for every extract id (substances related to external specification, calculated total weight & PPM & compliance result of each substance). The results data will be kept in this table for 31 days.

- **ROLLUP_COMPOSITION** - For each composition external rollup engine has met during the process, the engine loads the BOS structure and calculates the substance mass according to certain logic. Record these handled data in this table to cache the substance info of composition so that this table will never be deleted/truncated.

- **ROOT_OBJECT** - Record the info of top level objects and related external specification in current external rollup task.

- **SPECIFICATION_SUBSTANCES** - Record the external specification and substances & Threshold PPM defined upon it.

- **tmp_rollup** - While doing rollup the engine picks up worst case for each leaf component object (MPN/BOM) and stores substance SUM value of all leaf objects to this temporary table. It is used to simplify the rollup SQL and improve performance. Once the session ends it is truncated by Oracle DB.

If your company chooses to customize its own external rollup engine, knowing all the fields in each table is necessary. The fields included in each table are listed on the following pages. The fields can be enabled using Java Client.

**Fact Table**

BOM and BOS data are reflected in the Fact Table. Composition information such as quantity, composition specification, disclosure type, etc. are included. Out of date data is deleted according to job id. On demand and declaration release use this table.

ROW_ID
JOB_ID
FACT_ID
COMPONENT_SEQ
COMPONENT_ID
COMPONENT_CLASS
COMPONENT_NUMBER
QUANTITY
COMPOSITION_ID
COMPOSITION_NUMBER
COMP_SPEC_ID
COMP_SPEC
COMP_SPEC_STATUS
COMP_FMD

**Fact Table Task**
Same as FACT_TABLE but is only used for scheduled task type rollup. Considering performance data is truncated directly during the process.
ROW_ID
JOB_ID
FACT_ID
COMPONENT_SEQ
COMPONENT_ID
COMPONENT_CLASS
COMPONENT_NUMBER
QUANTITY
COMPOSITION_ID
COMPOSITION_NUMBER
COMP_SPEC_ID
COMP_SPEC
COMP_SPEC_STATUS
COMP_FMD

**Result Object Compliance Table**
The table records the top level objects and final rollup results (compliant or non-compliant). Each top object generates one extract id. This data is reflected back as direct composition in PG&C.
EXTRACT_ID
JOB_ID
ROOT_OBJECT_ID
CHANGE_ID
SITE_ID
CLASS_ID
COMPOSITION_ID
SPECIFICATION_ID
COMPLIANCE_STATUS
FMD
UPDATE_TO_SERVER
JOB_TYPE
NOTES
CREATED
Result Substance Compliance Table
Contents in this table are shown on Direct Composition > View Substances in Agile. The table records the detail rollup results for every extract id (substances related to external specification, calculated total weight & PPM & compliance result of each substance). The results data is kept in this table for 31 days.

<table>
<thead>
<tr>
<th>ID</th>
<th>EXTRACT_ID</th>
<th>JOB_ID</th>
<th>SUBSTANCE_ID</th>
<th>CALCULATED_MASS</th>
<th>UOM</th>
<th>CALCULATED_PPM</th>
<th>COMPLIANCE_STATUS</th>
<th>RESULT_SUBSTANCE_COMPLIAN_PK</th>
<th>RESULT_SUBSTANCE_COMPLIAN_FK1</th>
<th>RESULT_OBJECT_COMPLIANCE</th>
</tr>
</thead>
</table>

Rollup Composition
For each composition external rollup engine has met during the process, the engine loads the BOS structure and calculate the substance mass according to certain logic. Record these handled data in this table to cache the substance info of composition so that this table is not deleted/truncated.

<table>
<thead>
<tr>
<th>COMP_ID</th>
<th>SUBSTANCE_ID</th>
<th>SUBSTANCE_NUMBER</th>
<th>SUBSTANCE_MASS</th>
</tr>
</thead>
</table>

Root Object Table
Records the info of top level objects and related external specification in current external rollup task.

<table>
<thead>
<tr>
<th>EXTRACT_JOB_ID</th>
<th>ID</th>
<th>ROOT_OBJECT_ID</th>
<th>ROOT_OBJECT_NUMBER</th>
<th>ROOT_OBJECT_CLASS</th>
<th>CHANGE_ID</th>
<th>REV</th>
<th>SITE_ID</th>
</tr>
</thead>
</table>
**Specification Substances Table**
This table records the external specification and substances & threshold PPM defined upon it.

<table>
<thead>
<tr>
<th>ID</th>
<th>SPECIFICATION_ID</th>
<th>SPECIFICATION_NAME</th>
<th>SUBSTANCE_ID</th>
<th>SUBSTANCE_NAME</th>
<th>CAS_NUMBER</th>
<th>LIFECYCLE_PHASE</th>
<th>THRESHOLD_MASS_PPM</th>
<th>REPORTING</th>
<th>SPECIFICATION_SUBSTANCES_PK</th>
</tr>
</thead>
</table>

**tmp_rollup Table**
While doing rollup the engine picks up worst case for each leaf component object (MPN/BOM) and store substance SUM value of all leaf objects to this temporary table. It is used to simplify the rollup SQL and improve performance. Once the session ends it will be truncated by Oracle DB.

<table>
<thead>
<tr>
<th>JOB_ID</th>
<th>FACT_ID</th>
<th>SUBSTANCE_ID</th>
<th>SUBSTANCE_NUMBER</th>
<th>SPECIFICATION_ID</th>
<th>SUBSTANCE_MASS</th>
<th>PPM</th>
</tr>
</thead>
</table>

**Staging Database**
The staging database contains tables required to store extracted data, and the rollup results.

**Transformation Rules**
The rules described below apply to the PL/SQL based rollup solution.
Once you extract the data from Agile, it must be transformed or normalized.
- This component resides at the database level as a stored procedure.
The database administrator can export data out of PG&C database using this procedure by providing object identifiers (for example part number) that are visible in the UI.

The rules to be followed are:

a. All weights are converted to grams.

b. Each Rev (Latest Released or Pending) of an Item or a Product (root level assembly) and its BOM becomes an individual product.

Staging table Rules

a. At any given point in time, there are only product hierarchies affected by changes and their where used available in the staging tables.

b. For a fact change or BOM structure change, all data is wiped out and re-created in staging tables.

c. All items or product BOMs with a specification that are marked External are brought over when deploying new.

Rolling up Data

A PL/SQL procedure rolls up the extracted object data and composition data from the staging database tables, and passes the data back to PG&C, where objects are updated. Objects that have been updated via External Rollup are noted as such. For example, in a Declaration on the Specifications tab, the new field Rollup Engine is updated with "External".

Publishing Results

For new Compositions pulled back to PG&C:

- Compositions are marked "External Compositions" and were created using APIs as opposed to updating the database directly.
- Compliance Status/Flag is returned.
- Retain Substance Level Results are retained in External Rollup Result Tables.
- Substance Level detail in the UI is shown by using a URL process extension on objects.

Excel Sample for REACH Rollup

The Excel rollup provides a manual, non-automated approach to REACH rollup described earlier in this appendix. Excel rollup has been enhanced to support REACH rollup through web services.

Excel for REACH rollup works as follows: Users with the certain privileges can extract compliance data for an item containing an External Specification to Excel, roll up compliance, then submit the results back to Agile.

This section provides a sample for REACH rollup, instructions for use, and logic used in the rollup.


You can find the rollup for download at samplecode.oracle.com in the Agile PLM section. Follow instructions on the site to download and install the rollup.
Before using the Excel sample, the user is expected to do a basic setup of Microsoft Office runtime and executing a registry file to add the web service URL of Agile PLM in to the local machine's registry. Check with your administrator if you need assistance.

Excel rollup works within the current framework of Agile PLM, so the user should have read and discover privileges on items, manufacturer parts, declaration, part groups, subparts, materials, substance groups, substances, composition tabs, etc. In addition, to submit the rollup status, the user must have modify privilege for the Declared Compliance attribute for the specification row that is selected for rollup (found on the Compliance tab).

Once the file is opened, you will see the standard Excel menus as well as an Agile menu under Add-Ins. The Agile menu includes the following options, some of which are disabled as you perform various tasks:

<table>
<thead>
<tr>
<th>Logon</th>
<th>Logs in to the Rollup add-in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Opens a search dialog which you can use to locate items or manufacturer parts.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Rolls up the data. See REACH Rollup Logic for more information on the rollup logic.</td>
</tr>
<tr>
<td>Submit Data</td>
<td>Submits the calculated data in the Excel worksheets to Agile PLM</td>
</tr>
<tr>
<td>Clear Data</td>
<td>Removes all data in the Excel worksheets.</td>
</tr>
<tr>
<td>Logout</td>
<td>Logs out of the Rollup add-in.</td>
</tr>
</tbody>
</table>

Logging Into Excel Rollup

In this section you will set up login for the Excel sample and configure the web service.

1. Open an empty Excel workbook. Notice the Agile PGC menu.
2. Select Login from the Agile PLM menu.
3. From the Login dialog box, click the Options... button.
4. Use the dialog box that displays to enter the web service URL. Enter the following in the URL field to set up the connection server:
   http://server:port/CoreService/services
5. Click OK.
6. In the Login dialog box, enter admin as the User Name and agile as the Password, then click Log In. A successful login enables the Search, Clear Data and Logout functions. You can now begin using the rollup.

Using Excel Rollup

After logging in, the user can use the sample to:

- Search for and select items or manufacturer parts.
- Select a declaration and an external specification for the declaration.
- Load a composition.
- Roll up the data.
- Submit the data to Agile PLM.
These steps are demonstrated below. Please note that the screen and report samples are for informational purposes only.

To use Excel Rollup:

1. Click Search from the Agile PGC menu.
2. In the Object Type drop-down, select one of the following:
   - Items (Latest Released Rev)
   - Items (Pending Rev)
   - Manufacturer Parts
3. In the Keyword field, enter search criteria, then click Search. Records matching the search criteria display in the Search Results section.
5. Select one row of the loaded external specification. The related compositions load automatically in the Declarations and Compositions section.
6. Select a composition, then click the Load Data button to load the composition data to Excel. If you do not select a composition and click Load Data, all compositions are loaded and a confirmation message displays prompting you to load all compositions. Click OK.
7. An Excel worksheet containing is displayed. The selected data is represented on three tabs:
   - Rollup or FMD
   - Specification
   - Data - default selected sheet
8. To roll up the data, select Rollup from the Agile PGC menu. Compliance is calculated and displayed on the worksheet tabs.
9. To submit the calculated compliance to Agile, select Submit Data from the Agile PGC menu.

**REACH Rollup Logic**

This section describes the algorithms used for REACH rollup.

Threshold PPM is loaded from the specification.

The logic existing in the excel weight rollup is re-used to rollup the weight.

The rollup process has two sub-processes:

1. Mass rollup, followed by a BOS rollup
2. Comparison of weight percentage

**Mass Rollup**

The mass rollup process traverses the item’s BOM/AML and for every parent it adds up the mass of its children.

The mass rollup process also adds the mass on every intermediate level assembly. The quantity of the leaf nodes and sub-assemblies on the BOM are taken into consideration while calculating the mass.
BOS Rollup

If there are substance groups or materials or subparts, the substances weights are converted using conversion factors.

Substances are not repeated. For example if lead is found on multiple items on the BOM, all their weights are added up and reported against the lead row in the table on the first worksheet.

Substances that are not tracked on the specification, but on the BOS of items/manufacturer parts/part groups, are totaled on to one line item - ‘Substances Not Tracked’.

Notes:

- This process does not calculate substance weights on every intermediate level assembly; only on the assembly/item selected in the search.
- For MPNs with multiple compositions it uses the worst case; if all are equally bad then use the heaviest.
- For Items with multiple AML entries it uses the worst case; if all are equally bad then use the heaviest.

Compare Weight Percentage

REACH regulation states the weight of any given substance that is being tracked can only be 0.1% of the weight of the assembly/item.

Once the data has been rolled up, to calculate the compliance for each row of the substance the following logic is used:

- Compare the weight of the substance against the weight of the part/assembly and if it is above 0.1% weight of the part/assembly (Mass column), the substance row is non-compliant. Otherwise, the part/assembly is compliant.
- If the mass value of the part/assembly is missing, a rollup cannot be performed and an error message is issued to the user: 'Mass of the <partnumber> is missing. Please update it in agile. <partnumber> is substituted with the part/assembly number from top block.'